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Syncopation Software Chapter 1

1. Introduction

Congratulations on your purchase of DPL 9!

We're confident that the game-changing analytics, polished modeling
interface, and high level of performance offered by the DPL 9 Release will
exceed your expectations. If you've used DPL in the past, you'll find that
the ease-of-use improvements, performance enhancements, and improved
interoperability in this release will serve as a major boost to your
productivity.

The DPL modeling environment was designed to give you the capabilities
you need to maintain focus on the problem at hand -- the decision and not
the tools. This guide is an extension of that perspective, teaching you
essential DPL skills in the context of simple but realistic decision analytic
models.

The first section provides specific information about the tutorial contained
within this user guide. The subsequent sections of this chapter describe
how to get help and access resources, show you how to install and activate
your DPL license, and provide a brief tour of the DPL user interface. The
final section lists the major changes and new features included in the DPL
9 Release.

1.1 DPL™ 9 User Guide Overview

This DPL 9 User Guide covers the features of both the DPL Professional and
DPL Enterprise versions and is divided into 22 tutorial chapters plus
appendices.

Chapters 2 through 5 cover the basic modeling features and primary
outputs of DPL. These chapters were written specifically with users who are
new to DPL in mind. Various sections of these chapters do, however,
assume a basic knowledge of decision analysis, Excel, and valuation
techniques. If you are new to DPL, you should find that these chapters
provide a thorough introduction to the skills you will need to use the basic
functionality of the software effectively and work your way through the
advanced tutorials contained in later chapters of the guide.

Chapters 6 through 17 cover more advanced modeling features offered by
the DPL Professional version. Some of these chapters include features that
are offered by the DPL Enterprise version only. They further assume you

7
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have some basic experience using DPL, as well as familiarity with decision
and risk analysis concepts, Excel, Monte Carlo simulation and valuation
techniques. If you are new to DPL, you should complete the tutorials in
Chapters 2 through 5 of the guide before covering the material in the
remaining chapters. In general, Chapters 6 through 17 are intended to be
"stand-alone", although new users may find that Chapters 8, 9, and 10 are
best read sequentially, as discussed below.

Chapters 18 through 23 are also intended to be "stand-alone" with each
covering features offered by the DPL Enterprise version. If you are working
through the guide with the DPL Professional version you will not be able to
complete the tutorials contained within these chapters (the same goes for
earlier sections designated "Enterprise only"). Contact the Syncopation
Sales Team if you have the DPL Professional version but find that you have
a need for one of the features only offered by the DPL Enterprise version.

1.1.1 DPL™ 9 User Guide Chapter Descriptions

This guide focuses on DPL's graphical model development environment and
is intended to be read while working with DPL. The chapters contain
tutorials that will give you the essential tools needed to develop real world
decision models in DPL.

Chapters 2 and 3 contain a tutorial for building a model in Decision Tree-
focused mode starting from a spreadsheet that analyzes a drug
development opportunity. These two chapters together cover a broad
range of basic Decision Tree modeling skills and cover five of DPL's primary
analytic outputs: Policy Tree, Risk Profile, Policy Summary, VOIC, and Value
Correlations.

Chapters 4 and 5 contain a tutorial in which a model is built in Influence
Diagram-focused mode from a spreadsheet representing the business plan
for a new product. Similar to the two previous chapters, Chapters 4 and 5
taken together cover all basic Influence Diagram modeling techniques and
introduces a variety of DPL sensitivity analyses.

Note: You'll find that most of the later chapters assume you have already
been through the tutorials contained in Chapters 2 through 5 of this
manual, or that you are already familiar with the DPL modeling
environment.

Chapter 6 is a standalone chapter that contains a tutorial focused on
building an Excel-linked DPL model for a financial risk analysis application.
Continuous chance nodes are introduced to the model, Monte Carlo
simulations are initiated and the analytic results are analyzed. This tutorial
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assumes familiarity with cash flow spreadsheets and with the analysis of
uncertainty by Monte Carlo simulation.

Chapter 7 leverages DPL's modeling tools and features for more complex
decision models and situations, including probabilistic conditioning,
Bayesian updating, and learning models. The last section includes a
summary of DPL Influence Arc types.

Chapter 8 demonstrates how to create models with multiple attributes and
combine these attributes into a single objective function. Multiple attributes
can also be employed to track various metrics even if they aren't
incorporated into the objective function. This use of multiple attributes is
discussed further in Chapters 9 and 10. The use of constraint functions are
also covered in the chapter. The last section contains a tutorial in which a
model is modified to optimize multiple objective functions for an
attacker/defender scenario.

Chapter 9 demonstrates how to use multidimensional value nodes in the
Influence Diagram for driver and metric nodes. The tutorial within the first
section will look at an example of a one-dimensional array metric node, a
series metric node and a series driver node. The tutorial within the second
section defines a two-dimensional array driver node that is linked to Excel.

Chapter 10 contains a tutorial that uses a multidimensional value node in
the generation of a Time Series Percentiles chart. Because Time Series
Percentiles use multiple attributes, and can be used with multidimensional
value nodes for greater convenience and efficiency, you may wish to
review Chapters 8 and 9 before completing the tutorial in Chapter 10.
Within the last section an Initial Decision Alternatives Time Series
Percentiles chart is generated.

Chapter 11 covers the Endpoint Database feature in DPL. The Endpoint
Database can be recorded (saved) and viewed. A recorded Endpoint
Database can be re-played to quickly produce decision analysis results even
if the model has been modified in certain ways. With large models, the
Endpoint Database capability can significantly reduce the time required to
do multiple runs in order to generate outputs. The last section includes a
tutorial in which endpoints are recorded in parallel on multiple machines,
resulting in quicker runs.

Chapter 12 covers the more advanced features of the DPL Policy Tree and
Policy Summary. It also introduces two additional outputs: Subtree Risk
Profiles and Option Value Charts.

Chapter 13 shows you how to use DPL to model attitudes toward risk and
make decisions based on certain equivalent rather than expected value.
Utility functions are introduced in this chapter.

9
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Chapter 14 covers advanced sensitivity analysis features in DPL, including
two-way Rainbow Diagrams and Event Tornado Diagrams. Chapter 14 also
contains guidance about when to use each type of sensitivity analysis
offered by DPL.

Chapters 16 and 1716 describe and demonstrate how DPL programs and
DPL code are created, and how spreadsheets linked to DPL can be
converted to DPL code for significant improvements in model runtime.

Note: Chapters 18 through 23 cover additional features of the DPL
Enterprise version. They assume you have significant experience using
DPL, and parts of it also assume familiarity with database and
programming concepts.

Chapter 18 illustrates how to link DPL Enterprise to a spreadsheet that
contains a calculation macro.

Chapter 19 covers DPL Enterprise's expert aggregation interface and
contains a tutorial on how to create models with expert aggregation nodes
in them.

Chapter 20 covers DPL Enterprise's ability to estimate probabilities from an
external dataset (CSV). It further demonstrates how users can progress
from data analysis to decision making with a few modifications to the
model.

Chapter 21 documents the DPL Enterprise version's database linking
capabilities. You will complete a tutorial in which you set up and run a
database-linked model.

Chapter 22 covers the Application Programming Interface (API). This
feature allows you to control and run DPL from other applications, such as
Visual Basic for Applications (VBA), C# and VB.NET.

Chapter 23 covers DPL's user function library interface.

Appendix A summarizes DPL's spreadsheet linking features and gives
suggestions on when and how to use each feature.

Appendix B contains a tutorial on strategy tables, which allow you to
"aggregate" several up-front (initial) decisions into a logical, manageable
set of strategies to be analyzed.

Appendix C lists DPL's system requirements and compatibility with older
releases.

Appendix D provides a comprehensive list of DPL's keyboard shortcut
commands.

10
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Appendix E provides a glossary of common DPL and Decision Analysis
terms.

1.1.2 DPL™ 9 User Guide Conventions

A few conventions have been used in the text that follows. An instruction
to you in a tutorial is contained in a bulleted paragraph with a block arrow:

= Do this step now.

Information to be entered in edit boxes, Excel cells, etc. is contained within
double-quotes. Do not include the double-quotes when entering the
information.

DPL ribbon tab names, groups, and commands are separated by vertical
bars (|). For example, "Influence Diagram | Node | Add" refers to the
default command indicated by the icon in the Add split button, located in
the Node group on the Influence Diagram tab of the command ribbon as
show in Figure 1-1.

dwHO-F+
HOME | INFLUEMCE DIAGRAM | DECISION TREE VIEW DATA HELP
|7| [ 35 Linked Node = [ @ i ’." N
AR 7 « 7
Edit .'i\i% Change Link Manage Add From
- To- Events Formulas
e = Links Arc

Figure 1-1. Help Convention: Influence Diagram (Tab) |
Node (Group) | Add (Command)

For a split button, when a command other than the default indicated in the
icon is desired you will be prompted to drop-down the split button and
select the command from the drop-down list.

The word "Settings" following a vertical bar refers to the dialog box
launcher (1 ™), which is located at the bottom right corner of the given tab
group. For example, "Home | Run | Settings" refers to the dialog box
launcher for the Run group on the Home tab of the ribbon and will launch
the Run Settings Dialog.

If there are multiple tabs within a dialog, then the item following the last |
refers to the desired tab. For example, File | Options | Outputs refers the
Outputs tab of the File Options dialog.

11
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1.2 Installing and Activating Your DPL™
License

1.2.1 Installing the DPL™ Application on Windows

If you have not already installed DPL on your computer, do so now.
For the DPL trial:

= Click the link provided on the DPL 9 Professional Trial Download page
or within the email regarding your trial code.

For purchased DPL licenses:

= You should have received your DPL 9 software electronically via e-mail

from sales@syncopation.com. Follow the instructions contained in the
e-mail.

= Once the DPL9.msi file has been downloaded and opened, follow the
on-screen instructions.

Note: different instructions apply to installing DPL on a Mac. Refer to your
license email or contact sales@syncopation.com for a Mac download link.

1.2.2 Activating Your DPL™ License

Once you've completed the download and installation, you'll need to
activate your DPL license (trial or purchased) using the license codes or
license file contained in the DPL license email. If you have been provided a
license file, the email will contain instructions on where to place the file on
your hard drive for activation. To activate with license codes:

= Double-click the DPL 9 icon on your desktop ( 'ig ). The DPL License
Setup dialog with appear (Figure 1-2).

12
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DPL License Setup (Release 9.00.00) (Built Jan 11 2017}

License information
Fleaze enter your DPL zerial number and inztallation key below.

Serial number: | | [15 digitz]
Installation key: | | | | | | | | | (54 digits]

Check Licenze Infa

Licensze file

If you have a DPL licensze file, broveze for it now.

Browsze for Licenze File

Cancel

Figure 1-2. DPL License Setup dialog

= Carefully enter your Serial Number and Installation key within their
respective fields and press the Check License Info button.

Note: if you are activating with a license file and you have placed the file in
the correct location on your hard disk, this dialog will not appear as this
step is bypassed when DPL finds the file. If you've been provided with a
license file and this dialog appears, do not attempt to enter a serial number
and install key. Instead, click on the Browse for License File under the
License File section and navigate to the folder where you placed the license
file.

= If the license information you've entered is valid, you will receive the
following message:

13
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o License valid.

QK

Figure 1-3. DPL License Valid dialog

Note: if the DPL License andyor Maintenance and Support coverage are due
to expire in 30 days or less, you will receive a prompt notifying you of this
each time you activate or open DPL.

After clicking OK within the License Valid dialog, you are presented with the
User Information dialog (Figure 1-4) in which you should enter the named
user within the User name field and the licensing organization within the
Organization field. The information entered will be displayed alongside
other DPL license information within the Session Log (Figure 1-12) and
About DPL dialog (Figure 1-10).

User Information

Fleaze enter the information below for the licensed user.

|dzer name: | Micki Franz |
Organization: | Syncopation Software] |
k.

Figure 1-4. DPL User Information dialog

14
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123 Registering Your DPL™ License

After clicking OK, DPL will ask if you'd like to register your license online
with Syncopation Software (Figure 1-5).

DPL

Would you like to register enline now? Registration helps us to provide
you with better support.

Yes Mo

Figure 1-5. DPL License Registration prompt

If you click No to the prompt DPL will let you know that you can register
your license through Syncopation's website any time by selecting the Help |
Resources | Register command (Figure 1-8) or by navigating to the
following link directly and submitting the webform:

https://www.syncopation.com/register-dpl

If you haven't done so (or, if it's been a while) we recommend you register
your DPL license to ensure Syncopation has your most current license and
contact information. This helps us to provide you with the best user
experience possible.

If you were to click Yes to the registration prompt a web browser will open
to the Register DPL web form (Figure 1-6). Here you should enter your
current contact and license information. One important required field near
the bottom of the form asks you to specify your subscription preference,
e.g., whether or not you'd like to receive periodic emails from Syncopation
regarding the latest information on DPL releases, promotions, updates,
maintenance fixes and training.

If you set your preference to Yes your contact information will be entered
into Syncopation's secure CMS system. Once entered you can expect to
receive no more than 3 emails per month from Syncopation. If you set your
preference to No thanks, you will not be entered into our CMS system and
therefore will not receive regular emails from us.

15
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Register DPL | Syncopation Software

<5 Register DPL | Syncopatio.. X =

@ @  httpsy,

w.syncopation.com/register-dpl c Q Search

State [ County [ Province * 2
|Maine |

Zip I Post Code *

[+1 866 796 2375 |

Email *
|inf0@ syncopation.com |

Industry
| Computer Software v

Product *
DFL 8 Professional

Serial Number *

|SYDEQU[]UUUU[]OU[]
“our serial number is in Help | About DPL.

Receive periodic e-mails *
Yes ~

The latest information on DPL releases, updates, maintenance and training.

Primary intended DPL use
Capital Investment Strategy V|

Figure 1-6. Register DPL License Webform

After the Register prompt the DPL application will open. If yours is a new
installation, DPL will display the Example Navigator, which is covered in the
next section on DPL Help and Resources.

16
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1.3 DPL™ Help and Resources

1.3.1 Example Navigator

When you launch DPL for the first time, the Examples Navigator window is
displayed (Figure 1-7). The Navigator contains a sampling of the example
models installed with your license. The Navigator provides the industry
vertical, techniques employed, and a brief description of the given DPL
example model. Many users find it helpful to browse through already built
models to learn new techniques and as a source of ideas.

You can find all of the example models and their linked Excel spreadsheets
within the Examples folder within your DPL installation directory, usually
C:\Program Files\Syncopation\DPL9\Examples.

DPL Examples X

Click. an image to toggle between influence diagram/decision tree

Zeiice

Industry: Pharmaceuticals

Techniques: asymmelry, downstreamn
decisions, promoted get/pay expressions,
spreadsheet inks

File: asymmetric. da

Description: The models and linked Excel
Spreadsheet in this example are set up to
calculate the value of an RED project.
The azymmetric: model has a failure paint
at regulatory approval. The model has a
downstream launch decision after
learning about & key competitar,

Open

i sté‘rtupg

Industry. Energy

Technigues: DPL value modeling,
asymmetry, perform subtrees, learning,
downstream decisions, multiple get/pavs.
imperfect information

File: wildcat.da

Description: This example models a
diill/no diill decision in the simple case. In
a more complete model a test decision is

included and demonstrates the value of
learning.

Open

Cloze

“Wertical Mew Product Development

Techniques: DPL value modelling,
sensitivity on a probability, risk tolerance,
downstream decisions, symmetry

File: License v. Inchouse.da

Description: This example models a
decision whether to license or produce &
new product. The calculations are all
dane within DPL. A subsequent model
shows the use of DPL's Risk tolerance
feature. The final model demanstrates
haow to conduct a sensitivity on a
probability.

Open

Figure 1-7. DPL™ Examples Navigator

If you prefer not to the be shown the Examples Navigator upon start up,
check the box labeled Don't show this as startup in the bottom left corner
of the dialog. You can re-open the Navigator at any time by clicking the
Navigator button on the Help tab (Figure 1-8).

17
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1.3.2 Online Help
DPL's online help contains detailed descriptions of:

DPL features and dialogs

How DPL performs various calculations

How to interpret each of DPL's outputs

Common error and warning messages that may be generated by
DPL

To access online help you can use the commands within the Help group of
the Help tab on the ribbon (Figure 1-8) or by pressing F1. Either method
with launch a web browser that contains the appropriate DPL help topic.

HOME INFLUEMCE DIAGRAM DECISIOM TREE VIEW DATA HELP

License & Register Update Contents Index Search  Mavigater  Professional Portfolio
Version & Enterprise
Resources Help Examples Documentation

Figure 1-8. Help Tab Commands

The Help | Contents button will launch the Getting Started with DPL 9 help
topic page (Figure 1-9). The Help | Index command will launch the DPL 9
Help Index page, which provides a list of keywords and help topic title
links. The Help | Search command will launch the DPL 9 Help topic search
page in which you can search for specific terms within the body, keywords,
and titles of the help topics.

When you press F1 while modeling in DPL a web browser will open to a
contextual online help topic that corresponds to what you're doing or
viewing in DPL.

18
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DPL 9 Help | Syncopation Software

<5 DPL9Help | Syncopation... X =
(@ @  https;/fwww.syncopation.com/dpl-9-help?topic=dev_getting_started c Q

CONTACT / MY ACCOUNT [ CART ‘& _

<& SYNCOPATION

DECISION ANALYSIS PRODUCTS INDUSTRIES SUPPORT ABOUT SYNCOPATION

DPL 9 Help

Y%

Getting Started with DPL 9
Welcome to DPL 9!

If you've used earlier versions of DPL, click here to see what's new in DPL 9.

DPL Examples Navigator

‘When you first open DPL, the Examples Navigator window will be displayed. You can re-open the Navigator at any time
by clicking the Navigator button on the Help tab. The Navigator contains a sampling of the DPL example models
installed with your trial license. It provides the industry. techniques employed. and a brief description of the given DPL

example model.
DPL User Guides

One of the best ways to get started using DPL is to work through the tutorials found in the DPL 9 Users Guides that is
provided with your license. You can find the user guides in PDF format within the Documentation folder of your DPL
installation directory. The corresponding examples files are located within the Examples folder of the same directory.

You can also download it from our website here:

https://www.syncopation.com/sites/all/ithemes/sync/downloads/DPLE_Prof: |_Manual.pdf

Figure 1-9. Launched DPL 9 Help Topic in Web Browser
(Help | Help | Contents)

1.3.3 Support Team

Perpetual licenses of DPL include 60 days of Maintenance and Support to
help you get started and should be renewed annually thereafter. DPL
licenses covered by a Maintenance and Support agreements are eligible to
receive expert technical and modeling support through phone and email via
the following contact points:

Email: support@syncopation.com
Phone: 1 866 796 2375, Ext. 2.

Maintenance and Support coverage also includes free software
maintenance releases and major upgrades to the product. If you'd like
more information about Syncopation's Maintenance and Support coverage,
send an inquiry to support@syncopation.com. We pride ourselves on the
quality of our support, and we highly recommend you not take any
unnecessary risks and keep your DPL Maintenance and Support coverage
up-to-date!
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When you submit a support request, we ask that you provide us with the
information necessary to assist you most efficiently. It is helpful when the
support request includes your DPL license version (e.g., Pro), maintenance
release (e.g., 9.01.02), license type and serial number — all of which can be
obtained via the Session Log (Figure 1-12) or the About DPL dialog shown
in Figure 1-10 (Help | License).

About DPL X

ﬁg DPL - Decizion Programming Language
Enterprize Yersion
Release 9.00.00

Copuright € 2003-2017 by Syncopation Saftware, [nc.
Incarporating software on license to

Syncopation Software, lne.

All rights reserved.

Licensed to:

Synca User E Change ser i
Syncapation Software

Serial number: |SvDE 90170418001
Support expires: |.Jur'|e 18, 2017

pdate Licenze

License hype: Full, perpetual commercial license

Cloze

Figure 1-10. About DPL dialog (Help | Resources | License & Version)

It is also helpful if you include a detailed description of the steps leading up
to the issue and the specific behavior you've observed. Screenshots of the
application and any error messages received are also helpful. If you can
send the DPL model and linked spreadsheets to us, that is usually the best
way to bottom out an issue in a timely manner. Any materials sent are
treated as strictly confidential.
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1.3.4 Website Resources

e FAQs: Your most frequently asked DPL support and ordering
questions answered.
(https://www.syncopation.com/fag-page)

e Imperfect Information Blog: From DPL updates, modeling tips and
best practices to commentary on the latest topics within decision
science.

(https://www.syncopation.com/blog)

e DPL Industry Examples: Explore real world DPL examples models
by Industry.
(https://www.syncopation.com/industry-examples)

o DPL Instructional Videos: Learn about basic decision analytic tools
and concepts via short, simple tutorial videos using DPL.
(https://www.syncopation.com/instructional-decision-analysis-
videos)

135 DPL™ Training

The quickest, most efficient way to become proficient in DPL modeling is to
participate in a DPL training course. Syncopation offers DPL instructor-led,
interactive web training sessions that are designed to efficiently transfer
essential DPL skills to you without taking you away from your desk. The
web-based sessions save on travel costs and are an easy fit into your busy
schedule.

For several users we offer customized DPL in-house training courses which
also minimize travel costs while also allowing participants to focus on topics
specific to their organization. In an in-house setting, we can additionally
offer an application workshop focused on a particular issue, model or
approach. An application workshop is a great way to "kick-start" a new
analytical initiative by giving participants immediate, directly-relevant
experience applying DPL in a new setting. For more information on DPL
Training see our training overview page:

https://www.syncopation.com/training

Please send your training inquiries to sales@syncopation.com.
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1.4 A Brief Tour of DPL™

1.4.1 The DPL™ Workspace

= Start DPL by double-clicking the icon on your desktop (‘g ) or
double-clicking the application in Windows Explorer.

DPL will load with an empty, maximized Decision Tree pane within the
Model Window on the right-hand side of the screen. On the left-hand side
is the Workspace Window. See Figure 1-11.

< He-8= DPL - Warkspacel - B8 X
HOME  INFLUENCEDIAGRAM  DECISIONTREE ~ VIEW ~ DATA  HELP -2

OB @f o Command &

Bt | A ik Menage s Control~ Rlbbon K] seings

Objec Node s Instance Control/Blodk Objective & Utility 1] Model
Workspace Manager 5 o
=< Workspace ~

= Modell
Workspace Model Window
Window Decision Tree Pane

Session Log [

Qutside the US: +1 978 233 2509

Enterprise Version (internal Buid)
License expires: December 31, 1969
Relea. )

3
Buik Oct 17 2016 11:54:36 (64-bit)
nternal Use Only

v v

Figure 1-11. New Workspace with Empty Model Window
in Decision Tree-focused Modeling Mode

14.2 The Workspace Window

The Workspace Window contains two different panes: 1) the Workspace
Manager pane at the top and 2) the Session Log pane at the bottom. The
Workspace Manager pane displays all the documents in the open
Workspace in a Windows Explorer-style tree structure. The top level is the
Workspace. Below the Workspace are displayed all the models in the
Workspace. Below each model are displayed the outputs and other items
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associated with each model. Currently there is only one model (Modell) in
the Workspace.

= Right-click on the icon for Modell to see the context menu for a model.
Notice among other things that you can delete, rename or duplicate a
model.

Within a DPL Workspace, you can develop, run, and store results and
outputs from multiple models. The model most recently ran, compiled or
viewed is bolded in the Workspace Manager. In general, when you run a
Decision Analysis or use any other run or compile command, DPL runs or
compiles the active (visible) model. Once you've run or compiled a model,
its item in the Workspace Manager will have a compiled indicator, double
chevrons ("»»...««"), around the model name.

The Session Log displays information about the current session. Presently,
it displays information about the version of DPL you are running and to
whom the software is licensed. See Figure 1-12. You can also access DPL
license information by clicking Help | Resources | License & Version.

As you build models and run analyses, further information such as
compilation messages, expected values, and percentiles are written to the
Session Log. Certain error messages are also written in the Session Log.
The Session Log is cleared each time you close DPL and each time you
open a new Workspace. The Session Log can be edited like any other text
document. The contents of it can be copied and pasted to other
applications for support assistance or for further analyses.
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Session Log

DPL - Decigion Programming Language

Copyright @ 2003-2017 by Syncopation Software, Ir
Incorporating software on license to

Syncopation Software, Inc.

All rights reserved.

Use of this software is governed by the DPL End Us

W svncopation. com
support@syncopation.com

U5 tol-free: 1 886 795 2375
QOutside the US: +1 978 233 2509

Enterprize Wersion

Support expires: March 22, 2017
Releaze 5.00.00 (beta 4)

Buitt Jan 11 2017 14:17:53 (64-bit)
Serial Number: SYDES01 70222001
Licensed User: Nicki Franz, Syncopation
11:458:27 Clearing: wildcat

11:45:27 Compiling: wildcat
Mumber of paths = 630
11:458:27 Complete

11:45:27 Analyzing ... Fast sequence evaluation

Figure 1-12. The Session Log

Both the Workspace Manager and the Session Log can be undocked by
clicking the top of the pane and dragging away from the side of the
window or by right-clicking within the desired pane and selecting "Dock".
The pane can be left floating or moved to one of the edges of the
application window and re-docked there. The window border changes as
you drag it to indicate whether and where it will be docked. If you dock
one pane on top of the other, the window will show only the "top" pane
and create two tabs at the bottom of the Workspace Window, one for each
pane view.

The Workspace Manager and Session Log can be hidden using the Auto-
hide function (the thumb tack button on the top right of the pane). When
the thumb tack is in Pin Down mode, the pane stays visible. Pressing the
thumb tack button will toggle to Pin Up mode and the pane will collapse to
a tab on the edge of the screen if docked or to a window bar if un-docked.
When you mouse-over the tab or window bar, the pane will expand to its
visible state. When your mouse leaves the tab/pane area, the pane will
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collapse to a tab/window bar again. To keep the pane at its visible state,
click the thumb tack to toggle to Pin Down mode.

143 The Model Window

The Model Window contains two panes: 1) the Influence Diagram pane and
2) the Decision Tree pane — though both are not necessarily visible at
once. Upon launching DPL for the first time, the Decision Tree pane is
maximized within the Model Window by default. The Influence Diagram
pane is present but minimized and, consequently, hidden from view. This
means you are starting in Decision Tree-focused modeling mode.

You can change the preferred modeling mode (i.e., the pane maximized)
for new models via the "For new models, maximize pane" setting within
File | Options | General (Figure 1-16). Upon start up and for newly created
models you can choose to have the Decision Tree pane maximized, the
Influence Diagram pane maximized, or a halfway split with both panes
visible. When the Model Window is in halfway split mode, the Influence
Diagram is at the top with the Decision Tree pane on bottom.

When a new, blank workspace is open you'll notice a semi-transparent
watermark located in the top left corner of the pane(s), indicating whether
it is the Influence Diagram or Decision Tree pane.

If you are in Decision Tree-focused mode the Decision Tree pane is
maximized, the Decision Tree tab is active and you will see the following
indicator:

If you are in Influence Diagram-focused mode the Influence Diagram pane
is maximized, the Influence Diagram tab is active and you will see the
following indicator:
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If you choose Neither within File | Options | General then the Model
Window is split halfway with the two panes divided horizontally by a splitter
and both watermarks are visible within their respective panes. You can click
and drag the splitter bar between the panes to change the proportion of
each. Dragging the splitter bar to the top or bottom edge of the Model
Window will make only one of the panes visible, as will double-clicking the
splitter bar. Double-clicking the splitter again will set the splitter to the mid-
way point between the panes. Lastly, you can quickly switch between
maximized panes by using the Tab key.

When you switch between maximized Decision Tree/Influence Diagram
panes, the active tab may switch as well. For example, if the Decision Tree
pane is maximized and the Decision Tree tab is active and you switch over
to the Influence Diagram pane, the Influence Diagram tab will become
active, and vice versa.

Lastly, you can change the splitter to split the screen vertically by selecting
the radio button View | Layout | Vertical Split (which results in the
Influence Diagram being on the left and Decision Tree on the right).

14.4 Document Navigator

In addition to the Workspace Manager, all the documents are also
displayed as tabs in the Document Navigator (see Figure 1-13) just above
the Model Window. You can click the tab for the item once to activate it or
press the () to delete the item. If the desired tab is not visible in the
Document Navigator use the arrows at the far right to scroll through the
document tabs.

You can also use Ctrl+Tab to make quick switches between windows in the
Workspace.
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SR E T~ cyrmetric with Launch decision Expected Value Policy Tree Initial Decision Alternatives 4 »

-

Market Market Pricin
Develop? FD share Size
= Approval

Low Low Low

Yes Yes NPV
Nominal Nominal Nominal

No No N pv<|
High High High

NPV

Zoom: 100% Full Prev = ——F——+

Figure 1-13. Document tabs in the Document Navigator

1.45 Zoom Controls

You can zoom the Model, Policy Tree and Policy Summary Windows by
using the Zoom controls located on the status bar at the bottom right of
the application window (see Figure 1-14). For a description of the Zoom
controls see Table 1-1.
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Figure 1-14. Zoom Controls on the Status Bar with Zoom dialog active
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Button/Control Name Action

This button launches the
Zoom dialog (as seen in
Figure 1-14) within which
you can select a preset
level of zoom or specify a
custom zoom level.

100% Zoom Percentage

Zoom the active pane so
that all of the Influence
Diagram/Decision Tree is
visible in the pane.

Full Zoom Full

. Return to the previous
Prev Zoom Previous
zoom.

Click the -/+ to increase/
decrease zoom level or

_ " o Zoom Slider manually click and drag
Control the Zoom slider control
to the desired zoom
level.

Table 1-1. Zoom Controls Descriptions

You can also zoom these windows via the context menu or zoom by
selection. To zoom by selection, click the left mouse button on the top left
corner of the region you'd like to view, press Ctrl+Shift and then drag the
mouse down and to the right. A rectangle indicates what will be displayed
when you release the mouse button. Release the mouse button when the
rectangle surrounds the portion of the diagram you wish to view.

1.4.6 Introduction to the DPL Command Ribbon

Above the Workspace and Model Windows, you will find a Microsoft Office-
style command ribbon consisting of multiple tabs. Each tab is split up into
contextual groups that contain one or more commands.

You can view a short description of a particular command on the ribbon by
holding your cursor over the item until the tooltip note appears.
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Figure 1-15. DPL Ribbon Command Tooltip
File Tab

The File tab contains standard commands for creating a new Workspace,
opening and saving Workspaces, and printing. You can embed/unembed a
DPL workspace in a Excel spreadsheet file. You can also access DPL and
Workspace-level options via File | Options. These options will be discussed
in more detail later in the chapter.

Home Tab

The Home tab contains a Workspace group within which you can add,
delete, rename, copy, cut, paste, select and find/replace items in the
Workspace. The Run group and Sensitivity group each display the analyses
that can be run on models and the options associated with those analyses.

Influence Diagram/Decision Tree Tabs

The Influence Diagram (ID) and Decision Tree (DT) tabs (formerly a single
Model Tab) contain a number commands for editing DPL models. Some
ribbon command groups are available from both tabs, such as the Links
group. Others are specific to one or the other. For example, the Get/Pay
tab is only available from the Decision Tree tab. The commands, their
names and the action associated with each are described in the Tables
Table 1-2 through Table 1-5.
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Edit

ID/DT | Object | Edit

Object Group
Edit (Object) button

Edit the selected object. This can be used to edit a
selected node, branch(es), arc, text box, or
get/pay expression. If nothing is selected, the
Select Node dialog will open displaying a list of all
the nodes in the model.

[ ]

Add

ID/DT | Node | Add

Node Group
Add (Node) split button*

Add a new, unlinked node to the Influence
Diagram and/or Decision Tree of the default type
indicated by the icon.

Note: Value nodes do not appear independently in
the Decision Tree but can be added to get/pay
expression on an event's branch(es).

M
Change
To~

ID/DT | Node | Change To

Change to (Node type) split button

Change type of selected node to the default type
indicated by icon.

You can select multiple value nodes at once
(Ctrl+Click) in order to change them to chance
nodes with a single click.

ID/DT | Links | Link Events

Links Group
Link Events button

Launches the Link Model Events dialog which
serves as an interface for linking the model's
decision, chance, and controlled nodes to
spreadsheet driver cells.
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Manage Links button

@ Launches the Manage Links dialog which provides
an overview of all sources to which the model is
Manage linked and also a summary of node links by source.
Link sources can be edited/updated from the
dialog. Spreadsheet can be converted to a DPL
Program from the dialog as well.

ID/DT | Links | Manage

Objective & Utility Group
Obijective & Utility combo box

Max = | NPV -V f %

Risk tol : -V f
sk tolerance: (none} v I Only enabled for multiple attribute models.

Objective & Utility IF Use the drop-down list to select a single attribute
to use for the objective function or type in an
ID/DT | Objective & Utility expression involving more than one attribute
and/or value from the model. Use Max/Min drop-
down list to either maximize or minimize the

objective function. Use the ( V'), (  )or (%)
buttons to insert a variable, function, or attribute.

For single attribute models this is set to Objective
Function, and grayed out.

Built-In Risk Tolerance combo box

Specify the coefficient for the built-in risk tolerance
function in order to model attitudes towards risk.

Use the ( 4 )or ( _JII- ) buttons to insert a variable
or function.

Model Group

'a Model Settings button

T Launches the Model Settings dialog within which
Settings ! X .
you can change a variety of settings for the active
model. The Influence Diagram tab command will
launch the dialog with the Links tab active. The
. Decision Tree tab command will launch the dialog
ID/DT | Model | Settings with the Decision Tree tab active.

Table 1-2. Shared Ribbon Commands for Decision Tree and
Influence Diagram Tabs

* Note: DPL has several split buttons on the command ribbon. The icon
displayed within the top half of the split button indicates the current default
command. Click the top half of the button to choose the default command.
If you desire a command other than the default, drop-down the split button
to choose the command from the /ist.
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If you select a command from the split button’s drop-down list, the default
command and resulting icon changes to that. The split button allows you to
execute whichever item you last executed again without having to drop

down the list.

3 Linked Node -

ID | Node | Linked Node (Add)
¥% Excel Calculation-Linked...

™ Excel Initialization-Linked... <

75 DPL Program Calculation-Linked...

t=  Database Initialization-Linked...

Linked Node drop-down list

Node Group (ID only)
Linked Node (Add) split button

Add a linked value node of the type indicated
by the icon to the Influence Diagram.

Nodes can be linked to an Excel spreadsheet
(Calculation or Initialization-linked), a DPL
Program, or a database.

E Sum E

ID| Node | Formula Node (Add)

E Sum

M Product

A& Difference

Formula Node drop-down list

Formula Node (Add) split button

Add a summation, product, or difference node
to the model, as calculated from the value
nodes selected.

N

Add

ID | Arc | Add

Arc Group
Add (New Arc) button

Add new influence arc between nodes to
indicate timing, formulaic dependence, or
conditioning.
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From Formulas button

il
f.) Add new influence arc(s) to Influence Diagram
. that are based on the formulas of the data
From definitions of each node.
Formulas

ID | Arc | From Formulas

f‘;‘\. Bend Bend/Straighten buttons

n . Bend or straighten the selected influence
«— Straighten arc(s).

ID | Arc | Bend/Straighten

Table 1-3. Influence Diagram Tab-specific Ribbon Commands
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=

Manage
Values

DT | Node | Manage Values

Node Group (DT only)

Manage Values

Launches the Select Value dialog which
lists all the value nodes in the model.
Values in the list can be deleted or
edited (i.e., the Node Definition dialog
for the selected value node will open).

O«

Add

DT | Instance | Add

Decision...
= Chance..
g4 Controlled...

Instance drop-down list

Instance Group
(Add) Instance split button

Add a new node instance to the
Decision Tree of the type indicated by
the icon.

Choices in the drop-down list include
adding a decision instance, adding a
chance instance, or adding a controlled
instance.

Within the Select (Node type) dialog,
you can choose to add an instance of
an existing node or create a new node.

Asyrnmetric
' Detach
@ Subtree

[P

Right side of DT | Instance

Asymmetric check box

Check this box to modify the outcome
grouping of selected node(s) or
branch(es) to be asymmetric. Uncheck
the checkbox to make the node
symmetric.

Detach button

Detach selected node and create a new
detached subtree starting with the
selected node.

Perform Subtree button

Performs a subtree that begins with the
node selected and is performed at the
connection point (blue triangle)
selected.

Table 1-4. Decision Tree Tab-specific Ribbon Commands
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- | Remove

— Contraol =

Control/Blodk
DT | Control/Block

To Low
— To Mominal

T High

To Default

Control Selection drop-down list

Control/Block Group

Control combo box
(for a single node)

Control the selected node to the branch
selected in the combo. Control is
removed if (none) is selected.

Sticky checkbox

Check box to make the control setting
sticky for selected node(s). Once
designated sticky, control settings for
these node(s) must be changed
individually.

Control Selection drop-down
(for multiple nodes at once)

Control branches of the selected nodes
to Low, Nominal, High, or Default (as
defined in the node's definition) state.

Remove

Remove control from selected node(s).

Objective Function -

MPY -V

*) Show Hide Indicator
DT | Get/Pay

f
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Get/Pay Group
Select Attributes drop-down

For multiple attribute models, choose
the attribute from the drop-down list
for which you'd like to edit the get/pay
expression for the selected branch(es).

For single attribute models this box is
set to Objective Function.

Edit Get/Pay combo box

Use the drop-down list to select a single
quantity or type in an expression for
the get/pay for the selected branch(es).
For multiple attribute models, the
get/pay is for the attribute selected in
the Attributes drop-down list otherwise
it is for the objective function. Use the

( Vv )or ( _J"- ) buttons to insert a
variable or function.
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Get/Pay Display radio buttons

Display, hide or show an indicator ($)
for the get/pay expression for the
selected branch(es).

Model Group (DT only)

D

SEEE#'.:E‘ Re-build Default Tree

Default Build or re-build the default tree. Your
Tree existing tree is deleted and replaced

with a symmetric, default tree.

DT | Model | Default Tree

Table 1-5. Decision Tree Tab-specific Ribbon Commands Continued
View Tab

You can access several useful display commands within the View tab. Once
you have multiple items within your workspace, you can arrange windows
and icons and switch between windows via commands within the View |
Window group.

Within the View | Layout group there are commands to change the model
window split from horizontal to vertical, snap nodes to the grid and align or
arrange nodes. You can also add a block of text, typically used for titles or
explanatory notes, within the Influence Diagram or Decision Tree. Note
that text blocks can be edited independent of the text associated with
nodes (node names and branch names).

You can toggle back and forth between the Certain Equivalents and
Expected Value view for many outputs by clicking View | Results | CE. The
Certain Equivalents view is available only if a risk tolerance has been
specified.

You can change the font, font style, and font size for various items within
the Influence Diagram, Decision Tree and output charts using the controls
in the View | Font group.

Lastly, you can choose to show or hide the tip boxes that are displayed
when the mouse is hovered over a node or graphical object. The Show Tips
button is shaded blue upon launching DPL, indicating Show Tips is on by
default.

Data Tab

Within the data tab you can export the data or statistics of a particular
output via the Data | Export icon. Within Data | Distributions you can view
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the Statistics for a distribution or reduce the distribution to a single chance
node. Data | Update includes commands for updating reports or charts
using the latest data. DPL Enterprise users can set up an ODBC Datasource
for a Workspace and then load the database schema information within the
Data | Database group. And lastly, the Data | Learning group offers
commands for estimating and updating probabilities from external outcome
data in a .CSV file.

Help Tab

You can view or update your DPL version, license and license information
or register your DPL license via the commands within the Help | Resources
group. You can launch the DPL Online Help within a web browser by
clicking one of the three icons within the Help | Help group. You can launch
the Examples Navigator by clicking the Help | Examples | Navigator button.
And lastly, you can open the DPL 9 User Guide in PDF format by clicking
the Help | Documentation | Professional & Enterprise button.

Contextual Tabs and Commands

Some ribbon tabs are contextual and will appear only when a particular
item is active. For example, the Policy tab appears only when a Policy Tree
or Policy Summary is active. As you work your way through the following
tutorials, in addition to the Policy Tab, you will find the following contextual
tabs: the Grid Tab (when an Endpoint Database is active) and the Chart |
Series and Chart | Format tabs (when a chart, such as a Risk Profile Chart
or Tornado Diagram, is active).

Furthermore, not all commands within a particular tab will always be
enabled since some of them are context specific. For example, the options
within the Decision Tree | Get/Pay group are only enabled when you have
branch(es) selected in the Decision Tree.

1.4.7 DPL™ and Workspace-Level and Model Options

You will now check that workspace options and model settings are set in a
way so that as you work with DPL, what you see on your screen will be
similar to the images in this guide. In DPL 9, there are a few places to set
options. You can access DPL and Workspace-level options via File |
Options. Spreadsheet linking and settings that are specific to the models
within a Workspace are set within the Modeling Settings dialog (Influence
Diagram/Decision Tree | Model | Settings). Lastly, there are a few settings
that are specific to models within a Workspace that are set via dialog box
launchers. For example, Home | Run | Settings will open the Run Settings
dialog where settings relating to a decision analysis run are set. The
various model options are discussed throughout the manual.
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= Select File | Options to access the DPL and Workspace-level options.

The Options dialog appears with the General tab active as shown in Figure
1-16.

Options

General  Qutputs  Workspace

Display
[]iRestore window position on startup: Max number of lines to display in log:
Colored amowheads (arcs)
Lines to clear when max exceeded:

For new models, maximize pane: () Influence Diagram (®) Decision Tree () Neither, split hatfway

Undo levels

Grophicmodels: (30 [(100max) DPLcode: {1000 max)

Decision/chance node defaults
COutcome names/probs for new chance nodes Altemative names for new decision nodes

me Probability MName
W

Na
Low outcome: _ 3
Middle outcome:
High outcome: 3

[] Automatically add new decision/chance nodes to non-default decision trees

First atemative: Yes

Second altemative:

After node name chanage
(O Replace old with new in node data and get/pays (C) Dont replace (@) Prompt

Concel | [Pl

Figure 1-16. General Tab of File Options dialog

= Select the Outputs tab.
= Make sure that Decimal places is set to 1.
= Make sure that Display probabilities as percentages is checked.

= Make sure that Decimal places for probabilities is set to 0. The Outputs
tab should look like Figure 1-17.

= Click OK to close the File Options dialog.
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Options

General Outputs  Workspace

General number formatting

Decimal places: eq., 1235

Qutput scaling: EI display 1.0as 1.0

Fero equivalent: display 5.9e-13as 0
Probabilities

Dizplay probabilties as percertages

]

Decimal places for probabilties: eq., 13%

Copy/paste

[] Produce simplified metafiles for ungrouping in PowerPaint

Cancel Help

Figure 1-17. Outputs Tab of Options Dialog

All of the options on the General tab are at the installation level, i.e., they
are not Workspace specific. The options on the Outputs and Workspace
tabs are Workspace-level options and can vary from Workspace to
Workspace.
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1.5 What's New in DPL™ 9

This section is intended as a reference for users of previous versions of
DPL. A list of some of the major changes and new features in DPL 9 by
version are provided below.

DPL 9 Professional

More flexible modeling, Decision Tree or Influence Diagram-focused

Select which modeling mode you prefer: Decision Tree-focused,
Influence Diagram-focused, or no preference (i.e., split halfway
between) and build your model entirely in the view you prefer.

Modeling Ease-of-use Improvements
Multi-select any object in the Influence Diagram or Decision Tree to

make multiple changes at once. Manipulate the Decision Tree via a
streamlined and more intuitive use of the mouse.

Graphical Output Improvements
Exercise full control over the marker size in all charts and the
percentiles and labels displayed in Risk Profiles.
New Time Series Percentile Chart for Initial Decision Alternatives
(Covered in Section 10.3)
Visualize cash flow over time for all your initial decision alternative to
gain a complete picture of how uncertainty evolves over time.
Selective Attributes (Covered in Section 10.2.1)
Got a lot of attributes? With this feature you can slim down your
Policy Tree by selecting exactly which attributes are displayed.
Perform Subtree and Continue (Covered in Section 7.2)
Just like it says — perform a subtree and then continue descending
the tree with further events so you can define you decision problem
with precision.

DPL 9 Enterprise

Multiple-objective Functions (Covered in Section 8.3)

Who's making that decision? Optimize multiple objective functions
simultaneously within a single model to get a handle on the actions
of partners or adversaries.

Parallel Endpoint Recording (Covered in Section 11.6)

Divide and conquer by running a large model on several different
machines.
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Allow Event Already Active (Covered in Chapter 15)

Need to model a decision where you need to encounter the same
event more than once on a single path in the tree? Model it with
ease by enabling the new "Allow event already active and halt with
penalty value" feature.

Enhanced API and Improved Database Performance

Expanded functionality for embedding DPL in an automated decision
support system and better database connectivity under the covers.

DPL Takes you from Data to Decisions (Covered in Chapter 20)
Estimate probabilities and discover conditional relationships so you
can swiftly leverage your data to make better decisions.

All Versions

64-bit Executable
Exploit the scalability of the 64-bit Windows architecture.
.XLSX Conversion

DPL now does Excel XML: convert an .xlsx/xlsm spreadsheet to a
DPL Program for a huge performance boost.
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2. Building a Model in Decision Tree-
focused Mode

The next few chapters of this guide will focus on building simple
spreadsheet-linked DPL models from scratch for real-world decision-
problems. In this chapter a spreadsheet-linked DPL model is built in
Decision Tree-focused mode. In DPL, Influence Diagrams and Decision
Trees work together to provide a complete definition of the decision
problem — but at times, certain decision-problems lend themselves to being
modeled primarily within one medium or the other.

A Decision Tree provides an intuitive, map-like representation of the
sequence and structure of a decision problem. Throughout this tutorial
you'll be introduced to many key Decision Tree building features, such as,
creating local Decision Tree events, modifying the Decision Tree structure,
adding conditioning, linking tree events and the output metric to Excel and
editing get/pay expressions. If you are new to DPL and would like to
familiarize yourself with the skills needed to build Decision Tree models,
this is a great place to get started. To round out your DPL modeling skills,
Chapter 4 contains a tutorial in which you build a model in Influence
Diagram-focused mode from an Excel spreadsheet.

In this tutorial you will be developing a Decision Tree model for a drug
development decision. The final model will include technical, regulatory,
and commercial uncertainties along with a downstream decision, or exit
option. At the start of Chapter 3 you will run an analysis on the completed
model and examine the resulting DPL outputs.

2.1 Decision Tree Overview

A DPL Decision Tree is made up of decision and chance nodes and one or
more output metrics, which can also be referred to as objectives. A
decision node has one or more alternatives. During a decision analysis, one
alternative is determined to be optimal. Decision nodes appear as yellow
squares with its number of alternatives as branches in the Decision Tree.

A discrete chance node has a discrete set of outcomes that are uncertain.
Discrete chance nodes appear as green circles with its number of outcomes
as branches in the Decision Tree. Since both decision nodes and chance

43



Chapter 2 Syncopation Software

nodes represent things that happen at a particular point in time, they are
referred to as events.

The output metric is the calculated end result of the model/spreadsheet to
be maximized (or minimized, if appropriate).

You will be developing a Decision Tree model for a drug development
decision by adding several local, non-spreadsheet linked events to the
Decision Tree. The events and the output metric for the model will then be
linked to the Drug Development.xIsx Excel spreadsheet, which is an
example file that has been installed with the DPL software.

The resulting DPL model and its associated spreadsheet are set up to
calculate the value of a pharmaceutical R&D project. The project is in an
early stage, so there is lot of uncertainty about whether it will succeed
through the various technical hurdles. If it does succeed, its revenues are
influenced by the following market uncertainties: Key Competitor Outcome,
Pricing, Market Size and Market Share.

= Open DPL if it isn't already.

DPL will load with an empty Model Window on the right-hand side of the
screen as shown in Figure 2-1. The pane(s) displayed within the Model
Window will depend on your current modeling mode setting: Decision Tree-
focused, Influence Diagram-focused, or a halfway split. If you've never
changed the setting, the DPL Workspace will open in Decision Tree-focused
modeling mode by default, as shown in Figure 2-1.
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) Ho-8- DPL - Workspacel - 0 x
HOME  INFLUENCEDIAGRAM  DECIIONTREE = VIEW  DATA  HELP -8
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Figure 2-1. Blank DPL Workspace with Decision Tree Pane Maximized

Before you start building the model, you will change some of the default
decision and chance node settings for the model in order to better fit the
decision structure.

2.2 Symmetric vs. Asymmetric Trees

Prior to modifying node settings you'll first need to understand the
difference between a "symmetric" and an "asymmetric" node in DPL. A
symmetric node is defined as a node whose branches (e.g., outcomes or
alternatives) all lead to the same next event. Once placed, you'll see that a
symmetric node will have only blue endpoint node or connection point (the
blue triangle) for all of its branches. A symmetric Decision Tree is one that
contains only symmetric nodes.

With the current default model settings new events added to the Decision
Tree will have a symmetric outcome grouping. Furthermore, if you were to
start building your model within the Influence Diagram DPL will
automatically build a symmetric, default Decision Tree for you. Default
trees will be discussed in detail within Section 4.4.

See Figure 2-3 and Figure 2-6 for an example of a single symmetric
decision node and a symmetric Decision Tree.
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Develop?

Yes

0y <

Figure 2-2. A Symmetric Decision Node

Market Market Pricin
Develop? FDA Share Size treing
Leveon s Approval
Low Low
Yes Yes NPV
Nominal Nominal Nominal <I
No No NPV
High High High
NPV

Figure 2-3. A Symmetric Decision Tree with 5 Symmetric Nodes

In contrast, an asymmetric Decision Tree contains one or more asymmetric
nodes. With asymmetric nodes, each branch may lead to a different next
event. When you add an asymmetric node to the Decision Tree, you'll find
that each branch has its own endpoint node or connection point. See
Figure 2-4 and Figure 2-5 for an example of a single asymmetric decision
node and an asymmetric Decision Tree.
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Develop?

Yes

No

Figure 2-4. An Asymmetric Decision Node

Market Market Pricin
Share Size nenn
FDA
Approval Low Low Low
Develop?
NPV
Yes Nominal Nominal Nominal ‘<l
Yes \-\ NPV
No High High High
No <| NPV

Figure 2-5. An Asymmetric Decision Tree with 2 Asymmetric Nodes

The concept of asymmetry in Decision Tree modeling is important because
many business decisions are asymmetric in nature: different strategic
alternatives are often influenced by different sources of uncertainty.
Modeling that asymmetry directly in the tree results in a model which
reveals the true structure of the problem, can improve computational
efficiency, and is useful for communication purposes.

The drug development model you're about to build includes several
uncertain, 2-outcome failure points, which are modeled with asymmetric
nodes. In order to build the model most efficiently, you will change the
applicable default model and workspace-level settings for newly added
Decision Tree events to match this structure.

= Click File | Options, which will launch the File Options dialog with the
General tab active.

47



Chapter 2 Syncopation Software

Notice the default settings for Outcome names/probs for new chance nodes
under the Decision/chance node defaults section. The outcome names for
new chance nodes are set to be Low, Nominal and High with probabilities
of .3, .4, .3 assigned, respectively. You will change these defaults to better
match the structure of the events that define the drug development case.
This will result in a more efficient and compact model build out.

= Delete the name and probability assigned to the High outcome.
= Select the name for the Low outcome and rename it to be "Success".
= Change the probability for the Low outcome to be ".7".

= Edit the name of the Nominal outcome to be "Failure" and delete its
probability.

To the right, beneath the Alternative names for new decision nodes
heading, you can see that the default alternatives for new decisions added
to the tree will be set to "Yes" and "No". You'll leave the defaults for
decision events as they are. The outcome name and probabilities for new
chance nodes should now look like Figure 2-2.

48



Syncopation Software Chapter 2

Options

General  Outputs  Workspace

Display
Restore window position on startup Max number of lines to display in log:
Colored amowheads (arcs
5 - fares) Lines to clear when max exceeded:

For new models, madmize pane: (@) Influence Diagram () Decision Tree () Meither, split hatfway

Undo levels

Graphicmodels: [30 | (100max) DPL code: {1000 max)

Decision/chance node defaults

COutcome names,/probs for new chance nodes Altemative names for new decision nodes
Mame Probability MName

| Second altemative:
|

[ Automatically add new decision/chance nodes to non-default decision trees

Middle outcome: |Fai||.|re

Low outcome: |5uccess ||'.-" | First altemative: Yes
| |
| |

High outcome: |

After node name change
(_) Beplace old with new in node data and get/pays () Dont replace (®) Prompt

Cancel Help

Figure 2-6. Updated Outcome Name and Probabilities
for New Chance Nodes

= Click OK to close the File Options dialog.

Now you will change the default outcome grouping for newly added chance
events. More specifically, you are going to change the default outcome
grouping setting so that new events added to the tree are asymmetric.

= Click Decision Tree | Model | Settings. The Decision Tree tab of the
Model Settings dialog is displayed.

= Set the Alternative/outcome grouping for newly added nodes radio
button to Asymmetric.
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The Decision Tree tab should now look like Figure 2-7.

Model Settings - Modell

Links Decision Tree

[lgnore condttioning events in an unknown state {default states will be used in calculations)

] Allow event already active and hatt with penalty value: -1000000000

Altemative /outcome grouping for - Ij‘_ "
newly added nodes: O Symmetric —

Advanced settings
[ Risk tolerance and utility functions by branch

[]Use these settings for new models/programs

Concel | | o

Figure 2-7. Updated Alternative/Outcome Grouping Settings

= Click OK to close the Model Settings dialog.

2.3 Adding a Decision Node

You will start to develop the model by adding several local events to the
Decision Tree. The first event added is the upfront or initial decision as to
whether to develop the drug or not.

A decision node has two or more alternatives. DPL will o
choose the decision alternative that maximizes the Decisiont
output of the model (referred to as the objective Ves
function). A decision node is represented in the

Decision Tree by a yellow square. Each branch coming E@ <
from the node represents a decision alternative. The

image to the right displays a symmetric decision node

named Decision1 with two alternatives, Yes and No. Symimetric

Decisfon Node

= Click top half of the Decision Tree | Node | Add split
button to add a new decision node to the tree.
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Decision node should be the default command indicated by the icon. If it
isn't, drop down the split button list and select it.

Once you've clicked Add, your cursor will move down to the Decision Tree
pane and have a semi-transparent decision node beneath it.

= Click somewhere in the left side of the Decision Tree pane to place the
decision node.

Once placed the Node Definition is opened with the General tab active as
shown in Figure 2-8. This is where the node name and its states are
defined.

MNode Definition: Decision

General Data  Links  Tree Instance

Name and settings

Otice
DPL variable name for expressions:
Decision1
Atematives
Yes (Default) Add
No
Insert
Delete
Bename (F2)
Defautt

Comments

Print All Comments...

Copy to Clipboard

Cancel Help

Figure 2-8. General tab of Node Definition dialog for Decision Node

Note: There is an Alternatives list box on the General tab of the Node
Definition dialog for decision nodes. You can add, delete, insert or rename
decision alternatives. As you saw previously, the default alternative names
can be changed in File | Options | General. You will the alternative names
as is.

Notice that the first decision alternative ("Yes") is designated as the
"default" alternative. You don't need to worry about this right now. Default
alternatives will be discussed in more detail in Sections 2.10 and 5.4.

= Type "Develop?" for the node name.
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= Leave the alternatives as the defaults, Yes and No.
= Switch to the Data tab.

The Data tab displays a graphical data input tree that allows you to enter a
value expression for each decision alternative. The first alternative is
shaded magenta, DPL's selection color, which means the value edit box for
the "Yes" alternative is selected for editing. You can use the down arrow
key or the Enter key to select the next alternative.

There are several buttons on the Data tab which allow you to edit a node's
conditioning; zoom the input data tree; maximize the dialog to full screen;
and specify variables and functions via a dialog to help input the data.
These are discussed in more detail later.

= Enter a value of "1" within the value text edit box for the Yes
alternative and press the down arrow key to move to the No
alternative.

= Enter a value of "0" for the No alternative and press Enter.

Your data input tree should now match Figure 2-9.

Mode Definition: Develop?

General Data  Links  Tree Instance

Conditioning. .. LCopy Full Scieen wheel Fieorder Cf oy CP Cf‘ Fant...

|[v][f

Yes
Develop?
= O

0

Concel | |t

Figure 2-9. Data Input Tree for Develop? Decision Node
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Note: All of the events included in this Decision Tree model will have "flag"
values associated with their outcomes/alternatives (e.g., 1 and 0), as
opposed to the event's actual numeric values (e.g., $10,000,000, 50,000
units, etc.). These flags correspond to logic in the spreadsheet. All Yes/No
and Success/Fail events are assigned values of 1 and 0, respectively.
Chance events with Low/Nominal/High outcomes are assigned flag values
of 1, 2, and 3, respectively.

= Click OK to close the Node Definition dialog.

Notice that the newly added decision node is asymmetric with each
decision alternative having its own blue endpoint node. This is due to the
fact that the default outcome grouping settings have been changed. In the
Decision Tree, blue endpoint nodes serve as the connection point when
adding events to the tree.

= Press ESC to deselect Develop?. Your model should look like Figure
2-10.

Note in a number of the images that follow nothing is selected. The images
will differ slightly from what you see in DPL after e.g., editing a node. By
default, items remain selected in DPL after you edit them. The images
show the model with no selection.

Develop?

Yes

No

Figure 2-10. Asymmetric Develop? Decision Node
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2.4 Adding a Chance Node

Now you'll add the first uncertain event to the tree: a discrete chance
node. In DPL, a discrete chance node has two or more outcomes which
occur with specified probabilities. During an analysis, DPL will evaluate
each chance outcome to calculate the expected value of the decision model
when rolling back the Decision Tree.

A discrete chance node is represented in the Chancef

Decision Tree by a bright green circle. Each

branch coming from the node represents a Low

chance outcome. The image to the right .

displays a symmetric, discrete chance node Nominal <

named Chancel that has three outcomes: Low, .
. . High

Nominal, and High.

= Create a new discrete chance node by Symmetric Discrete
dropping down the Decision Tree | Node | Chance Node

Add split button and selecting Discrete
Chance from the list.

= Place the node on the endpoint (blue triangle) for the Yes alternative of
the Develop? decision. The General tab of the Node Definition dialog
appears.

Similar to the decision node in Section 2.3, the General tab of the Node
Definition dialog contains an Outcomes list box within which you can add,
delete, insert or rename chance outcomes. The outcomes reflect the names
specified earlier within File | Options | General (Figure 2-6). Furthermore, it
designated the "Success" outcome as the default outcome. You don't need
to change this setting for the purposes of this tutorial.

= Type "Phase 1" for the node name. Leave the outcomes as they are.
= Switch to the Data tab.
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The data input tree for discrete chance nodes includes the following input
options for each outcome:

1. Distribution type drop-down list,
2. a Probability edit box,
3. and a Value edit box

These input options are labeled in Figure 2-11.

Node Definition: Phase 1

General Data  Links  Tree Instance
Conditianing... Copy -IIScreen Wwiheel Feorder | Multiple Experts... (:f . {:P Cf‘ Fant...
Distribution type: | [discrete]
Frobability: |ﬁ |?| | 14 f
Walue: |1 \ I_'\ | v f
\ 2
Phase Success
1
Fallure {:I
0
v
< >
Cancel Help

Figure 2-11. Data Inputs for Discrete Chance Node Outcomes

The Distribution type drop-down is currently set to "(discrete)" which is
what you want — as you will be entering explicit probability and value data
throughout this tutorial. For certain chance events, you may find that it's
more appropriate to select a named distribution from the list for a node's
probability and/or value data. For more information on named distributions,
refer to the Online Help (pressing F1 launches a web browser with
contextual Online Help).

Presently, the probability input for the Success outcome is ".7" and is
selected for editing. Recall that ".7" is the default probability specified
within File | Options | General for the Success outcome for new chance
nodes. Note that you can specify numbers or formulas in the probability
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edit box but you'll be leaving the probability as it is. There is a 70% chance
of success in Phase 1 of the project and that it continues to Phase 2.

= Press the down arrow key to select the value edit box for the Success
outcome and enter a "1".

= Press the down arrow twice (skipping over the probability input for the
Failure outcome) and enter a "0" for the value input for the Failure
outcome. Press the Enter key.

The Data tab of the Node Definition dialog should now look like Figure 2-12

Nede Definition: Phase 1

General Data  Links  Tree Instance

Conditioning. . LCopy Ful Screen wheel Fearder | Multiple Experts... Cf' oy CQ (f‘ Font...

Distribution twpe: | [discrete] v

Prabailin: |ﬁ | V|| f
Walue: |1 | V|| f

Phase Success
1 [ ] 1
Failure D

0

Corcel | | b

Figure 2-12. Data Input Tree for Phase 1 Discrete Chance Node

Note that you entered a probability for only one of the two uncertain
outcomes, DPL will automatically calculate the other (1-p). This is a small
time saver allowed by DPL.

= Click OK to close the Node Definition dialog. Your model should now
look like Figure 2-13.
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Phase

Develop? 1

Success

Yes
Failure

Figure 2-13. Decision Tree with Newly Added Chance Node

Again, you should note that each of the Phase 1 outcomes has its own
unique blue endpoint node. Notice as well, that the Phase 1 node is
connected only to the Yes alternative, and not the No alternative. The No
alternative ends in a blue endpoint indicating that it is a terminal
alternative (DPL will stop calculating the path at that point). Now you'll add
the next uncertain event, which has a slightly different structure than the
first.

=

g 4 44 0

Click Decision Tree | Node | Add to add another discrete chance node
to the tree.

Place the node on the endpoint for the Success outcome of the Phase 1
uncertainty. The General tab of the Node Definition dialog appears.

Type "Phase 2" for the node name.

Within the Outcomes box, double-click the first outcome (Success) to
enter text edit mode.

Edit the outcome name to be "Success - Once a Day" and press the
Enter key.

Arrow down once to select the next outcome. Click the Insert button to
insert a new outcome. Name this new outcome "Success - Twice a
Day" and press Enter.
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= Leave the Failure outcome as is. The General Tab should look like
Figure 2-14.

MNode Definition: Phase 2

General Datz  Links  Tree Instance

MName and settings

Phase [ Hide

2

[[] Separate probability and value data input trees

DPL variable name for expressions:
Phase_2

Outcomes

Success - Once a Day (Default) Add
Failure Insert
Delete
Bename (F2)

Defautt

Comments

Prirt Al Comments...

Copy to Clipboard

Cancel Help

Figure 2-14. General Tab of Node Definition Dialog for
Phase 2 Chance Node
Switch to the Data tab.
Enter .2 for the probability of Success — Once a day.
Arrow down once, enter 1 for the value of Success — Once a day.

Repeat the process to enter .2 and 1 for the probability and value of
Success — Twice a Day, respectively.

4 44438

Repeat the process again to enter .6 and 0 for the probability and
value of Failure, respectively.
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The Data tab of the Node Definition dialog for Phase 2 should now look like
Figure 2-15.

Mode Definition: Phase 2

General Data  Links  Tree Instance

Conditinning LCopy Full Screen Wheel Bearder | Multiple Experts Cf' [y CP (f‘ Fant.

Distribution type: | (discrete] ~

Probabilty: |[V][f
Walue: |1 | V|| f

Success - Once a Day

Success - Twice a Day
2

Failure
5 -0

G | [

Figure 2-15. Data tab of Node Definition dialog for
Phase 2 Chance Node

The outcome grouping for this 3-outcome uncertainty is mixed, meaning
some subset of the states leads to the same next event, while another
subset leads to a different next event. More specifically, the two success
outcomes will share a single blue endpoint node and the failure outcome
will have its own endpoint. You will modify the node's outcome grouping
setting via the Tree Instance tab.

= Switch to the Tree Instance tab.

Within the Outcome grouping section select the Mixed radio button.
This will launch the Select Groups dialog.

Select both the "Success - Once a Day" and "Success - Twice a Day"
outcomes by pressing the Ctrl key and clicking each one.

=
=
= Click the Group >> button.
=

Select the Failure outcome and click the Group >> button.
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If you make a mistake, click the reset button to reset the outcomes and try
again. The Select Group dialog should look like Figure 2-16.

Select Groups

Outcomes: Groups:
1: Success - Once a Day
1: Su_u:u:ess - Twice aDay
Group 33 2 : Failure
Urigroup <<
Rezet
Cancel

Figure 2-16. Select Groups dialog for Phase 2 Chance Node
= Click OK twice to close both dialogs.

Your Decision Tree should now look like Figure 2-17.

Phase
2
Phase
Develop 1 success - Once a Day
sSuccess Success - Twice a Day <I
Yes
Failure Failure
No <|

Figure 2-17. Decision Tree with Newly Added
Mixed Outcome Chance Node
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Next there are two additional 2-outcome, Success/Fail Discrete Chance
nodes to incorporate to round out the technical and regulatory hurdles.

= Create a new discrete chance node and place it on the endpoint for the
Success outcomes of the Phase 2 node.

Type "Phase 3" for the node name.

Switch to the Data tab and enter .8 for probability of success. As
before, you can leave the probability blank for Failure.

Enter values of "1" for Success and "0" for Failure. Click OK.

Create another new discrete chance node, place it on the endpoint for
the Success outcome of Phase 3 and name it "Regulatory Approval".

Switch to the Data tab and enter .9 for probability of success.

g4 44 48

Enter values of "1" for Success and "0" for Failure. Click OK.

Your Decision Tree should now look like Figure 2-18.

Requlatory
Phase F’hase Approval
2

Phase Success
1 Success - Once a Day Success
Develop? Failure
Success Success - Twice a Day Failure
Yes
Failure Failure
No

Figure 2-18. Decision Tree with Techincal
and Regulatory Uncertainties

At this point, you may want to name your DPL model and save your
Workspace file.

= Select the item for the model in the Workspace Manager (DPL gave it
the default name of "Model1").

= Press F2 to edit the name.

= Type "Drug Development" or any other name you'd like.

= Press Enter to save the edit.

= Save the Workspace to a convenient location and give it a name of
your choice using File | Save.
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Now you will add a few market uncertainties to the model. The structure of
these uncertainties are more similar to the DPL's original defaults (e.g., 3-
outcome and symmetric), so you'll revert back to those settings.

= Go to File | Options | General.

= Under the Outcome names/probs for new chance nodes heading, edit
the name and probabilities to match Figure 2-19.

Options

General Qutputs  Workspace

Display

Restore window position on startup Max number of lines to display in log: | 1000

[ Colored heads |
b Colored arowheads (arcs) Lines to clear when max exceeded: | 100

For new models, maximize pane: () Influence Diagram (@) Decision Tree () Neither, split hatfway

Undo levels

Graphic models: (100max) DPL code: (1000 maxe)

Decision/chance node defaults

Outcome names.,probs for new chance nodes Altemative names for new decision nodes
Name Probability MName

Low outcome: |an | |.3 | First altemative: Yes

Middle outcome: |N0mina| | |.4 | Second atemative:

High outcome: |High | |_3 |

[] Automatically add new decision/chance nodes to non-default decision trees

After node name change
() Replace old with new in node data and get/pays () Dont replace (®) Prompt

Cancel Help

Figure 2-19. Outcome Names and Probabilities for
New Chance Nodes Reverted to Original Defaults

= Click OK to close the File Options dialog.

= Click Decision Tree | Model | Settings and set the Alternative/outcome
grouping for newly added nodes radio button to Symmetric.

= Click OK to close the Model Settings dialog.
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Before editing the tree further, it should be noted that in DPL you can have
either a node or branch(es) selected within the Decision Tree. Note: DPL
indicates what is selected by coloring it magenta. In Figure 2-20, the
Develop? node is selected. In Figure 2-21, the branches are selected
of the Develop? node.

Market Market |
F?;al Share “Size Pricing

Low Low Low
Yes Yes MNPV
Mominal MNominal Mominal
Mo Mo NPV Q
High High High
NPV

Figure 2-20. Develop? Node Selected in Decision Tree

Market Market |
FDA Market b
o oA - ricing
Develop? Approval Share Size
Low Low Low
Bl e NPV
D" - Nominal Nominal Mominal Q
No NPV
19 9 g
High High High
NPV

Figure 2-21. Develop? Branches Selected in Decision Tree

Double-clicking a node in the Decision Tree launches the Tree Instance tab
of the Node Definition dialog. Double-clicking the branches of a node in the
Decision Tree brings up the Get/Pay tab of the Branch Definition dialog
(more on this later). Further to this, certain button and edit boxes (for
example, the Edit Get/Pay box) on the command ribbon are active/inactive
depending on what is selected in the Decision tree (node or branch(es)).
Lastly, you can have multiple items and a mixture of nodes and branches
selected in the Decision Tree. Many of the commands on the Decision Tree
tab can be executed when you have multiple items selected, regardless of
whether you have a mixture of nodes and branches selected.

You will now continue building out the model by adding the market
uncertainties to the Decision Tree.
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= Add a new discrete chance node to the model via Decision Tree | Node

=
=
=
=
=
=

4

| Add.

Place the node underneath the Develop decision in the tree. It should
not be connected to any other nodes yet.

Type in "Key Competitor Outcome" for the node name and rename the
outcomes to be "Failure", "Disappointment”, and "Breakthrough".

Switch to the Data tab and leave the default probabilities.
Select the right end of the Failure branch in the data input tree.
Enter 1.

Arrow down twice and enter 2 for the value of Disappointment.
Repeat to enter 3 for the value of Breakthrough.

The data input tree for Key Competitor Outcome should look like Figure
2-22.

Mode Definition: Key Competiter Outcome

General Data  Links  Tree Instance

Conditioning... LCopy Full Screen Wheel Beorder | Multiple Experts... || of||QT (:P cf|| Fant..
Distribution type: | [discrete] ~
Probabilty: E |[v][F
Walue: "I | V|| f
~
Key Failure
Competitor _
Outcome

Disappointment
. O

Breakthrough
3 70

Cancel Help

=

Figure 2-22. Data Input Tree for Key Competitor Outcome

Click OK to close the dialog.
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Your Decision Tree should now look like Figure 2-23.

Regulatory
Phase Phase Approval

2
Phase Success
1 Success - Once a Day Success
Develop? Failure
Success Success - Twice a Day Failure
Yes
Eailure Failure
No

Key
Competitor
Oufcome

Failure

Disappointment

<

Breakthrough

Figure 2-23. Decision Tree with Key Competitor Outcome Added

You may be wondering why the Key Competitor Outcome isn't connected
to the rest of the tree. For large Decision Trees, you can improve
readability (i.e., increase the zoom level) by breaking the tree into two or
more sections and placing each section in a more easily viewable space.
But you'll need to link the subtree sections together via DPL's Perform
Subtree command.

Sections of a Decision Tree are referred to as subtrees. When a subtree is
needed in more than one place in the Decision Tree, you can use the
Perform Subtree feature to avoid having redundant instances of the same
set of nodes. In this case, you're only using the Perform Subtree feature
for cosmetic purposes, so it is performed just once. You'll do this in order
to link the Key Competitor Outcome event (and those that will eventually
follow) to the Success endpoint of the Regulatory Approval node.
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= Select both the endpoint for the Success outcome of the Regulatory

Approval node and the Key Competitor Outcome node by pressing the
Ctrl key and clicking both items.

The selections should look as they do in Figure 2-24.

Regulatory
Phase Phase Approval

2 3

Phase

Success
1 Success - Once a Day Success
Develop? Q Failure ;
Success f( Success - Twice a Day d Failure

Yes q
Failure Failure
No

Failure

Disappointment

<«

Breakthrough

Figure 2-24. Decision Tree with Items Selected for
Performing a Subtree

= With the items selected, click the Decision Tree | Instance | Subtree
button as shown in Figure 2-25.

Asyrmmetric
o< _ -
0 Detach

Add @ ubtree

Instarice

Figure 2-25. Decision Tree | Instance | Subtree Command

DPL assigns a label consisting of a single letter on the node to be
performed (the perform target) at the head of the subtree and also adds a
node of the same type and with the same label as the perform target just
before a new connection endpoint (the perform reference) (Figure 2-26).

In effect, you have copied the node and its subtree to the point from
where it is to be performed.
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Requlatory
Phase Phase Approval

2
Phase Success
1 Success - Once a Day Success
Develop? Failure
Success Success - Twice a Day Failure
Yes
Failure Failure
No

Key
Competitor
QOutcome

Failure

Disappointment

<

Breakthrough

Figure 2-26. Decision Tree with Perform Subtree Link

Now you'll add the remainder of the market uncertainties: Pricing, Market
Share and Market Size.

= Click Decision Tree | Add | Discrete Chance and place it on the
endpoint for Key Competitor Outcome.
= Type "Pricing" for the node name and leave the default outcomes.

= Enter values of "1", "2", and "3 for the Low, Nominal, and High
outcomes. Be sure to enter in the values position and leave the default
probabilities as is.

Click OK to close the Node Definition dialog.

4 4

Just as you did for Pricing, add two more chance nodes to the tree for
Market Size and Market Share. Each will have the default probabilities
and flag values of "1", "2", and "3" for the Low, Nominal and High
outcomes, respectively.
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Your Decision Tree should now match Figure 2-27.

Requlatory
Phase Phase Approval

2 3
Phase Success
1 Success - Once a Day Success Q
Develop? Failure

Success Success - Twice a Day Failure q
Yes

Failure Failure
No

Key
. . Market Market
Competitor Pricing Size Share
Outcome —
Failure Low Low Low
& Disappointment Nominal Nominal Nominal q
Breakthrough High High High

Figure 2-27. Decision Tree with Technical, Regulatory,
and Market Uncertainties

2.5 Adding Probabilistic Conditioning

The Marketing Team believes that the Market Share outcome will depend
heavily on the dosing outcome of Phase 2. If a once-a-day formulation is
achieved, a significant share of the market will be captured. On the flip-
side, if only a twice-a-day formulation is achieved a much lower market
share will be captured.

In DPL, you can model this conditioning explicitly within the Market Share's
node data. You can specify that the dosing outcome of the Phase 2 chance
node influences the probabilities of the Market share chance node — but
not the values. To model this most efficiently you'll separate the Data input
tree for Market Share into two: one for probabilities and one for values.

= Double-click the Market Share node (not the branches) to edit its data.

= Switch to the General tab and check the Separate probability and value
data input trees box.
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Note that the Data tab has been split into tabs: one for entering value data
(Values) and the other for entering probability data (Probabilities). You'll be
editing just the Probabilities.

= Switch to the Probabilities tab and click the Conditioning button.
The Conditioning dialog will appear with a list of all the events in the tree.

= Select Phase 2 as shown in Figure 2-28. Click OK to close the
Conditioning dialog.

Conditioning: Market Share

The probabilities faor this node depend on:

Continue to Phasze 3
Develop?

K.en Competitar Dutcome
Launch

Market Size

Phaze 1

Phasze 3
Pricing
Regulatory Approywal

CIEEE

Mumber of probability exprezzions reguired: 9

Carcel

Figure 2-28. Selecting the Phase 2 Uncertainty to
Condition the Probabilties of Market Share

As indicated near the bottom of the dialog, you will now have 9 probability
inputs for Market Share: a Low, Nominal, and High outcome for each of the
three outcomes of the Phase 2 node.
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= Enter the probabilities provided in Table 2-1(left to right, then down to

the next row) for Market Share:

Low Nominal High
Success — Once a Day 0 0.4 0.6
Success - Twice a Day 0.6 0.4 0
Failure (not used but required) 0.3 0.4 0.3

Table 2-1. Probability Inputs for Market Share given Phase 2

Your data input tree for the probabilities of Market Share should look like

Figure 2-29.

MNode Definition: Market Share

General Values Probabiities  Links — Tree Instance

Copy ilhesl Cf | (P C{‘ Fant..
|E | HMultiple Experts. ..

Conditioning.. Full Screen FRieorder

v||.f

Market
Success - Once a Daghare

Nominal
4

High

L]

Low
Market 6
Nominal
4

High

0

Low
Market 3
Share Nominal
4

High

3

Phase
2 Success - Twice a Daghare

Failure

-~

Cancel

Help

Figure 2-29. Probability Data Input Tree for
Market Share with Conditioning
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As you can see from Market Share's probability data input tree, if you
succeed in producing a once-a-day formulation you are much more likely to
capture significant market share (High outcome is 60%). Whereas for the
twice-a-day formulation you're likely to capture a lower portion of market
share (60%).

= Click OK to close the Node Definition dialog.

2.6 Linking Decision Tree Events to Excel

It is possible to put all value model calculations directly in DPL but most
often a DPL Decision Tree/Influence Diagram model is linked to an existing
cash flow spreadsheet that does the value model calculations and
calculates metrics such as NPV (net present value). You'll proceed by
linking the Decision Tree events to a typical cash flow spreadsheet. You
can quickly link each of these chance and decision events in the tree to a
named, driver cell in the Drug Development.xlsx spreadsheet via the Link
Model Events dialog.

= Click Decision Tree | Links | Link Events.

You'll be prompted to browse for the location of your Excel spreadsheet.
The spreadsheet is located within the Examples folder of the DPL
installation directory, usually C:\Program Files\Syncopation\DPL9\Examples.

The directory may vary slightly depending on your license type (trial or full
version) and operating system.

= Select Drug Development.xlIsx from the list and click Open.

This will open the spreadsheet and launch the Link Model Events dialog.
The first column (Name) lists the all events in the model by node type, with
decisions coming first, and then in creation order within type. The edit
boxes within the Ce// column are used to link events to a particular driver
cell. The Ce// drop-down lists all the named, driver cells suitable for linking
alphabetically by SheetName!Cell_Name. The last two columns indicate the
Link Type (Unlinked, Driver, or Metric) and Node Type (Decision, Discrete
Chance, or Continuous Chance).

= For the Develop decision, click in the Cell edit box. It will become active
(i.e., magenta border) and a drop-down arrow will appear.

= Click the drop-down arrow to view the list of driver cells and select
"Assumptions!Develop" from the list.
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= Continue linking the rest of the events using Table 2-2

Name Cell

Phase 1 Assumptions!Phase_1_success

Phase 2 Assumptions!Phase_2_success

Phase 3 Assumptions!Phase_3_success
Regulatory Approval Assumptions!Reg_approval

Key Competitor Outcome Assumptions!Key_competitor_outcome
Pricing Assumptions!Pricing

Market Size Assumptions!Market_size

Market Share Assumptions!Market_share

Table 2-2.Node and Cell Names for Linking Model Events
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Your Link Model Events dialog should look like Figure 2-30.

Link Drug Development Events to S:\dpl®0\Examples\Drug Development.xlsk

Mame Cell Link Type Mode Type

DEVE|Dp Assumptions!De\relop Unlinked Decisian Cancel
Phase 1 Assumptions!Phase_1_success |Unlinked | Discrete Chance

Phase 2 Assumptions!Phase_2_success |Unlinked | Discrete Chance Go to Nods
Phase 3 Assumptions!Phase_3_success |Unlinked | Discrete Chance

Regulatory Approval Assumptions!Reg_approval Unlinked | Discrete Chance Go ta Cell
Key Competitor Outcome | Assumptions!Key_competito... |Unlinked | Discrete Chance

Pricing Assumptions!Pricing Unlinked | Discrete Chance

Market Size Assumptions!Market_size Unlinked | Discrete Chance

Market Share _ Unlinked | Discrete Chance

Figure 2-30. Link Model Events dialog with Driver Cells specified

= Click OK to close the dialog.

When you build a spreadsheet-linked DPL model as you are now, you will
typically have DPL send different sets of drivers to Excel and then ask Excel
to send back one or more metrics. Nodes in DPL that send data to Excel
are called driver nodes. All of the nodes you have created so far are driver
nodes. Nodes that receive data back from Excel are called metric nodes.
You will now create a metric node.

2.7 Creating and Linking the Output Metric

The model is nearly complete. The last step before running a decision
analysis is to create and link the output metric to the named, metric cell in
Excel and add it to the Decision Tree as a get/pay expression. A get/pay
expression tells DPL what value to get (i.e., you receive) or pay (i.e., you

73



Chapter 2 Syncopation Software

pay out) at each point in the tree. The get/pay expression is displayed
below the branch(es) on which it occurs in the Decision Tree.

It should be noted that metric nodes are a type of value node. Value nodes
are a number or calculated quantity in DPL. Value nodes do not appear
directly in the Decision Tree; rather, the name of value node(s) may
appear in get/pay expressions on branches of events in the Decision Tree.
Unlike a decision or chance node, a value node is not an "event" and as
such does not appear as a node in the sequence of the tree.

With the desired set of branches selected, you'll use the Link Excel Metric
command to create and link the output metric and place it in the Decision
Tree as a get/pay expression all at once.

= Select the branches of the Market Share node.

= Within the Decision Tree | Get/Pay group drop-down the Get/Pay
combo box (bottom combo box in the group; see Figure 2-31).

= Choose "<Link Excel Metric>" at the bottom of the list as shown in the
Figure 2-31.

&l H -3~ DPL - Drug Development.da - [Drug Development] - 0 %
HOME  INFLUENCEDIAGRAM  DECISIONTREE =~ VIEW ~ DATA  HELP -
“/" O Add Eg:l @ e Asymmetric ~| Remove  Objective Function - Maxe
L i T Sy s
Edit | EL‘:’K Manage ﬂ_dd Control - Develop. ttolerance: | (none) ~|v f ME_[‘E'
et Hode ik Instance ortral Bl Continue_to_Phase 3 P 5
Object ks stance Control/Block Laune Objective & Utility
Workspace Manager P Drug Development | Phase_1 AL
Phase 2
= <& Drug Development.da Phase_3 ~
2= Drug Development Regulatory Approval
Key_Competitor_Outcame Regulator
Pricing
Market Size Phase Approval
Market_Share
Ph;s 2 Success <|
T to Phase 3
Phase
1 Success - Once a Day Failure
Develop?
Success Success - Twice a Day
Yes
Failure
Session Log b Failure
DPL - Decision Programming Language  a No
Copyright @ 2003-2017 by Syncopation Key
Incorporating software on license to Market Market
Syncopation Software, Inc. Competitor Pricin Size Share
Alrights reserved. Outcome
Use of this software is governed by the
Failure Low Low
‘wews Syneopation.com
Support@syncopation.com
US toll-free: 1 856 796 2375 Disappointment Nominal Nominal
Outside the US: +1 978 233 2509
o ernal Buid) Breakthrough High High
ic er3t,
00 (beta 4)
Buit Jan 13 2017 11:22:42 (84-bi)
Internal Use Only - v
< > |« >

Use the drop down list to select a single quantity for the get/pay & n ortype in an expression involving more thai i I e —

Figure 2-31. Using Link Excel Metric Command to
Add Get/Pay Expression to Decision Tree
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The Range Names dialog will appear displaying a list of named ranges from
the Drug Development.xslx spreadsheet that contain formulas -- as DPL
correctly assumes you are looking for a calculated output metric.

= Scroll to the bottom of the list and select "Total_NPV".

= Click Select to close the dialog. The output metric is created and the

metric is placed in the Get/Pay expression on the branches of the
Market Share node as shown in Figure 2-32.

Regulatory
Phase F’hase Approval
2
Phase Success
1 Success - Once a Day Success
Develop? Q Failure 3
Success ,{ Success - Twice a Day Ci Failure
Yes
Failure Failure
No
Key
Competitor Pricing % %
Outcome — o
Failure Low Low Low
Total_NPV
Disappointment Nominal Nominal Nominal d
Total_NPV
Breakthrough High High High
Total_NPV

Figure 2-32. Decision Tree with Linked
Output Metric for Get/Pay Expression
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2.8 Running a Preliminary Analysis

Now that that all of the events and an output metric are defined and linked
to the spreadsheet you are ready to run a preliminary decision analysis on
the model to produce results. It's usually a good idea to run the model
periodically and check results as it's built to ensure proper set up and
logical results.

= Navigate to the Home tab. Check Policy Tree in the Home | Run group.

= Ensure all other outputs are unchecked. The Home | Run group should
match Figure 2-33.

n.;. Rizk Profile ¥| Policy Tree Levelz (10 (all} -

— (none) - Pelicy Summary Endpoints
Decision ) ) )
Analysis ™ WOIC Yalue Correlations

Figure 2-33. Home | Run Group Selection for Preliminary Analysis

The default Evaluation Method indicated by the Decision Analysis split
button is Fast Sequence Evaluation, which is what you want.

= Click top part of the Home | Run | Decision Analysis button. DPL will
run the analysis and generate the outputs requested.

When the run is complete the Policy Tree is displayed (Figure 2-34). The
Policy Tree output is described in-depth a bit later within Section 3.1. For
now it is key to understand that the optimal decision alternative (indicated
by a bolded line) is to proceed with developing the drug. If you do so the
expected NPV is 43.7 whereas if you decide not to develop the value is
zero. You will now expand the Policy Tree in order to inspect some of the
scenarios further down the tree.
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Phase 1
Develop?  Yes [43.7] O
[43.7]

No [0.0] |

Figure 2-34. Policy Tree” Output for Drug Development Model

= Right-click on the chance node at the end of the Yes branch of the
Develop? decision. This will launch the context menu.

= Select Expand to Level... from the list. This launches the Expand Policy
Tree dialog.

= Within the Expand to level box, enter "5". Click OK to close the dialog
and expand the Policy Tree (Figure 2-35).

Regulatory Approval

Phase3 Success [440.3]
Success - OnceaD...  [352.3] 80% (N 11%]) .
20% (N 14%) Failure @
20% (N 3%) —<

Regulatory Approval

Phase 2
Phase 1 Success [62.5]

Phase 3 Success [-42.9]
Develop? V&S S0 Success - TwiceaDay  [-38.9] 50% (N 11%,) O
K 20% (N 14%) Failure @
20% (N 3%) ~—A

Failure [0.0]
80% (N 42%)

Figure 2-35. Intial Policy Tree™ Expanded 5 Levels

Looking further down the tree you'll find that if the project were to fail at
any of the technical hurdles the expected value (the value at the end of
branches contained in brackets) is zero. DPL assumes a value of zero for
the No/Failure points because no get/pays were specified on those
branches.
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In reality if you were to develop the project through to Regulatory
Approval, for example, and fail to be approved, you would incur the cost of
R&D up to that point. To correctly model the situation at hand, you will add
a Get/Pay expression to each of the Failure branches of the Decision Tree
so that costs up to those points are included in the results.

The Drug Development spreadsheet is set up so that a single output
metric, Total NPV, is calculated correctly for each scenario in the tree (or
path through the tree). I.e., the spreadsheet is set up to calculate this
value correctly at each failure point, in addition to all the scenarios if you
get regulatory approval the end of the tree. Note that instead of using one
metric for all cash flows associated with the project you could separate
cash flow into multiple metrics, such as development costs, launch costs
and revenues/marking costs once the product is on market. It would be
your choice as to how you'd like to set up your spreadsheet logic and
resulting Get/Pay expressions. Importing data from several places in the
spreadsheet can result in a model that is more flexible and efficient, and
can also help communicate the model's logic.

= Double-click on the model within the Workspace Manager to activate it
(or press Ctrl+F12).

= Select the branches of the Market Share node and press Ctrl+C to copy
the get/pay expression to the clipboard.

= Select the Failure branch of Phase 1 and then hold down the Ctrl key to
select each of the remaining Failure branches. Your selections should
look as they do in Figure 2-36.
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Chapter 2
Regulatory
Phase Phase Approval
2 3
Phase Success
1 Success - Once a Day Success 4
faveio? il
Success J Success - Twice a Day (_<] ]
Yes
Failure "\—q_
No ] <4 =
Key
. . Market Market
Competitor Pricing Size Share
Outcome — o
Failure Low Low Low
Total_NPV
Disappointment Nominal Nominal Nominal
Total_NPV
Breakthrough High High High
Total_NPV

Figure 2-36. Decision Tree with All No/Failure Points Selected

= Press Ctrl+V to paste the get/pay expression to the selected branches.

You can click in whitespace to de-select the branches. In addition to the

last node, Total_NPV has been added as a get/pay expression on all of the
Failure branches in the Decision Tree (Figure 2-37).

Reqgulatory
Phase Phase Approval
2 3
Phase Success
1 Success - Once a Day Success q
Develap? Failure
Success Success - Twice a Day ( Failure <| Total_NPVY
Yes Total_NPV
Failure Failure
Total NPV Total_NPV
Key
Competitor Pricing % %
Outcome — o
Failure Low Low Low
Total_NPY
Disappointment Nominal Nominal Nominal q
Total_NPVY
Breakthrough High High High
Total NPV
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Figure 2-37. Decision Tree with Get/Pay Expression
on All Failure Points

You'll run another analysis to see how the Policy Tree results have

changed. On the Home tab, ensure that Policy Tree is the only output
requested.

= Click Home | Run | Decision Analysis.

DPL gives a warning that any previously generated outputs will be
overwritten by the run, which is OK for the purposes of this tutorial. Click

Yes to continue with the analysis. When the run is complete the new Policy
Tree is displayed

= As before, right-click on the chance node at the end of the Yes branch

for the Develop? decision and select Expand to Level... within the
context menu.

= Enter "5" within the Expand Policy Tree dialog. Your Policy Tree should
look like Figure 2-38.

Regulatory Approval
FPhase3  Success [421.5]

Success-Oncea...  [302.0] 80% (0 11%)
20% (11 14%) Failure [-176.0]

20% (N 3%) -176.0
Regulatory Approval

Success [-68.7]

902 @ 0 @
Failure [-176.0]

20% (N 3%) -176.0 :]

Phase 2
Phase 1 Success [9.8]

Yes [3.4] 70% (1 70%)

Phase 3
Develop?

B34

Success - Twice a..
20% (11 14%)

Failure
60% (N 42%)

[-54.2] ]

-542
Failure [11.5]

30% (M 30%) -115

Figure 2-38. Policy Tree™ output for
Model with Multiple Get/Pays

The Expected Value of the model now stands at 3.4, a significant drop
when compared to the results of the previous run (43.7). This decrease
makes sense as the model now accounts for the R&D costs incurred at
various failure points within the tree. The optimal decision alternative
remains to develop the drug but the expected value has dropped
significantly.

After a review, management has asked you to consider options that will
mitigate some of the project risk. One particular scenario in the Policy Tree
has caught their attention. It's circled in red above in Figure 2-38. If you
achieve the Success — Once a Day outcome in Phase 2 the Expected Value
heading into Phase 3 is 302. But if you have to settle for the Success —

80



Syncopation Software Chapter 2

Twice a Day outcome, the Expected Value is -90.2. Continuing at this point
is actually worse than failing at Phase 2 altogether (EV: -54.2).

This tells you that the viability of the development project depends largely
on whether or not a once-a-day formula can be developed. Consequently,
you will add an explicit downstream decision to the tree as to whether to
continue to develop the drug through phase 3, given the potential
outcomes of the Phase 2 uncertainty.

2.9 Adding a Downstream Decision

Asymmetric trees often involve downstream decisions that represent risk
mitigation options or future opportunities. These downstream decisions are
sometimes referred to as real options. A real option is analogous to a
financial option. With a financial option, you buy the right but not the
obligation to purchase (or sell) an underlying financial asset (e.g., a share
of stock) at some future date. With a real option, you invest an initial sum
of money in a project or venture which gives you the ability but does not
obligate you to invest more money in the project or venture at a future
date after learning something about the project/venture. E.g., you could
pay for some market research on a product and subsequently decide
whether to launch the product or not. In this market research example, the
real option is the launch decision. You get to decide whether or not launch
after learning about the market research results.

In the model you are developing, the development and launch costs are
significant so one might ask whether there are situations in which you
suspect the product will perform poorly and you would like to know
whether you are better off continuing with development in those scenarios.
The spreadsheet is set up for this new decision so you'll create the node,
link it to Excel, and add it as a downstream decision to the tree.

= Activate the model by clicking its item in the Workspace Manager.

= Switch to the Decision Tree tab of the ribbon.

= Create a new decision node by dropping down the Decision Tree |
Node | Add split button and selecting Decision from the list.

= Place the node on top of the Phase 3 chance node.

You many have noticed that when you hovered the mouse cursor over the

node, it changed to a reorder (EEC)(J) cursor, indicating that the node will be
added to the tree just before the node it's dropped on.
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= On the General tab of the Node Definition dialog type "Continue to
Phase 3" for the node name.

= Switch to the Data tab and enter a value of "1" for Yes and "0" for No.

= Switch to the Links tab. Within the Calculation links section at the top,
select Microsoft Excel.

DPL with automatically assume that you'd like to link to the same
spreadsheet as the rest of the nodes in the model, which is correct. You'll
just need to specify the specific named range. To do so:

= Click the Range Names... button.

= Within the Range Names dialog double-click on Continue_Phase_3.
Your links tab should match Figure 2-39.

Nede Definition: Continue to Phase 3

Genersl Data Links  Tree Instance

Calculation links

These links are recalculated throughout the run. They may be either inputs used in the linked spreadsheet’s calculations (e.g.. unit sales) or calculated results from *
spreadsheet {e.g., NPV).

() None focal) (O DPL Program @Ml:msoﬂE;cel

Workbook: ‘5"-de5D'-Examp\es'-Dn_|g Development xdsx. ‘ Browse

Sheet/Cell: ‘Assumptions!Cominue,PhasefB ‘ Go to Range Range MNames...
This is a driver node. ks value will be sent to Excel each time it changes during the run. Paste Link

Initialization links

These links are for connecting to a spreadsheet, database or program that contains dasta (values and/or probabilties) which will be used in the Data tab to initialize
nodes. These links are refreshed once at the start of each un.

(®) None flocal or DPL program) () Microsoft Excel (O) Database

Go to Manage Links

Concel ] [

Figure 2-39. Links tab of Node Definition dialog for
Continue to Phase 3 Decision node

= Switch to the Tree Instance tab and change the Alternative grouping to
Asymmetric.
= Click OK to close the Node Definition dialog.

= Re-connect the tree by dragging the Phase 3 chance node (and its
subtree) and dropping it on the endpoint for the Yes branch of the
Continue to Phase 3 decision.
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Lastly, you need to add a Get/pay expression to the No branch of the new
decision, indicating that development costs need to be accounted for at
that point if you do not continue to Phase 3.

= Select the No branch of the Continue to Phase 3 decision.

= Drop-down the lower Edit Get/Pay combo box within the Decision Tree
| Get/Pay group and select Total NPV from the list.

Your Decision Tree should now look like Figure 2-40. You'll run the model
one last time to see if the downstream decision increases the value of the
project.

Regulatory
Phase Approval
Phase Continue 3
2 to Phase 3 Success
Phase <|
o 1 Success - Once a Day Yes
Develop? Failure
Success Success - Twice a Day N Total_NPV
5 _|
Yes
Failure ’\ Eailure Total_NPV
No Total_NPV Total NPV
Con%itor Pricin Market Market
fompetitor ricing Size Share

Outcome

Failure Low Low Low
Total_NPV

& Disappointment Nominal Nominal Nominal q

Total_NPV

Breakthrough High High High
Total_NPV

Figure 2-40. Decision Tree with Downstream Decision Added

= Navigate to the Home tab and click the Decision Analysis button to
generate a new Policy Tree (Figure 2-41).
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Phase 3
Continue to Phase 3 Ves [302.0]
Success - Once a [302.0]

20% (N 14%)

£0.2
Phase 2

Success [15.8]
70% (N 70%)

Phase 3

Continue to Phase 3| _Yes [-90.2]

Success - Twice a [-60.2]
20% (N 14%) No [-60.2]
£0.2

Failure [-54.2]
0% (M1 42%) 542

Phase 1
[7.6]

Develop?
[76]

30% (N 30%)

Figure 2-41. Policy Tree"” output for Model with Downstream Decision

The Expected Value of the model has increased from 3.4 to 7.6. Where is
this value coming from? Refer to the section of the tree outlined in red
above (Figure 2-41). If you end up with a twice-a-day formulation in Phase
2 the best decision alternative is to not continue to Phase 3. By adding the
downstream decision, you have modeled the flexibility to stop the project
and cut your losses for this unfavorable scenario. Modeling this flexibility
adds value to the project.

Be sure to save your workspace before proceeding. At the start of Chapter
3 you will use the model saved at the end of this section to generate DPL's
primary decision analysis outputs.

2.10 Ignore Conditioning in Unknown State

Before continuing to the next chapter you will examine an option in DPL
that has some bearing on the current model.

= Activate the model.

= Select Decision Tree | Model | Settings. The Decision Tree tab of the
Model Settings dialog will open. Note that the Ignore conditioning
events in an unknown state (default states will be used in calculations)
is checked by default. See Figure 2-42.
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Model Settings - Drug Development

Links Decision Tree

[] Allow evert already active and halt with penalty value: -1000000000
Altemative/outcome grouping for ) '_ ) =
newly added nodes: sreapne ® Symmetric Ij: ' O Asymmetric Ij: 1

Advanced settings
[] Risk tolerance and utility functions by branch

[J Use these settings for new models/programs

Cancel Help

Figure 2-42. Decision Tree tab of Model Settings dialog showing
Ignore conditioning events in unknown state Setting

Without this setting checked, DPL assumes that the output metric depends
on every driver in a spreadsheet linked model such as the one you are
building. In the failure scenarios in the Decision Tree, several of the drivers
are not known when Total NPV is calculated, e.g., when you fail at Phase
1, none of the remaining technical uncertainties nor the commercial
uncertainties are in a known state. However, the spreadsheet is set up to
be able to calculate Total NPV correctly in each of the failure scenarios.
E.g., it know to ignore Phase 2 costs if you fail at Phase 1 and it knows to
include any revenues if you fail at any phase or decided not to continue. By
having Ignore conditioning events in an unknown state on, DPL assumes
that the tree is valid and that the output metric can be correctly calculated
in every scenario regardless of unknown states.

= Click Cancel to close the dialog without making any changes.

Warning: To safely use this option, you must make sure that the nodes
that are skipped do not affect spreadsheet calculations in the scenarios
where they are not known. In those scenarios, the values for the "default"
state (decision alternative or chance outcome) are sent to the spreadsheet.
For example, when Regulatory Approval is Failure, DPL sends the default
(in this case the middle or Nominal) values for Key Competitor Outcome,
Pricing, Market Share, and Market Size to Excel before telling Excel to
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recalculate NPV. The Excel model must be coded to ignore these values
when Regulatory Approval is Failure.

You will now look at how to set default states.

= Double-click the Pricing chance node in the Decision Tree.

= Click on the General tab. The Nominal outcome is designated as the
default state for Pricing.

= Select another state and press the Default button. The default
changes.

= Click Cancel to discard the change.

When you create new chance and decision nodes, DPL assigns a default
state. If you delete the default state, be sure to assign a new state as
default. Each node should have one of its states assigned as the default
within the General tab of the Node Definition dialog. This is particularly
important for asymmetric Decision Trees and when using the Ignore
conditioning events in an unknown state option.
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3. Analyzing a Decision Analysis Model

Up to this point, you've only requested a Policy Tree output but it should be
noted that within the Home | Run ribbon group there are several output
options available when running a Decision Analysis. These options allow
you to generate probability distributions, policy outputs, value of
information and record endpoints during a run. The model you saved at the
end of Section 2.9 is now ready to produce a variety of these results
available from the Home | Run group with a decision analysis run.

The majority of the analysis and output options included within the Home |
Run group are discussed in detail within Table 3-1, Table 3-2, and Table

3-3.

Control

Description

g
o=

Decision
Analysis™  paow

The Home | Run | Decision Analysis split button tells
— DPL by what method to analyze the Decision Tree. The
methods and their corresponding icons are outfined

Fast sequence evaluation

& 1g

Provides the exact expected values but
optimizes run time by using the
structure of the tree to avoid visiting
every endpoint of the tree. Risk
Profiles (and hence percentiles) may
be approximate.

Full tree enumeration

= e

Provides exact expected values and
visits every endpoint of the tree. Risk
Profiles (and percentiles) are exact and
optionally the Endpoint Database can
be recorded for re-use.
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Discrete tree simulation Provides an estimate of expected
o values by sending a specified number
.E of samples down paths in the tree.

Useful to reduce runtime when an
exact expected value is not required.

Table 3-1. Evaluation Method Types

Control Description

. . This section of the Home | Run group
Risk Profile includes controls for probability distribution
Objective Function = | rélated outputs that DPL can generate with a

, - modéel run.
Init Dec Alts

Risk Profile Creates a graph showing the
sy full range and likelihood of

w0 | possible values for the item
selected in the Risk Profile
Quantity drop-down box

60% |

s ] (typically the Objective
o] Function). The format of the

7 graph can be changed after the
S A A AR M model run.

Select Risk Profile Quantity box
Select the quantity for which
Objective Fancionl you would like a Risk Profile.
tnong) For single attribute models this
can only be the Objective

Al Attibutes bs Function. For models with
CF.2017 multiple attributes or objective
Eiﬁglg functions, you can choose to

CF 2020 generate a Risk Profile chart for
any single attribute/objective
function or all.

Risk Profile
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Init Dec Alts

Initial Decision Alternatives
( ) Creates risk profile graphs for

each of the alternatives of the
0% 4 — decision at the head of the tree.
Only available when the Risk
Profile Quantity box is set to
Objective Function, and the
model includes only one
objective function.

100%

60% -

Table 3-2. Probability Distribution Output Options

Control Description
Policy Tree  Levels|12 (all) ~ This section of the Home
- / Run group includes
Policy Summary Endpoints controls for decision
VOIC Value Correlations =~ P olicy related outputs

that DPL can generate
with a model run.

Policy Tree™ Creates a calculated output

tree that displays the optimal
alternative for each decision,
the branch and joint
probabilities, get/pay values
and rolled-back expected
values for the objective
function(s) and attributes at
each point in the tree.
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Policy Summary™

Froduct Stbegy

e Crasge

rroume

Ucerse

idoes not occu)

Sarimn Coss

Creates a view that
summarizes the information in
the Policy Tree™. More
specifically it displays the
policy conditional probabilities
for each decision and chance
event in the tree.

VOIC (Expected Value of Perfect
Information/Control)

52
50
48
46
44
42

ul E -

Sales 2 Sales Marketing Costs  Unit Costs

Creates a chart showing both
the expected value of perfect
information and the expected
value of control for each
discrete chance node in the
model.

Number of levels

Levels | 7(all) =

Tells DPL how many levels
down the tree to gather policy
information. A tree with N

(none)

% nodes in its longest path will
a have N+1 levels. Must be set
g to all for generating VOIC
Zan charts.
Endpoints Tells DPL to record an

0 1 2 3 2 5 endpoint database for the run.

0 |Endpaint |Product.. Sales |Per_Unit... Marketin..| Price_Ch... i
_In_house Low MNominal | Low Raise The en(':'IPOInt gatabase a"PWS
2 1/In_house |Low Nominal |Low Raise YOU tO replay the endeIntS
3 2/In_house |Low MNominal | Low Raise H

4 3In_house |Low Mominal | Low Keep_sa. to QUICkly perform further

5 Tihowse Low  |Nominal [Low [Keep_san analyses without value model
() 3/In_house Low MNominal | Low Keep_sa... . . .

7 6/In_house Low Nominal | Nominal Ralsz recaICUIatlon' If Endp_OInts Is

8 7in_house [Low  [Nominal [Nominsl |Raise checked, the evaluation

8/ln_house |Low Nominal |Nominal |Raise g
190 3in_house Low  |Nominal Nominal |Keep_sa.. method is set to full tree

enumeration.
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Value Correlations

™ Creates a column bar chart
showing the correlation
coefficient between each value
025 | in the model and the objective
RXE function.

T T T T T
Profit Sales Price Change  Costs Marketing Costs

Table 3-3. Policy Output Options

The last section of the Home | Run group contains two buttons, Clear Mem
(7<) and Compile ( # ). Clear Mem tells DPL to clear the compile
structures and any unsaved results from a Decision Analysis run for the
active model. The Compile command tells DPL to compile the active model
to test for missing data or other errors.

Note that there are some additional evaluation methods in the Decision
Analysis drop-down list not included in Table 3-1: Monte Carlo simulation,
Full Tree Enumeration from Endpoints, Record Endpoints using Servers and
Act as Endpoint Server. Monte Carlo simulation and the options associated
with this evaluation method will be covered in Chapter 6. Full Tree
Enumeration from Endpoints and Parallel Endpoint Recording will be
covered in Chapter 11.

The dialog box launcher within the Home | Run group launches the Run
Settings dialog. This dialog contains a number of run and compilation
settings -- most of which are self-explanatory. A few of the options will be
discussed in detail later in the manual.

You will continue working with the model saved at the end of Section 2.9.
If you've closed DPL do the following:

= Start DPL and open the workspace you saved at the end of Section 2.9
by using File | Open.

Note: if you're starting here and haven't worked through the tutorial in
Chapter 2 or are not confident that the model built in Chapter 2 is correct,
open the workspace Drug Development_DT.da from the Examples folder in
your DPL installation directory, usually

C:\Program Files\Syncopation\DPL9\Examples.

= The selections within the Home | Run group should match what is
shown in Figure 3-1.
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= v| Risk Profile v| Policy Tree Levels 11 (all) =

[P

— Objective Function - Pelicy Summary Endpoints
Decisicn . - ) ] ]
Analysic - Init Dec Alts YOIC Yalue Correlations

Figure 3-1. Outputs Requested within the Home | Run Group

4

Make sure Risk Profile is checked. For this single attribute model, the
Select Risk Profile Quantity box just below it is set to Objective
Function — the only option.

Make sure Init Dec Alts (i.e., Initial Decision Alternatives) is not
checked.

Make sure Policy Tree™ is checked.
Make sure Number of levels is set to "11 (all)".

344 0

Make sure Policy Summary™, Expected Value of Perfect
Information/Control (VOIC), Endpoints, and Value Correlations are not
checked.

The default evaluation method indicated by the Decision Analysis button
icon is Fast Sequence Evaluation. This is fine for the purposes of this
tutorial.

= Click the Home | Run | Decision Analysis icon or press F10.

DPL runs the analysis and produces the requested outputs.

3.1 Policy Tree™

DPL creates an item beneath the model in the Workspace Manager for the
Policy Tree output and activates it once the run is complete as shown in
Figure 3-3. Before discussing the Policy Tree, take another look at the
Workspace Manager. Note that DPL has put double chevrons ("»»...««"
around the model you just ran. This indicates the model is compiled (i.e.,
checked for errors and data structures loaded in memory) and is ready to
run. Once you modify the model, the compiled indicator is removed.

Take a look at the Session Log as well (Figure 3-2). Note that the number
of paths in the model is 177, the Expected Value of the model is 7.6, and it
took just over a second for DPL to run the model (the runtime will vary by
machine).
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Enterprize Wersion

Support expires: June 18, 2017

Release 5.00.00

Built Apr 26 2017 14:14:32 (64-bit)

Serial Number: SYDESO170418001

Licensed User: Synco User, Syncopation Software
10:01:44 Clearing: Drug Development

10:01:44 Compiling: Drug Development
Number of paths = 171

10:01:44 Complete

10:01:51 Clearing: Drug Development

10:01:51 Anahlyzing ... Fast sequence evaluation
10:01:52 Complete
Elapsed time: 1.108=

Expected value = 7.5

EV. T8

Percentiles:

10th, 50th, S0th
-50.2, -54 2 -11.5

Figure 3-2. Session Log a Analysis Completes

c} =] = oLy DPL - Drug Development downstream later.da - [Policy Tree] - B X
HOME  INFLUENCEDIAGRAM  DECISIONTREE ~ VIEW ~ DATA | POLICY | HELP -a

v] Show Get/Pays ¥| Show Branch Probs Text View D--I- 'nd

] Show Obj. Fn. EVs (7] Show Joint Probs
Add  Compare

Displa o biree Risk
Workspace Manager R DrugDevelopment  Expected Value T
<& Drug Development downstream | ~
& 2% »» Drug Development <
./ {Expected Value}
/" Expected Value
«C Policy Tree
Phase 3
Continue 1o Phase 3
Success - Once...  [302.0]
20% (N 14%)
Phase 2
Phase 3
Phase1  Success [5.8]
3 > Develop? 70% (N1 70%) Continue to Phase 3 _Yes [:00.2]
. velop? Success - Twice... [-60.2]
Session Log i 761

20% (N 14%)
DPL - Decision Programming Language A
Copyright © 2003-2017 by Syncopation
Incorporating software on cense fo
Syncopation Software, In.

Al righis reserved

Use of this software is governed by the

Failure
60% (N 42%)

Failure
30% (1 30%)
www syncopstion com

support@syncopation.com

US tolfree: 1 856 7962375
Outside the US: +1 578 233 2608

Enterprise Version (interal Buid)
License expires: December 31, 1969
Release 9.00.00 (beta 4}

Buit Jan 132017 11:22:42 (64-bit)
Internal Use Only

Figure 3-3. Policy Tree™ output for Model
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The Policy Tree displays information in a Decision Tree format about the
results of the decision analysis. Nodes in the Policy Tree are displayed
using the same symbols as in the Decision Tree. Decision nodes are yellow
squares. Discrete chance nodes are bright green circles. Endpoints are blue
triangles. The first thing to note is the structure of the Policy Tree. To the
left it displays the initial Develop? decision with each of its alternative
branches (Yes and No). The Yes alternative branch leads into the next
event (Phase 1) while the No alternative branch has a blue triangle at the
end of its branch. As mentioned previously, the blue triangle is DPL's
representation for an endpoint.

The Policy Tree also displays the expected value (or rolled back expected
value) at each point in the tree in square brackets ([]). The [7.6] to the left
of the Develop? decision is the expected value of the objective function for
the complete model or tree. Look further down the tree to the two rolled
back expected values that appear next and you see that the expected value
beneath Phase 1 is 7.6 and the expected value for the endpoint at No is 0.
As mentioned in Section 2.3, in this model DPL maximizes the objective
function. Therefore when confronted with a decision with two alternatives,
one of which has a rolled back expected value of 7.6 and the other a rolled
back expected value of 0, DPL chooses the alternative with the rolled back
expected value of 7.6. This can be seen in the Policy Tree, not only by the
[7.6] next to Develop?, but also by the Yes branch of Develop? being
displayed with a thick branch. DPL indicates the optimal alternative of a
decision at each point in the Policy Tree by displaying the optimal
alternative with a thick branch.

Phase 1
Develop?  Yes [7.6]

[7.6] T

No [0.0]
0.0 q
Figure 3-4. Optimal Decision Alternative indicated
with a Thick Branch Line
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Looking further down the tree (Figure 3-5) you'll see that the optimal
decision policy is to Continue to Phase 3 if you succeed in attaining a once
per day formulation in Phase 2, but you should cut your losses and not
continue if a twice a day formulation is achieved.

Fhase 3
Continue to Phase3 Vs [302.0] O
Success-Once aDay  [302.0] /[\
20% (N 14%) Ma [-60.2] q
-60.2
Fhase 2
[15.9] Fhase 3
Continue to Phase 3 Yes [-90.2]

Success - Twice a Day [-60.2]
20% (M 14%) Mo [-60.2]

/[\ -60.2

A @

Failure [-54.2] <|
G0% (N 42%) -h4 2

Figure 3-5. Optimal Decision Policy Indicated for Downstream Decision
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To explore even further down the Policy Tree you will expand from the
Phase 3 chance node at the end of the tree.

= Select the Phase 3 chance node at the end of the Yes alternative of the
Continue to Phase 3 decision node as shown in Figure 3-6. Once
selected the Expand split button within Policy | Display group becomes
active.

Fhase 3

Continue to Phase 3 €S [302.0]
Success - Once a Day [302.0]
20% (N 14%) {j MNo [60.2] ;
-60.2

FPhase 3

Continueto Phase3 s -90.2]
Success - Twice a Day [-60.2]
20% (N 14%) {j No [-60.2] ;
-60.2

Failure [-54.2] Q
60% (N 42%) 542

Phase 2
Phase{  Success [15.8]
[7.6] TO% (M 70%)

Yes

Develop?
[7.6]

Failure
30% (N 30%)

-115

Figure 3-6. Phase 3 Chance Node Selected for Expanding

The Expand split drop-down lists five menu commands for changing the
state of expansion of the Policy Tree. If you were to right-click on the same
node in the Policy Tree to bring up the context menu you will find four of
the same expand commands, with the exception of the Expand All
command. All are summarized in Table 3-4.
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Control Action
Expand Expands the currently selected node one
o level if the node has never been expanded
D’j q;l - before or to the previously expanded state.

This same action can also be accomplished
by double-clicking the node.

Expand and Zoom Does the same thing as Expand but then
zooms the Policy Tree so that the whole

D/g & tree can be seen. This action can also be
- : accomplished by Shift+double-clicking the
node.
Expand to Level... Brings up the Expand Policy Tree dialog in
c which you can specify the level to which you

want the subtree expanded. The Policy Tree
is expanded from the node selected.

Expand Subtree Expands the entire subtree in the Policy
c Tree from the selected node.

Expand All Expands the entire Policy Tree so that all
c nodes are fully expanded.

Table 3-4. Policy Tree™ Expand Commands

= With the node still selected, drop-down the Expand split button and
select Expand Subtree.

= Use the keyboard shortcut Ctrl+L to Zoom Full on the Policy Tree. Your
Policy Tree should look similar to Figure 3-7

You should find (if you haven't clicked anywhere) that the chance node
you've expanded from is still selected but the Expand button will no longer
be enabled on the command ribbon. The Collapse button is now enabled
on the ribbon. There are two collapse options, Collapse and Collapse and
Zoom. Analogous to Expand, the Collapse command will collapse the tree
to the previous level. This action can also be accomplished by double-
clicking the node.
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Now that the Policy Tree is expanded, you can see several endpoints
(displayed as blue triangles) at the right end of the tree. This model
contains 177 endpoints (or paths), so the tree would be difficult to read if
all the endpoints are displayed at once. Practical applications often involve
thousands or millions of endpoints, so it's important to be able to
manipulate the Policy Tree to show the desired information at a level that
is readable.

Figure 3-7. A Policy Tree™ Subtree Expanded to Endpoints

You'll zoom by selecting in order to get a closer look at a section of the tree
that includes endpoints.

= At the top right most corner of the output put your cursor just above
and to the left of the top chance node as shown in Figure 3-7.
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= Press Ctrl+Shift while you click and drag the mouse down and to the
right. A box will show you what will be displayed when you release the
mouse button. Release the mouse button and keys when the box
surrounds the portion of the diagram selected in Figure 3-7. See the
zoomed section with the data elements labeled in Figure 3-8.

3
- Low ¢ é-209.3]
1 0% (N 0%) -209.3

“‘Market Share

2749 6] Nominal [-132.3]
40% (N 0%) 132.3
High [170.9]
60% (N 0%) 170.9

Figure 3-8. Data Elements labeled in Zoomed Policy Tree™

For a description of these data elements labeled above see Table 3-5 and
Table 3-6.

Data element (location key) Definition

Node Name (1)

Rolled-back expected values (2) The expected value of the
objective function for the subtree
headed by the node adjacent to
the value

Value is displayed in square
brackets, e.g., [49.6].

Table 3-5. Node Information Displayed in the Policy Tree™
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Data element (location key)

Definition

State name (3)

Branch probability (4)

The probability can either be
displayed as a percent between
0%-100% or as a number
between 0-1. This data is
displayed for Discrete Chance
nodes only.

The conditional probability of this
discrete chance outcome
occurring on this path. If the
discrete chance is conditioned by
other nodes, this is the probability
of the chance outcome occurring
given the outcomes on this path
of the nodes that condition it.

Joint probability (5)

Displayed as above. Plus, joint
probabilities are indicated by a
set intersection symbol and are
contained within parentheses,
e.g., (N 0.11%).

The joint probability (also referred
to as the "path probability") is the
probability of the particular path
occurring. It is the product of the
chance outcome probabilities
along the path defining the
endpoint.

Get/pay values (6)

If there is no get/pay value at
this point in the tree, then
nothing is displayed.

The value of the get/pay
expression (if any) that occurs at
this point in the tree.

Table 3-6. Branch Information Displayed in the Policy Tree™

Notice that the joint probabilities are all 0%. The joint probability is in fact
not zero but a very small percentage. With the current model settings
percentages are set to display zero decimal places. If you'd like to update
the number formatting to see the path probabilities, do the following:

= Go to File | Options | Outputs

= Within the Probabilities section, enter a "2" within the Decimal places

for probabilities box.
= Click OK to close the dialog.

The Policy Tree display will update to reflect the new number formatting. If
you'd like your outputs to exactly match what you see in the tutorials for
the rest of the chapter, you should go back into File | Options | Outputs
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and change the decimal places for probabilities back to 0 before continuing
on.

In the model there is a get/pay expression (Total_NPV) at each Failure
outcome and No alternative of the downstream decision in the tree.
Therefore, you will see the get/pay value for Total_NPV at each of these
points in the Policy Tree. At each point in the tree, the Total_NPV value is
for a single, specific scenario. You could verify Total_NPV for that specific
scenario in the spreadsheet by setting the inputs in the spreadsheet to
match the inputs for that path in the Policy Tree.

At all of the endpoints of the tree (Failure outcomes, No alternative for the
downstream decision and all the endpoint at Market Share), the value of
the get/pay expression (Total_NPV) is the same as the rolled-back
expected value, which is why the same number appears above and below
the branch at these points.

You can use the Policy Tree to find out a number of things about your
model. For example, the expected value of the model is -60.2 given that
you develop the drug when a twice a day formulation is achieved at Phase
2 (-60.2 is the rolled-back expected for the Yes alternative of the Continue
to Phase 3 decision at the Success — Twice a Day outcome for the Phase 2
chance node).

= Try manipulating the Policy Tree by expanding / collapsing different
parts of it. You can do this by double-clicking a node, using the context
menu or using the Expand/Collapse split buttons within the Policy |
Display group on the ribbon.

You can also directly control the data elements that are displayed in the
Policy Tree via the Policy | Display group as shown in Figure 3-9.

Show Get/Pays Show Branch Probs
Show Obj. Fn. EVs Show Joint Probs

Nicnls

Figure 3-9. Data Element Display options
within the Policy | Display group

= Experiment with using the checkboxes to turn on and off the different
data elements within the tree display.
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There are more formatting options within the Format Policy Tree dialog.

= Select Policy | Display | Options (the dialog box launcher) to launch the
Format Policy Tree dialog (Figure 3-10).

Format Policy Tree

Drigplay
Branch length: : Branch offzet: :

Show

Mode names State names

Branch probabilities Joint probabilities

Objective function expected values Attribute expected values [Eat Policy]

Get/pay values

Select attibutes to display ([EVs and get/pays]:

Branch filter

[[JBazed on probabilities []Based on rolled-back objective function Ey's

Min: ] tdin: ]

[GETS 1 b ax: 0

Cancel

Figure 3-10. Format Policy Tree Dialog

You can use the two spin buttons at the top of the Display section to
increase or decrease the Branch length and Branch offset percentages in
order to alter the shape and appearance of the tree. The same display
elements options that are on the ribbon and included beneath the Show
heading.

If your model includes multiple objective functions or attributes, you can
select which ones to display in the Policy Tree on an individual basis within
their respective selection boxes. This will be covered later in Sections
10.2.1 (multiple attributes) and 8.3 (multiple objective functions).
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Lastly, beneath the Branch filter section you can apply branch filters based
on branch probabilities or rolled back expected values.

3.1.1 Comparison to Symmetric Decision Tree Version

You might wonder how the model, analysis and results would have differed
had you built a completely symmetric Decision Tree for this drug
development decision. Note that this is for example purposes only and you
will not be making any edits to your current model.

Displayed in this section are some screenshots that show how a symmetric
version of the Decision Tree would compare to your current model. Figure
3-11 shows a symmetric version of the Decision Tree with a single get/pay
at the end.

Phase

Phase 2 Continue Phase Regulatory
Develop? . s i
1 to Phase 3 3 Approval
Success - Once a Day
Yes Success Yes Success Success
Success - Twice a Day
E( No q Failure E[ No C:( Failure d Failure ®<I
Failure
@. I~ Market Market
Competitor Pricing Size Share
Outcome - =
Failure Low Low Low
Total_NPV
& Disappointment Nominal Nominal Nominal Q
Total_NPV
Breakthrough High High High
Total_NPV

Figure 3-11. A Screenshot of a Symmetric Version
of the Drug Development Model

103



Chapter 3 Syncopation Software

Figure 3-12 shows the Session Log information at the completion of a
Decision Analysis run on the symmetric model.

Session Log

10:06:06 Clearing: Drug Development

10:06:06 Compiling: Drug Development
Number of paths = 7775
10:06:06 Complate

10:06:06 Analyzing ... Fast seguence evaluation
10:06:51 Complete
Elapsed time: 44.093s

Expected value =78
EV-TE

Percentiles:

10th, 50th, S0th
-50.2, -54 2 -11.5

Figure 3-12. Session Log Information for Symmetric Model Analysis

Note that the number of paths has increased from 177 to 7,776!
Furthermore the symmetric model took much longer to complete the run
(nearly 50 seconds on the same machine that took just over a second for
the asymmetric model). And lastly, you can see that the Expected Value for
the model matches that of the current model, 7.6. For this example the
asymmetry in the Decision Tree proves to have a significant impact on
runtime, results in @ model which is much more efficient and generates
results that are much more compact and easy to read.

Figure 3-13 shows what the Policy Tree output looks like for the symmetric
version of the model. Notice that the values at all the points in the tree for
the Phase 1 Failure outcome are the same. The asymmetric version of the

tree removes this redundancy.
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Phase 3

Continue to Fhase 3 (30201

Success-0... [202.0]

20% (N 14%)

Fhase 2 Centinue to Phase 2
Success [15.8] Success-T... [60.7]

70% (N T0%)

20% (N 14%)

Centinue to Phase 2
[-54.2]

Failsre

60% (N 42%)

Centinue to Phase 2

[11.9]

Continue to Phase 3

Failure

30% (N 20%)

Continue to Phase 3
Failurz [-11.8]

Figure 3-13. Policy Tree” for Symmetric Model

3.2 Risk Profile

As shown in Figure 3-14, DPL creates one or more items in the Workspace
Manager for each of the outputs it created. For Risk Profiles, DPL creates at
least two items: one item for the Risk Profile chart and one item for each
Risk Profile dataset in the chart. In the decision analysis run that you
requested previously, DPL created a Risk Profile dataset and Risk Profile
chart for the objective function under the optimal decision policy.

If you had requested Initial Decision Alternatives, DPL would have created
two Risk Profile datasets: one for the Yes alternative of Develop? and one
the No alternative. A third item (a Risk Profile chart) would have displayed
both risk profiles within a chart for comparison. Note that the Risk Profile
generated for the No alternative would have been uninteresting, as it is a
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terminal alternative that would be displayed as a vertical line at 0. For more
information on displaying and comparing multiple Risk Profiles within a
single Risk Profile chart, see Section 6.6.

In the Workspace Manager, a Risk Profile chart is indicated by the icon
(f ) and a Risk Profile dataset by the icon (/' ). When you generate a
Risk Profile for the optimal alternative policy, DPL names the Risk Profile
chart and dataset "Expected Value". DPL encloses items in the Workspace
Manager that do not correspond to windows (such as the Risk Profile
datasets) with curly braces i.e., {Expected Value}.

= Double-click on the item for Risk Profile chart called Expected Value

(f ) in the Workspace Manager to activate the window. The Expected
Value Risk Profile chart becomes active as shown in Figure 3-14.

Note: you can also double-click on the Risk Profile dataset called Expected
Value. DPL activates the Risk Profile chart that displays it. If you double-
click on a Risk Profile dataset that is not displayed in a Risk Profile chart,
DPL creates a chart for the dataset and activates the chart.
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Figure 3-14. Risk Profile Chart for Optimal Decision Policy
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By default, DPL creates a cumulative Risk Profile chart. A cumulative Risk
Profile chart displays the value of the objective function (or attribute in
multiple attribute models) on the x-axis (horizontal axis) and cumulative
probability on the y-axis (vertical axis). A cumulative Risk Profile chart can
be read by choosing a value on the x-axis, determining where the Risk
Profile intersects with the vertical line "drawn" from the value, and then
"drawing" a horizontal line over to the y-axis. The value where the
horizontal line meets the y-axis is the probability that the objective function
is less than or equal to the chosen value on the x-axis. For example, if you
choose the value 300, you see that the vertical line drawn from 300
intersects the Risk Profile at a probability value of approximately 95%.
Therefore, the probability that the objective function is 300 or less is 95%.

To create a Risk Profile chart, DPL calculates all the endpoint values
(objective function values and probabilities) associated with the model, and
then aggregates the endpoints into a user-determined number of intervals
for display. The number of intervals used can significantly affect the
appearance of the Risk Profile chart. The number of intervals has no impact
on the expected value of the Risk Profile.

The precision of the percentiles from a Risk Profile chart is affected by the
number of intervals. In the example in the previous paragraph, 300 is the
95" percentile. The 10" percentile is the x-axis value found by "drawing" a
horizontal line from 10% on the y-axis to where it intersects the curve and
then "drawing" a vertical line down from the intersection to the x-axis. If
you are interested in percentiles and require more precision, you should set
the number of intervals to be larger. A larger number of intervals requires
more memory and has a slight performance impact.

The number of intervals can be changed within the Run Settings dialog
(Home | Run | Settings).

= Double-click on the model within the Workspace Manager to activate it
(or press Ctrl+F12).

= Click Home | Run | Settings to launch the Run Settings dialog. Under
the Risk Profile section you should see that the Number of intervals is
500.

= (Click Cancel.

In general, 250 to 500 is usually a reasonable setting for most models.
(Note: in the model as it currently stands there are only 177 paths in the
tree — a small portion of which are in the optimal policy and displayed in
the Risk Profile. Setting the number of intervals to greater than 500 will not
affect how the Risk Profile charts looks since there are many fewer
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scenarios than intervals.) If you have distributions with very long tails, you
may wish to increase the number of intervals.

DPL displays the expected value (EV) of the objective function on the Risk
Profile chart by default. Displaying the expected value of the distribution is
particularly useful when comparing multiple Risk Profiles. It is also helpful
to display the expected value if the Risk Profile is less symmetric because it
may be difficult to estimate the expected value from the risk profile.

If you'd like to view your chart as a Histogram, do the following:
= Activate the Risk Profile Chart and check the checkbox next to
Histogram in the Format | Display group.

= Uncheck the EV / CE Lines and EV / CE Values checkboxes in Format |
Display. DPL updates the Risk Profile chart as shown in Figure 3-15.
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Figure 3-15. Frequency Histogram Type Risk Profile Chart

A frequency histogram displays the Risk Profile information in a different
format. The x-axis still displays the objective function and the y-axis still
displays probability values. The height of each bar in the frequency
histogram Risk Profile chart indicates the probability that the objective
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function falls within the range determined by the horizontal position and
width of the bar. For example, in the frequency histogram Risk Profile chart
in Figure 3-15 there is approximately a 30% chance that the objective
function falls in the range -60 to 0 (the height of the second highest bar is
30% on the y-axis; it starts at -60 on the x-axis and ends at 0).

= Revert back to a Cumulative risk profile chart type by un-checking the
Histogram checkbox in Format | Display.

Now let's examine the statistics and percentiles for the distribution.

= Click Data | Distributions | Statistics. You can also right-click on the
Risk Profile and select Statistics from the context menu. The Statistics
dialog appears as shown in Figure 3-16.
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Diigtribution; Expected Walue w
tean: 7.6 Percentile Value ™
tedian: -54.2 [ 60.2
a0 B4
Mir: -284.9 1] q15
Mas: 21432 [nane)
[none]
Weremger BI674.2 [none]
[none]
Standard Deviation: 2523 [nane] y
. 53
> fEiEss I—l Update Fercentile Y alues
Kurtosis: R

Distribution statistics have aleo been wiitken to the log.

H

K Cancel

Figure 3-16. Risk Profile Statistics

The Statistics dialog gives you a standard statistical description of the
distribution as selected by the drop down box at the top of the dialog. If
the Risk Profile chart contained more than one Risk Profile dataset, you can
use the drop down to select which distribution’s statistic the dialog displays
(See Section 6.6 for more on multiple Risk Profiles within a single chart).
The dialog provides the minimum and maximum values, the variance and
standard deviation, the higher moments (skewness and kurtosis), and the
10t™, 50t and 90t percentiles of the distribution.
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For example, the percentiles table shows that the 10™ percentile of the
distribution is -60.2; the objective function is less than or equal to -60.2
with probability 10%. Similarly, with probability 90%, the objective function
is less than or equal to -11.5 (or conversely there is a 10% probability that
the objective function exceeds -11.5). As you can seg, this is a highly risky

venture. You can use the table to determine the values for other percentiles, which
you'll do now.

= Double-click the first (none) item within the Percentile column to put it
into edit mode and enter "95".

= Click the Update Percentile Values button.
The 95™ percentile of the distribution is 310.4.
To display the percentiles specified within the table on the chart:

= First, click OK to close the Statistics dialog.

= To display the 10, 50t, 90t and 95t percentile values directly on the
Risk Profile, check the Percentiles box within Series | Labels.

You can also view/update the Percentiles table by clicking Chart | Series |
Labels | Settings.

A Risk Profile chart can be formatted in a number of ways. If you'd like,
experiment with some of the other formatting options available on the
Format tab. Figure 3-17 demonstrates some of the ways in which a chart
can be formatted. If you'd like your chart to match, you should do the
following:

= Create a title for the chart by checking the checkbox next to Chart in
the Format | Titles group. To rename the title, double-click the default
title "Chart 1" and type in "Expected Value".

= Select the Chart title text and change the font within View | Font to
one of your choice. You can do the same with the values along both
the x and y-axis and the axis label ("Cumulative Probability").

= Within the Format | Display group uncheck Shading. This will cause the
background shading of the chart to go away.

= Uncheck the checkbox next to Color Fill within the Format | Color
group. This will leave a single line with no color fill beneath it.

= Select the line (it will turn magenta). Go to Chart | Series |
Lines/Markers. In the Weight edit box, change the number from 2 to 3.
This will thicken the weight of the line.
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= Go back to the Format | Display group. Check the checkboxes next to X

Grid Lines, Y Grid Lines, and Dashed Grids to format the grid lines in

the background of the chart.

= Select the line within the chart and use the Color fill bucket split-button

to select a new color for the line and percentiles text.

= Turn on the EV/CE Lines and EV/CE Values. Select the EV line to edit

the location and size of the EV Value via the Series | Labels group.

= Select one of the percentiles and use the settings within the Chart |

Series | Labels group to re-position percentiles, if needed.
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Figure 3-17. Formatted Risk Profile Chart

See Section 5.2 for more on formatting charts.

3.3 Policy Summary™

T
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You will now examine DPL's Policy Summary. A Policy Summary is often

used to understand the decision policy for a downstream decision (i.e., a
decision that occurs after one or more chance nodes). You can request to

have a Policy Summary generated as a part of a decision analysis run

(check its box within the Home | Run group) or create one from the Policy

111

T
2200



Chapter 3 Syncopation Software

Tree output window (Policy | Policy Summary). Since there is already a
Policy Tree in the workspace, you'll do the latter.

= If it isn't already, activate the Policy Tree.

= Click the Policy | Policy Summary | Add button to create and activate
the Policy Summary output (Figure 3-18).

With downstream decisions there is not necessarily a single alternative that
is always optimal. Note that in the Policy Tree a different alternative is
optimal for the Continue to Phase 3 decision depending upon the outcome
of Phase 2. The Policy Summary provides a useful view of the information
in the Policy Tree, particularly for models with larger and/or more complex
Policy Trees.

Develop? Continue to Phase 3 Phase 1 Phase 2

Success - Once a Day

14%
1UM 14% 70% €35 - Twice a Day
No No Failure 14%
0% 14% 30% Fallure
(does not occur) does not occur {does not ocecur) 42%
0% 72% 0% does not occur)

Pricing Market Size

Market Share Phase 3

Success
Failure

does not occur:

Regulatory Approval Key Competitor Qutcome:

Success
Failure

does not occur’

Figure 3-18. Policy Summary™

The Policy Summary displays summary information about the optimal
policy. For each node, it displays the policy dependent probabilities for
each state of the node at the end of the state branch. A policy dependent
probability is the probability weighted fraction of optimal scenarios in which
the state (either decision alternative or chance outcome) occurs.

You will note that DPL also displays an additional state for each node called
"(does not occur)" and displays the probability of this happening as well.
The "(does not occur)" state will have a non-zero policy dependent
probability if there are scenarios in which the node does not occur. This
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common for asymmetric trees such as the one you've created in this
example.

For initial decisions (those that appear before any chance nodes in the
Decision Tree), the policy dependent probability of the optimal branch is
always equal to one (or 100%) and is always zero (0%) for the rest. So in
the Policy Summary, the optimal decision alternative for the initial decision
is the one with 100% probability. As you know, Yes is the optimal
alternative for the Develop? Decision and Figure 3-18 displays the Yes
alternative with a 100% policy dependent probability.

For downstream decisions, the Policy Summary displays the probability
weighted fraction of scenarios for which each downstream decision
alternative is optimal. Continue to Phase 3 is a downstream decision
because it occurs after a discrete chance event. As indicated in Figure 3-18,
the Yes alternative for Continue to Phase 3 has a policy dependent
probability of 14% while No has a policy dependent probability of 14% as
well. In 72% of scenarios, this decision event doesn't occur.

The Policy Summary also displays the policy dependent probabilities of the
outcomes for discrete chance nodes. For discrete chance nodes that are
not conditioned by others and that do not depend on the optimal policy,
the policy dependent probabilities are equal to the input probabilities. In
the current model, this is only true of Phase 1 event. You can see that the
policy dependent probabilities for the remaining uncertainties do not match
the input probabilities for the reasons described above.

3.4 Saving Outputs within a Workspace

All outputs described in Chapter 3 up to this point (Risk Profile Charts and
Datasets, Policy Trees, Policy Summary) along with some that will be
described later in the guide (Value of Information/Control, Value
Correlations, and Endpoint Databases) will remain in the Workspace until
the next run of the model. When you have one or more of these outputs
associated with your model and you run a Decision Analysis, you will be
given a warning that any unsaved results from the previous run will be
cleared or overwritten by the new run. See Figure 3-19.
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Figure 3-19. Unsaved Results Warning

An unsaved output or dataset will be cleared, even if you do not select the
output to be created in the subsequent run. For example, if you have an
unsaved Risk Profile associated with your model and run a Decision
Analysis in which you do not request a Risk Profile, the Risk Profile from
the previous run is still deleted.

To save outputs from a particular run so that they will not be overwritten in
subsequent runs, you must re-name the output in the Workspace Manager.
Note that there is no limit to the number of saved sets of results you can
have in DPL workspace.

When you rename a Risk Profile dataset the corresponding Risk Profile
chart will also be renamed, and therefore, saved as well.

Outputs generated from a sensitivity analyses (tornado diagrams, rainbow
diagrams, Time Series Percentiles, and Option Value charts) and Policy
Summaries that are generated from the Policy tab are not overwritten in
subsequent Decision Analysis runs or analyses. They will remain in the
workspace until you explicitly delete them.

When you save a DPL workspace (File | Save) you save all outputs
(renamed or otherwise) included in your workspace, along with any
formatting done.

Further if you format certain outputs such as a Risk Profile chart but do not
rename it, DPL will not delete the chart but will re-use it for the next run if
a Risk Profile is requested. This allows you to make formatting changes
once, make edits to the data in the model or structure of the model and re-
run to produce a new chart with the same formatting. This may be
convenient if you need to do a series of runs for a presentation. See
Section 3.7 for information on copying outputs to presentations.
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3.5 Expected Value of Perfect Information /
Control

The expected value of perfect information / control is actually two outputs
which both indicate how important it is to reduce the uncertainty
associated with each discrete chance node in a model. The expected value
of perfect information indicates how valuable it would be to have perfect
information for a chance node before making a decision. The expected
value of control indicates how valuable it would be to have complete
control over the uncertainty.

= In the Home | Run group, make sure the following are checked: Risk
Profile, Policy Tree, VOIC and Value Correlations.

= Click Home | Run | Decision Analysis or press F10. Click Yes to the
overwrite prompt. DPL clears the model of all Policy Tree and Risk
Profile outputs (the Policy Summary is maintained), produces the
requested outputs, and activates the Policy Tree.

Note if you formatted the Risk Profile chart as described in Section 3.2 then
as discussed at the end of Section 3.4 the Risk Profile chart will be re-used
in this run preserving the formats you made.

= Double-click the Value of Info/Control item in the Workspace Manager
to activate the output.

You will now examine the expected value of perfect information / control
results.
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Figure 3-20. Expected Value of Perfect Information / Control

DPL displays the value of perfect information for each chance node as a
red vertical bar and the value of control as a yellow vertical bar. By default,
both sets of bars are displayed and the nodes are sorted in descending
order by their value of perfect information.

DPL calculates the expected value of perfect information for each chance
node, in essence, by moving it to the front of the Decision Tree (or as far
to the front as it can) while keeping all other nodes fixed in position and
"re-running" the model. (Note that DPL's solution algorithms allow it to
calculate the expected value of perfect information without actually having
to re-run the model.) DPL calculates the expected value of the objective
function for the modified model.

The expected value of perfect information for a chance node is the
difference in the expected value of the objective function of the modified
model and the expected value of the objective function of the base model.

It is called the expected value of perfect information because the modified
model simulates the situation in which you have perfect information about
the uncertainty before you need to make a decision. For example, in the
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base model you must make the decision to develop the drug before you
know what market share will be. The difference in value between the
modified model and the base model is due to the information gained.

For a given chance node, if the value of perfect information is greater than
zero, then the optimal alternative must be different given the outcome of
the chance node in the reordered tree (otherwise the expected value of the
objective function of the model with the reordered tree would be the
same).

You will modify the model and generate a new Policy Tree for comparison
to the original Policy Tree in order to see how DPL calculates the value of
perfection information for Market Share. To do so:

= Press Ctrl+F12 to activate the model.

= Select and drag the Market Share node to the head of the Decision
Tree. Notice when you hover the node cursor over another node, a re-
order icon appears under your cursor as shown in Figure 3-21.
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Total_| NPV
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Figure 3-21. Dragging Market Share node to Re-order Decision Tree

= Place the Market Share node on top of the Develop? decision node. It
should now be at the head of the tree.

= Select the branches of the Market Share node and Ctrl+X to cut the
get/pay expression from the branches.
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= Select the branches of the last node in the tree (Market Size), and
press Ctrl+V to paste the get/pay expression to its branches.

You will save some of the outputs generated for future use. Most
importantly you'll rename and save the original Policy Tree so you can
compare it to the Policy Tree generated for the modified tree.

To rename items in the Workspace Manager you can right-click the item
and choose Rename from the context menu or select the item and press
F2.

= Rename the outputs as follows:

Original Output Name Renamed Output
Value Correlations Saved Value Correlations
Value of Info/Control Saved VOIC
Policy Tree Original Policy Tree

= Leave the names for the Risk Profile dataset and chart as is. You will
allow these to be deleted with the next run as they aren't needed.

= In the Home | Run group make sure Policy Tree is checked, all other
outputs should be un-checked.

= Run a Decision Analysis and say Yes to the overwrite prompt.

First off, notice that the Risk Profile dataset and chart have been deleted —
as you did not rename, and therefore, did not save them. Even though you
may have formatted the Risk Profile chart and it got re-used in the previous
run, the chart is deleted in this run since you did not ask for a Risk Profile
this time. The three outputs that were re-named have been maintained
through the run, along with the Policy Summary which was created from
the Policy tab and not as a part of an analysis. There are now two Policy
Tree outputs associated with the model ("Original Policy Tree" and "Policy
Tree"). The "Policy Tree" for the modified model is active as shown in
Figure 3-22.
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Figure 3-22. Policy Tree to illustrate Value of Perfect Information

The expected value for the modified model is 32.2. Recall (or look back at
the original Policy Tree) that the EV for the base model is 7.6. Therefore,
the value of perfect information for Market Share is 32.2-7.6= 24.6 (which
is the height of the Information bar for Market Share in the VOIC chart).
This indicates that the optimal alternative must have changed for one of
the outcomes of Market Share. If you had the luxury of knowing which
state Market Share was in before deciding to develop the drug, you would
choose not to proceed in certain scenarios. As shown in the Policy Tree
above the optimal decision alternative is not to develop when Market Share
is Low or Nominal.

3.6 Value Correlations

In this section you will examine a simple example of a Value Correlations
chart. Value Correlation charts are bar charts that display the correlation
coefficients between each value and event in the model and the objective
function.

Correlation coefficients are measures of statistical association between two
variables. Correlation coefficients can vary between 1.0 (perfect positive
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correlation) and -1.0 (perfect negative correlation). Perfect positive
correlation (1.0) means that as one of the two variables increases, the
other variable always increases proportionately. Perfect negative
correlation (-1.0) means that as one variable increases, the other variable
always decreases proportionately.

Correlation does not always imply causation; that is, even if two variables
are correlated, it does not necessarily mean that an increase or decrease in
one variable is causing the change in the value of the other variable. Lack
of causation may be due to, for example, both variables being influenced
by some other variable which is not in the model.

Note when you request value correlations DPL must evaluate the model
using full tree enumeration and does this automatically. You may have
noticed previously that this changes the default action of the Home | Run |
Decision Analysis button. For this simple example, it is unlikely you will
notice the difference. For larger models, you may wish to return to fast
sequence evaluation after running value correlations. Use the Home | Run |
Decision Analysis drop-down list to do this the next time you run the
model.

= Double-click on the Saved Value Correlations item to activate the
window. The Value Correlations chart is displayed as in Figure 3-23.

Correlaticn Coefficient

Total NPV Markat Share Market Size Phase 2 Pricing Phase 3 Continue to Ph 3 Reg Approval Phase 1 Comp Outcome

I Positve Correlation ) Negative Correlation

Figure 3-23. Value Correlations Chart

120



Syncopation Software Chapter 3

The Value Correlations chart assumes that the optimal decision policy is
followed. It tells you which values in your model tend to vary in the same
direction (positive correlation) or in the opposite direction (negative
correlation) as the objective function, which in this case is NPV. Positive
correlations are shown as purple bars, while negative correlations are aqua.
A correlation (bar) is shown for each value in the model for which the
correlation coefficient can be calculated. Each value corresponds to either a
decision node, a chance node, or a value node in the model. If a chance
node or decision node has no values associated with it, DPL correlates the
state numbers with the objective function. E.g., for a decision node with
two alternatives, the first alternative has a state number of 1 and the
second alternative has a state number of 2.

As Figure 3-23 shows, only one of the chance events is highly correlated
with the objective function. The first bar (Total_NPV) simply indicates that
the objective function is perfectly correlated with itself. Market Share is
highly positively correlated with the objective function. This makes sense
because the higher the market share, the higher the revenues and NPV
are. On the other hand, Key Competitor Outcome is negatively correlated
with the objective function (Total_NPV).

In decision analyses with complex value models, Value Correlations charts
are useful for understanding how the variability in the objective function is
related to the variability in individual values such as chance nodes and
downstream decisions.

3.7 Copying/Pasting to a Presentation

All of the output charts in DPL can be copied and pasted to other
applications, e.g., presentation software or word processing software such
as Microsoft PowerPoint or Word. In addition, you can copy and paste DPL
models. When you copy an image, it is copied onto the clipboard both in
metafile format and bitmap format. Depending on whether and to what
extent you intend to edit the copied image, one format might be preferable
to another. In particular, if you wish to edit the chart image in PowerPoint
other than just resizing it subsequent to pasting it, you should turn on the
Produce simplified metafiles for ungrouping in Powerpoint setting within
File | Options | Outputs (Figure 3-24). If you are using an application other
than Powerpoint, you may need to experiment with the Paste options to
find the best one.
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Figure 3-24. Produce Simplified Metafile Setting
within File Options dialog

If you will not be editing the image itself (other than resizing it) subsequent
to pasting it, paste it as a bitmap. The image will look exactly as it does on
screen. If you maintain the aspect ratio (height to width) when you resize,
you can resize the image and still maintain how it looks from when you
copied it. If you intend to make more substantial edits to the image, paste
it as a metafile. In Powerpoint, you can then un-group it and make various
edits. Note: the simplified metafile setting above results in better looking
images when they are un-grouped in Powerpoint.

= Open a presentation or word processing software application that you
use (e.g., Microsoft Powerpoint). Use a blank document where you can
paste an example chart.

= Navigate to File | Options | Outputs and check the box for Produce
simplified metafiles for ungrouping in PowerPoint as shown in Figure
3-24.
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= Activate the VOIC chart you examined earlier.

Click Home | Edit | Copy (or Press Ctrl+C) to copy the chart to the
clipboard.

=
= Switch to the document you opened. Use Edit | Paste (this pastes as a
bitmap by default) or Edit | Paste Special to paste the chart.

=

If you're using PowerPoint or Word and have copy/pasted the image as
a metafile, you can right-click on the image and select Group |
Ungroup from the context menu to facilitate edits.

= Close the application (save the new document with the chart image
only if you want to; you don't need it later in this guide.)

For this particular bar chart you may not see a difference between the
bitmap and simplified metafile image once ungrouped in PowerPoint. But it
should be noted that some charts (e.g., Risk Profiles) will need to be in
simplified metafile format for PowerPoint to ungroup the image properly for
editing.

The above steps can be used for copying an image of your DPL model or
any of DPL's output charts to other applications. Note: because the chart is
copied as a picture, the underlying data is not copied to the other
application.
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4. Building a Model in Influence
Diagram-focused Mode

This tutorial focuses on building a spreadsheet-linked model in Influence
Diagram-focused mode for a simple decision analysis application. The main
purpose of an Influence Diagram is to show the relationships among the
different factors relevant to a decision. DPL's Influence Diagram modeling
environment provides a rich set of features to give you flexibility in defining
these relationships.

In this chapter, you'll familiarize yourself with key Influence Diagram
modeling features like adding Excel-linked value nodes, running sensitivity
analyses, introducing uncertainty and conditioning, and generating results.
If you are new to DPL and would like to familiarize yourself with the
modeling features of the Influence Diagram, this tutorial is a good place to
start. If you would prefer to model in Decision Tree-focused mode, you
should go through the tutorial contained in Chapters 2 and3.

A DPL model is always a combination of an Influence Diagram and Decision
Tree. When modeling in Influence Diagram-focused mode, DPL continues
to update the default Decision Tree behind-the-scenes. You can press the
Tab key or drag the splitter to the middle of the model window to view the
Decision Tree. Keep in mind that once you've made edits to the default
tree, you've taken over the controls and DPL will no longer make edits to
the tree as you model in the Influence Diagram.

4.1 Value Nodes and Spreadsheet Links

You will develop a decision model by adding spreadsheet-linked value
nodes to the Influence Diagram. Each of these nodes will be linked to a
range in the Excel spreadsheet called New Product Strategy.xIsx, which is
an example file installed with the software.

A value node is a constant (i.e., a number) or calculated quantity (i.e., a
formula) in a DPL decision model. They can be linked to a cell in a
spreadsheet or be local (i.e., not linked and contain a number or formula in
DPL). Value nodes are represented by rounded blue rectangles in the
Influence Diagram.

= Open DPL.
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By default, DPL will start with an empty Decision Tree pane maximized on
the right-hand side of the screen. You'll be building the model in Influence
Diagram-focused mode so you'll switch to Influence Diagram-focused
mode.

= Press Tab to switch to the Influence Diagram pane of the model
window. See Figure 4-1.

The Influence Diagram pane will now be maximized within the Model
Window and the Influence Diagram ribbon tab active.

E B -3+ DPL - Workspace2 - [Model1] - o x
HOME | INFLUENCEDIAGRAM  DECISIONTREE  VIEW  DATA  HELP -a

|j o ?Lmlredhlc(lé' ps’;;_l @ i ﬂ) P ﬁ
vents Formulas

Edit Add

‘Workspace Manager 4

B-<& Workspace
2= Modell

Session Log 4

DPL -

US tol-free: 1 866 796 2375
Quiside the US: +1 978 233 2509

Enterprise Version
Support expires: June 18, 2017

Release 9.00.00

Buil Apr 26 2017 14:14:32 (84-bi)

Serial Number: SYDES0170415001

Licensed User: Synce User, Syncopation Software

For Help, press F1

Figure 4-1. New Workspace with Decision Tree pane maximized

If you wish to have all new models start with the Influence Diagram pane
active and maximized, do the following:

= Click File | Options. The General tab of the File Options dialog is
displayed.

= Select the Influence Diagram radio button for the For new models,
maximize pane setting. Click OK to close the dialog.

You're going to start building out the model by adding linked value nodes
to the Influence Diagram. To do so:
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= Click the Influence Diagram | Node | Linked Node split button. Note
initially the default action of this button should be to add Excel

Calculation-Linked nodes (?J) which is what you want. If it isn't, drop
down the list and select it.

= In the Create Calculation Linked Values from Excel dialog (Figure 4-2),
click Browse and select the file New Product Strategy.xIsx. The
spreadsheet is located within the Examples folder of the DPL
installation directory, usually
C:\Program Files\Syncopation\DPL9\Examples.

The directory may vary slightly depending on your license type and
operating system.

Create Calculation-Linked Values from Excel

Spreadzheet;
C:%Program FileshSuncopation\DPLIVE samplesiMew Product Strateogy. sl | Lﬂ.ruwse... i

(] Cancel

Figure 4-2. Create Linked Values Dialog

= Click OK. The Range Names dialog appears.

The Range Names dialog displays all named ranges in the spreadsheet that
are suitable for linking to value nodes.

Important note: DPL only displays named ranges or cells in the Range
Names dialog. Before linking a spreadsheet to DPL, you should ensure that
ranges you wish to link are named in Excel. Please consult your Excel
documentation if you are not familiar with named cells/ranges, as they are
essential for using DPL with Excel.

= Select the ranges named Cost_per_Unit, Launch_Costs,
Marketing_Costs, NPV, Revenue_per_Unit and Unit_Sales as shown in
Figure 4-3. (Hint: to select multiple names, hold down the Ctrl key as
you click the names.)
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Range Mames - C:\Program Files\Syncopation\DPL%\Examples\MNew Product Strateg

Creating Calculation-Linked W alues

MHame Location Type Count  Rows  Col...
Basze_Date Drivers!$CH12 Walue 1 1 1 Select &l
Drivers!$CE2E Walue 1 1 1
Drivers!$CH10 Walue 1 1 1
Drivers!$CH30 Walue 1 1 1
Driversl$C328 Value 1 1 1 Cancel
Driversl$C$17 Farmula 1 1 1
Calculations! $C$24  Formula 1 1 1 [ Sort b location
Dr?vers!$|3$22 Yalue 1 1 1 W e s
Driversl3CE24 Yalue 1 1 1 already linked

Shaw ranges
with farmulaz

[] Prefix node
name with sheet
name

Figure 4-3. Range Names Dialog with Selection

= Click OK. DPL creates the linked value nodes and adds them to the
Influence Diagram.
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= Arrange the nodes so they look like Figure 4-4.

Revenue
Unit per Unit
Sales

Cost
per NPV

Unit

Marketing Launch
Costs Costs

Figure 4-4. Model with Six Value Nodes Arranged

When you build a spreadsheet-linked DPL model, you will typically have
DPL send different sets of drivers to Excel and then ask Excel to send back
one or more metrics. Nodes in DPL that send data to Excel are called driver
nodes. Nodes that receive data back from Excel are called metric nodes.
Driver nodes are typically linked to ranges in Excel that contain constant
numbers (not formulas). While metric nodes are typically linked to ranges
in Excel that contain formulas. In the current model, NPV is a metric node
and all the rest are driver nodes.

= Double-click on the Cost per Unit value node. The Data tab of the Node
Definition dialog is displayed. See Figure 4-5.
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Mode Definition: Cost per Unit

General Data  Links

Conditioning... LCopy Full Screen Wwiheel Beorder Cf ) CP Cf‘ Fant...

[ |[v|[.f

Cost
per

Unit
O.SD

v
< >

Concel | | i

Figure 4-5. Data Tab of the Node Definition Dialog for Cost per Unit

The Data tab displays a data input tree for the value node and allows you
to enter the data for this node. Because this node was created as a linked
value, DPL has filled in the value of 0.8, which comes from the cell named
Cost_per_Unit in the spreadsheet.

= Switch to the General tab of the Node Definition dialog. See Figure 4-6.

To the right of the Name and settings section are several options specific to
value nodes. For instance, via the checkboxes you can choose to hide the
value node or specify that it is a dummy node (i.e., a node that doesn't
include data and is ignored by DPL during an analysis), which can be
helpful in indicating calculations more clearly. You can also specify that the
value is a constant, string, or integer.

Further to the right are a set of radio buttons that allows you to specify the
dimensionality of the value node. Value nodes can be a single value (i.e., a
scalar) like Cost per Unit is currently, a one dimensional array, a series, or
a two-dimensional array. If you specify anything other than a Scalar value,
the number of rows, columns or both should be specified on the Data tab.
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Node Definition: Cost per Unit

General Data  Links

Mame and settings
E [Hide [Constant []Sting []Integer (®) Scalar value

() 1 dmensional amay (N values) or series

] Dummy () 2 dmensional amay (M x N values)

DPL variable name for expressions
Cost_per_Unit

Comments

Print All Commenrts...

Copy to Clipboard

Concel | |t

Figure 4-6. General Tab of the Node Definition Dialog for Cost per Unit

= Switch to the Links tab of the Node Definition dialog. See Figure 4-7.

MNode Definition: Cost per Unit

General Data Links

Calculation links

These links are recalculated throughout the run. They may be either inputs used in the linked spreadshest’s calculations {e.g., unit sales) or calculated results from the
spreadsheet (e.g.. NPV},

(O None (local) () DPL Program ®

Workbook: |S:\dpl9’D\ExampIes\New Product Strategy xdsx | Browse...

Sheet/Cell. [ DriversICost_per_Unit | | GotoCel | |CollMames.. | v
This is a driver node. Its value will be sent to Excel each time it changes during the run Paste Link

Initialization links

These links are for connecting to a spreadsheet, database or program that contains data (values and/or probabilities) which will be used in the Data tab to initialize
nodes. These links are refreshed once at the start of each un.

(®) None flocal or DPL program) (O Microsoft Excel (O Database

Go to Model Links

[ok ]| caneal Help
Figure 4-7. Links Tab of Node Definition dialog for Cost per Unit
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The Links tab contains information about the links between the node and
Excel. There are two categories of spreadsheet links: calculation links and
initialization links. Calculation links are used to send or receive data from
Excel during the course of a run. Initialization links are used to set the
values (or probabilities) for a node at the beginning of each run.
Initialization links are discussed in Appendix A.3.

The radio buttons near the top of the Calculation links section of the dialog
indicate whether the node is linked and if so, to what (Excel or a DPL
Program). The workbook as well as the sheet and cell that the node is
linked to are displayed in edit boxes. The sheet and cell syntax is the same
as Excel's syntax (i.e., Sheet1!Cell_name).

Table 4-1 summarizes the functions of the buttons in the Calculation links
section.

Button Action

Browse... Finds a spreadsheet or allows you to change to which
spreadsheet this node is linked.

Range Brings up the Range Names dialog which can be used to
Names... change the sheet/cell to which this node is linked.

Go to Takes you to the cell/range in Excel to which this node is
Range linked.

Paste Pastes a link to a cell from Excel. The cell must be

Link copied in Excel first.

Table 4-1. Calculation Links Buttons

= Click the Go to Range button.

DPL activates Excel and selects the sheet and range to which the node is
linked. As you can see in Figure 4-8, the range named Cost_per_Unit
contains the value $0.80, which is what DPL copied for the node's data.
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Cost_per_Unit -

Discount Rate

Base Date

Revenue per Unit
Unit Sales

Cost per Unit
Marketing Costs

Launch Costs

Calculations

Value Drivers and Metrics

H - = Mew Product Strategy.xlsx - Excel ? |

FILE B—(DME INSERT PAGE LAYOUT

FORMULAS DATA

112017

- o x
REVIEW B
)

Figure 4-8. Excel with Linked Range Selected

= Switch back to DPL.

= Click OK to close the Node Definition dialog without making any

changes.

At this point, you may want to name your DPL model and save your

Workspace file.

= Select the item for the model in the Workspace Manager (DPL gave it

the default name of "Model1").

= Press F2 to edit the name.
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= Type "License vs. In-house" or any other name you'd like.
= Press Enter to save the edit.

= Save the Workspace and give it a name of your choice using File |
Save.

4.2 Influence Arcs

You will now add some influence arcs to the model. Influence arcs indicate
one or more of three things to DPL: 1) dependency 2) conditioning and/or
3) timing. (Note: see the Glossary of DPL and DA Terms for definitions of
dependency and conditioning.)

Influence arcs are useful because they visually indicate which nodes
depend on or are conditioned by other nodes. You will start by creating an
influence arc between Revenue per Unit and NPV.

= Click in whitespace or hit Esc to deselect Cost per Unit.

= To create an influence arc, click the Influence Diagram | Influence/Arc
| Add button on the ribbon (see Table 1-3). The mouse cursor changes

to the begin arc cursor ( [fl ).

= Place the cursor over the Revenue per Unit node and click. Now the

(J i
cursor changes to the end arc cursor ( # ) and an arc is anchored at
the Revenue per Unit node. Revenue per Unit is called the predecessor
node for this arc.

= Place the cursor over the NPV node and click. An influence arc is drawn
from Revenue per Unit to NPV. Click in whitespace to deselect the
nodes and arc. See Figure 4-9. NPV is called the successor node for
this arc.
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Revenue
per Unit

Unit
Sales

Cost
per
Unit

Marketing Launch
Costs Costs

Figure 4-9. Model with Influence Arc

An influence arc that points from node A to node B indicates that node B
depends on, is conditioned by and/or occurs after node A. In Figure 4-9,
the influence arc you just added indicates that NPV depends on Revenue
per Unit.

Note: DPL indicates which arc is selected by coloring it magenta. In
general, DPL indicates selected items in the Influence Diagram or Decision
Tree by coloring them magenta.

There is an easy way to have DPL automatically generate influence arcs
based on your formulas or spreadsheet links.

= Click Influence Diagram | Influence/Arc | From Formulas on the ribbon
(see Table 1-3).

DPL generates the influence arcs from the formulas found in the node data.
Your model should now have all the arcs shown in Figure 4-10.

134



Syncopation Software Chapter 4

Revenue
per Unit

Cost
per
Unit

Marketing
Costs

Figure 4-10. Model with All Influence Arcs

Note: the above process provided you with some familiarity on how to
create individual Excel-linked nodes and how to create individual influence
arcs. This information is useful when building and modifying DPL models.
However, DPL also provides a command which will create the model shown
in Figure 4-10 in a single step. Before continuing, you will try this now.

=
=

434

Select Home | Workspace | Add to WS | Excel Linked Model.

In the Create Model from Excel dialog, click Browse and select the file
New Product Strategy.xlIsx. It is in the folder with DPL examples,
usually C:\Program Files\Syncopation\DPL9\Examples.

Within the Range Names dialog select the same ranges as shown
Figure 4-3 (Cost_per_Unit, Launch_Costs, Marketing_Costs, NPV,
Revenue_per_Unit, and Unit_Sales).

Click OK.

You will receive a prompt that linked nodes have been created in the
Influence Diagram. Click OK.

Press Tab to activate the Influence Diagram.
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DPL has created a new model in the Workspace called New Product
Strategy (i.e., the same name as the spreadsheet). Other than node
arrangement this model is identical to the model in Figure 4-10. This is a
much quicker way to build a model from an Excel spreadsheet. However, it
is also important to know the steps outlined in Sections 4.1 and 4.2.

= Select the New Product Strategy model in the Workspace Manager.

= Press Delete.
= Click Delete Model in the Confirm Delete dialog.

You will now continue with the initial model you built.

4.3 Running an Initial Analysis

You are at the point where you can run the model to check the model for
correctness. You may wish to save your Workspace before running the
model.

= Click on the Home tab. Within the Home | Run group there are a
number of different output and run options available in a Decision
Analysis run which were covered in Chapter 3.

= Uncheck Risk Profile and Policy Tree, as these outputs would be
uninteresting (see Figure 4-11).

g Rizk Profile Policy Tree Levelz [(nong] -

— (none) - Policy Summary Endpoints
Decision ) ) )
Analysis™ WOIC Yalue Correlations

Figure 4-11. Decision Analysis Options in Home | Run Group

= Click the Home | Run | Decision Analysis icon to run the default
analysis (fast sequence evaluation).

= DPL runs the model and brings up the Analysis Complete dialog. See
Figure 4-12.

136



Syncopation Software Chapter 4

DPL >

Analysis Complete,

Expected value = 105.1

Figure 4-12. Analysis Complete Dialog

You will not normally see the Analysis Complete dialog since it is only
displayed if no outputs are requested for a Decision Analysis run within the
Home | Run group. In this instance, the model is deterministic; it does not
yet include any uncertain events so the expected value is just the
calculated value of NPV.

= Click OK to dismiss the Analysis Complete dialog.

4.4 Decision Nodes

You will now build out your DPL model by adding a local decision node.

= Click the Influence Diagram | Node | Add split button to create a
decision node (it should be the default indicated).

Click in a region to the left of the value nodes in the Influence
Diagram. The Node Definition dialog appears.

automatically split the node name into multiple lines.

Select the Yes alternative, type "In-house" to rename it. Note: you may

=
= Type "Product Strategy" for the Name of the node. DPL will
=
also click the Rename button or press F2 to edit an alternative name.
=

Rename the No alternative to "License".

Your node definition dialog should now look like Figure 4-13.
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Mode Definition: Product Strategy

Name and settings

Product [1Hid=
Strategy
DPL variable name for expressions:
Product_Strategy
Altematives
In+ouse (Default) Add
License
Insert
Delete
Bename {F2)
Default
Comments
Frint All Comments...
Copy to Clipboard

Corcel | | e

Figure 4-13. Node Definition Dialog for a Decision Node

= Click OK to close the Node Definition dialog. Your model should now
look something like Figure 4-14.

138



Syncopation Software Chapter 4

Revenue
per Unit

Product Cost
Strategy per
Unit

Marketing
Costs

Figure 4-14. Model with Product Strategy Decision

Now that there is an event in the model, DPL has begun to build a
symmetric, Decision Tree for you within the Decision Tree pane — which

currently isn't visible.

= Press the Tab key to switch your view to the Decision Tree pane. It
should match what you see in Figure 4-15.
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Product
Strategy

In-house
T

|: License Q

Figure 4-15. Decision Tree pane displaying Default Tree

This Decision Tree is referred to as the Default Tree. If you do not modify
the Decision Tree yourself, DPL will continue to build a symmetric Default
Tree for you — even when the Decision Tree pane isn't visible (see Section
2.2 for a discussion of symmetric trees). If you build your model entirely
from the Influence Diagram and find once it is completed that the Default
Tree has the structure you want, then there is no need to change the
Default Tree.

Once you modify the Default Tree, you have taken over control of the tree.
DPL will no longer build a Default Tree for you. You can always ask DPL to
create the Default Tree from the current Influence Diagram by clicking
Decision Tree | Model | Default Tree (see Table 1-4).

= Press the Tab key again to switch back to the Influence Diagram.

In order to incorporate the new decision into your model, you will need to
add two additional nodes.

= Create a new value node by dropping down the Influence Diagram |
Node | Add split button and selecting Value from the list.
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= Click near the top of the Influence Diagram to place the new node. The

Node Definition dialog appears.

Type "License Fee" for the node name.
Switch to the Data tab.

Type "0.75" for the node data.

Click OK to close the Node Definition dialog.

344833400

Click Influence Diagram | Influence/Arc | Add (see Table 1-3). DPL

uses License Fee as the predecessor node since it is selected and

changes the cursor to the end arc cursor.

4

on Revenue per Unit.

Draw an influence arc from License Fee to Revenue per Unit by clicking

Note: Another way to draw an influence arc is to hold down the Shift key,
click on the first node (such as License Fee), and then click on the second
node (such as Revenue per Unit). You can also right-click in the Influence

diagram and select Add Arc from the context menu.

= Repeat the process above, adding a new value node called "Price" with

data of "2" that has an arc leading to Revenue per Unit.

License
Fee

Revenue
per Unit

Product
Strategy

Marketing
Costs

Figure 4-16. Model with Price and License Fee Nodes
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Your model should look like Figure 4-16 above. You will now edit the
definition of Revenue per Unit to incorporate the Product Strategy decision.

= Double-click the Revenue per Unit node to edit it. The Node Definition
dialog appears with the Data tab selected.

= Click the Conditioning button. The Conditioning dialog appears.
= Click the checkbox next to Product Strategy as shown in Figure 4-17.

Cenditioning: Revenue per Unit

The walues for thiz node depend o

Mumber of value exprezsions required: 2

Carca

Figure 4-17. Conditioning Dialog

= Click OK to close the Conditioning dialog.

The Node Definition dialog Data tab now indicates that two values are
required for Revenue per Unit: one for the In-house alternative of the
Product Strategy decision and a second for the License alternative. DPL has
copied the value that was specified when the Revenue per Unit node was
not conditioned on anything to both entries. DPL indicates the currently
selected entry by coloring it magenta in the data input tree.

= With the In-house alternative selected, click the select Variable button (
V') to display the Select Variable dialog. See Figure 4-18.
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Select Vanable
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Licenze_Fee
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Figure 4-18. Select Variable Dialog

= Double-click Price in the list. Press Enter. DPL replaces the number 2
with the Price variable within the data input tree.

Note: In variable names, DPL replaces spaces and punctuation marks with
underscores "_" in multiple word node names so the value node "Unit
Sales" has a variable name of "Unit_Sales". The variable name is what is
used in in expressions (formulas). Using the Select Variable dialog saves
typing, reduces errors from misspellings and prevents you from having to
remember the names of all the variables in your model. Also, DPL variable

names are case sensitive; "Costs" is different from "costs".

= With the License alternative selected, click the select Variable button (

V') and double-click License_Fee in the list. Press Enter. Your data
input tree for Revenue per Unit should now look like Figure 4-19.
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Mede Definition: Revenue per Unit

General Data  Links
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: M5
~
Revenue
Product In-house per Unit
Strategy
License D
License_Fee
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Figure 4-19. Data Input Tree for Revenue per Unit Node
with Conditioning

You have now told DPL that when Product Strategy is in the In-house
alternative, Revenue per Unit is equal to Price, whereas when

Product Strategy is in the License alternative, Revenue per Unit is equal to
License Fee.

= Click OK to close the Node Definition dialog. Your model should now
look something like Figure 4-20.

Note that DPL has drawn an influence arc from Product Strategy to
Revenue per Unit to indicate that Product Strategy conditions

Revenue per Unit. Also note that the arrowhead of the arc is colored. DPL
uses a blue arrowhead to indicate that the values of Revenue per Unit
depend on which state or alternative Product Strategy is in. Arrowhead
colors are covered in more detail in Section 7.3.
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License
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Product
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Figure 4-20. Model with Revenue per Unit Conditioned
on Product Strategy

= Press the Tab key to view the Decision Tree pane.

DPL has also updated the Default Tree, adding NPV as a get/pay
expression for the decision node Product Strategy. A get/pay expression
tells DPL what value to get (i.e., you receive) or pay (i.e., you pay out) at
each point in the tree. The get/pay expression is displayed below the
branch on which it occurs in the Decision Tree. For now, leave the get/pay
expression as is.

It should be noted that value nodes are not displayed directly in the
Decision Tree; rather, the names of value nodes appear in get/pay
expressions on branches in the Decision Tree. Unlike a decision or chance
node, a value node is not an "event" which occurs in the sequence of the
tree, it is simply a calculated quantity.

= Press the Tab key to return to the Influence Diagram pane.
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You will now neaten up your model by bending the arc from Product
Strategy to Revenue per Unit.

= Select the influence arc with the left mouse button and without
releasing the mouse button begin to drag the arc upward. The mouse
i

cursor will change to the arc bend cursor ("“\"-) and a dashed line will
appear to preview the bent arc.

Continue dragging until your arc looks similar to the arc in Figure 4-21.
Release the mouse to fix the arc in place.

License
Fee

44

Revenue
per Unit

Product

Strategy Cost
per
Unit

Marketing
Costs

Figure 4-21. Model with Bent Arc

When you defined conditioning for Revenue per Unit, you used the
Conditioning dialog. DPL also provides a way for you to define conditioning
via the arcs in the Influence Diagram. You will now use this procedure to
condition Cost per Unit and Marketing Costs on Product Strategy.

= Click Influence Diagram | Influence/Arc | Add on the ribbon.

= Draw an arc from Product Strategy to Cost per Unit: click on Product
Strategy, and then click on Cost per Unit.

= Double-click the new influence arc. The Value Influence Type dialog
appears.
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= Check the Different values for each conditioning event state checkbox
as shown in Figure 4-22. Notice that the preview arc head is now
colored blue.

Value Influence Type

Walues
ifferent walues for each conditioning event state

[ ] Make thiz the default value influence type

Corca

Figure 4-22. Value Influence Type Dialog
= Click OK to close the Value Influence Type dialog.

You have now told DPL that the values for Cost per Unit are conditioned by
Product Strategy.

= Double-click Cost per Unit. The Node Definition dialog appears with the
Data tab selected.

Note that DPL has changed the node data input tree so that it is

conditioned on Product Strategy and has copied the data for Cost per Unit
to each of these data entry slots.

= Arrow down to select the License alternative.

= Type "0" and press Enter. Your node data input tree should look like
Figure 4-23. (This is a very simple model; if Product Strategy is in the
License alternative, costs equal zero.)
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Figure 4-23. Node Data Input Tree for Cost per Unit
= Click OK to close the Node Definition dialog.

You will now try a different procedure to create an influence arc between
Product Strategy and Marketing Costs. To do this you will select multiple
nodes in the Influence Diagram by holding down Control and clicking.

= Click Product Strategy to select it.
= Hold down Ctrl and click Marketing Costs to select both nodes.

= Click Influence Diagram | Influence/Arc | Add. DPL creates an arc from
Product Strategy to Marketing Costs.

If you have two nodes selected DPL will create an influence arc from the
first selected node to the second selected node when you click Influence
Diagram | Influence/Arc | Add. Note you can use this method to create
multiple arcs at once. If you select more than two nodes and then click the
Influence Diagram | Influence/Arc | Add, DPL creates an arc from the first
node selected to each subsequent node.

Now repeat the remaining procedure above to make Marketing Costs
conditioned on Product Strategy by changing the arc type. Like Cost per
Unit, Marketing Costs is zero if Product Strategy is in the License
alternative. Your data input tree for Marketing Costs should match Figure
4-24,
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Figure 4-24. Node Data Input Tree for Marketing Costs

= If you wish, bend the influence arc from Product Strategy to Marketing
Costs. Your model should now look something like Figure 4-25.
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Figure 4-25. Model with Conditioning from Product Strategy Decision

Note in this example you conditioned several nodes on the Product
Strategy decision. For example, you specified that both Cost per Unit and
Marketing Costs were zero if the Product Strategy alternative is License.
Another way to do this would be to link the decision node to the
spreadsheet with flag values (e.g., 1 and 2) and put the logic for marketing
costs, etc. in the spreadsheet (e.g., an Excel formula such as
=if(Product_Strategy=2,0,Marketing_Costs)). As with any other node type,
decision nodes can be linked to Excel.

Now that you have added a decision to your model, you will run it again.
You may wish to save the workspace first.

= For the Decision Analysis options within the Home | Run group make
sure Risk Profile is unchecked.

= If Policy Tree is unchecked, check it. The Home | Run group should
look like Figure 4-26.
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poan Risk Profile v Policy Tree Levels(2(all}] -

— (none) - IbsF'l:Iin:}-‘Summar}-' Endpoints
Decision ) ) )
Analysiz= WOIC Yalue Correlations

F‘_..

Figure 4-26. Decision Analysis Options for Model with Decision

= Click Home | Run | Decision Analysis or press F10 (F10 is the shortcut
for the default run type indicated in the Home | Run | Decision Analysis
icon).

= DPL runs the model with the newly added decision node and produces
the Policy Tree output that you requested. See Figure 4-27.

& = 'ﬂ = DPL - New Product Strategy 4.4.da - [Policy Tree] POLICY - 0 X
HOME INFLUEMCE DIAGRAM DECISION TREE VIEW DATA POLICY HELP -8

| Show Get/Pays | Show Branch Probs Text View D-+ D“Y
/] Show Obj, Fn, EVs  [¥] Show Joint Probs - -

Add  Compare

Disphy & PolicySummary | Subtree Risk Profile

Workspace Manager o License vs. In-house

El-<& New Product Strategy 4.4.da
=] l;:D »» License vs. In-house «
o Policy Tree

Product Strategy In-house [105.1] <I

[105-11E( 105.1
« > License [93.7] <|

Session Log b 93.7

DPL - Decision Programming Langu: A,
Copyright © 2003-2016 by Syncopa
Incorporating software on license tc
Syncopation Software, Inc.

Allrights reserved.

Use of this software is governed by

yncopation.com
@syncopation.com

US toll-free: 1 866 796 2375

Outside the US: +1 578 233 2509

< > < >

For Help, press F1 Zoom: 125% Full Prevy =——+H—+

Figure 4-27. Policy Tree” for Model with Decision
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Recall that 105.1 is the same expected value result from when you ran the
model in Section 4.3. So the model has not changed much from how it was
originally constructed. The optimal decision alternative is to produce the
product in-house.

Be sure to save your workspace before proceeding. At the start of Chapter
5 you will be conducting a variety of sensitivity analyses on the model
saved at the end of this section.
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5. Conducting Sensitivity Analyses

Often the first step in a successful analysis is to perform a sensitivity
analysis -- one that shows the relative importance of the value drivers. DPL
offers a variety of graphical sensitivity analyses that provide you with the
insight necessary to prioritize your focus on the variables that matter most
in the decision.

DPL's Tornado Diagram's show the effect of varying inputs on the objective
function and the optimal decision policy. For a more detailed sensitivity
analysis DPL also offers one and two-way Rainbow Diagrams, which can be
employed for a particular value or probability.

You will be continuing with the model you saved at the end of Section 4.4.

= Start DPL and open the workspace you saved at the end of Section 4.4
by using File | Open.

Note: if you're starting here and haven't worked through the tutorial in
Chapter 4 or are not confident that the model built in Chapter 4 is correct,
open the workspace New Product Strategy_Sensitivity.da from the
Examples folder in your DPL installation directory, usually

C:\Program Files\Syncopation\DPL9\Examples.

5.1 Value Tornado Diagrams

You may want to know how sensitive the decision to produce the product
in-house is to changes in value for the variables in your model. This can be
accomplished by running a Value Tornado.

Note that since the model is deterministic (has no chance nodes -- only
value and decision nodes) the Value Tornado diagram is the only type of
tornado diagram you can run at this point.

= Click Home | Sensitivity | Tornado (Value Tornado is the default
currently indicated by the icon) or press F8 (F8 is the shortcut to run
the default tornado type). You will see a blank Value Tornado Setup
dialog similar to Figure 5-2 (the figure shows the dialog with the values
already entered).
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The Value Tornado Setup dialog provides a table in which to enter the low
and high settings (range) for each value node that is not a formula. The
middle column shows the current setting for each variable.

The Cost per Unit and Marketing Costs variables are not included in the
table initially because they are conditioned by the decision and thus have
more than one value. You will add these variables to the table now.

= Within the lower half of the dialog in the Va/ue section select Cost per
Unit from the drop-down list.

Notice that in the Condiitioning section show in Figure 5-1 it shows that the
selected variable is conditioned by Product Strategy. When a value is
conditioned by events, you must specify which conditioning states to use
for the value. The drop downs in the conditioning section currently show
that the In-house alternative conditioning state is selected. The Current
value box shows that the value for Cost per Unit given In house is 0.8 (this
is written as Cost_per_Unit|Product_Strategy.In_house).

Vale Current walue:
Cost_per_Unit w08 Add Replace
Conditiohing
1. Product_Strategy
In_houze w
Cancel

Figure 5-1. Adding Conditioned Values within
Value Tornado Setup Dialog

= Click the Add button. A line for
"Cost_per_Unit|Product_Strategy.In_house" is added to the table, i.e.,
you are going to run the tornado on the value for Cost per Unit given
that Product Strategy is In house.

= Again, within the Value section select Marketing Costs from the drop-
down list and click Add.

"Marketing_Costs|Product_Strategy.In_house" will be added to the table.

= Click the blank cell for the Low value of Launch Costs and enter 20.

= Click the blank cell in the High column of Launch Costs and enter 25.
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= Continue to fill in the Value Tornado Setup dialog with the rest of the
High and Low values shown in Table 5-1. Note that you can use the
arrow keys to move around.

Value Low High
Launch Costs 20 25
License Fee 0.7 0.8
Price 1.9 2.3
Unit Sales 20 60
Cost per Unit 0.8 1
Marketing Costs 5 20

Table 5-1. Variables and Ranges for a Value Tornado

When you are done, the Value Tornado Setup dialog should look like Figure

5-2.
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Value Tornade Setup - License vs. In-house

Bars
Value Low Current High
Launch_Costs 20 22 25
License Fee 0.7 0.75 0.8
Price 1.9 2 23
Unit_Sales 20/ 40 60
Cost_per_Unit|Product_Strategy.In_house 0.8 0.8 1
Marketing_Costs|Product_Strategy.In_house 5 15 _
Bemove

Velhez Current walue:

Price ~| 2 Add Replace

Conditioning
[ Initial Decision Alternatives

oo

Figure 5-2. Value Tornado Setup Dialog

Note that the Low value for Cost per Unit is the same as the current value.
Assume you have reliable information that the cost cannot be less than 0.8.

You have now selected the values to include in the Value Tornado and
specified ranges for each.

= Click OK to run the Value Tornado. DPL generates the Value Tornado
as displayed in Figure 5-3.
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v I Low Policy Change [E Policy same as Nominal [l High Policy Change

Figure 5-3. Value Tornado Diagram

The x-axis (horizontal axis) of the Value Tornado diagram displays the
change in the objective function of the model as each of the variables on
the vertical axis is changed from the low setting you specified to the high
setting you specified. For a given variable (e.g., Unit Sales) it is changed
from the low setting to the high setting while all other variables are held at
their current settings. DPL runs the model once to establish the value of
the objective function with all variables at their current setting (for a model
with only value and decision nodes). This is called the Base Result and is
indicated by the vertical line in the Value Tornado. See Section 5.2 for a
further discussion of the Base Result. Note that the vertical line on the
diagram is at 105.1, which is the value you obtained running the model
previously. DPL sorts the bars so that the variable that has the biggest
impact on the objective function is at the top.

The changes in color indicate that a policy change has occurred for either
the low or high setting of the variable. In this model, a policy change
occurs when a different alternative is optimal for the upfront decision (the
decision at the head, i.e., far left, of the Decision Tree) from that which is
optimal for the Base Result policy.

DPL indicates that a policy change has occurred for the low setting of the
variable by displaying a portion of the bar for that variable in blue. For a
high setting policy change, the end of the bar is displayed in light magenta.

157



Chapter 5 Syncopation Software

The legend located at the beneath the tornado diagram helps to explain
this.

For different values, the blue and/or light magenta may occur on either
side of the vertical line representing the Base Result. In Figure 5-3, light
magenta and blue both occur to the left of the Base Result. This is because
a low setting of Unit Sales decreases the objective function (NPV) and
causes a policy change while a high setting of Marketing Costs also
decreases the objective function (and causes a policy change).

Note that DPL displays the change in color from green to blue (or light
magenta) midway between the value of the objective function for the
current setting and the value for the low (or high) setting. For each
variable, DPL has only tested a low, nominal and high value and the
position of the change in color does not indicate the exact value at which
the change in policy occurs. If you would like more precise information on
when the change in policy occurs, you could run a Rainbow Diagram (see
Section 5.7) to narrow down the range.

5.2 Formatting Tornado Diagrams and Other
Charts

When a tornado diagram or any other graphical output is active, the Chart
tab group opens with pink context shading and outline, as shown in Figure
5-4. It contains two tabs: Series and Format.

Within the Format tab you can change several display options: titles,
legends, axis, colors, lines, shading, and overall display of the chart. To
format the policy change colors, you can chose from color palettes
provided with DPL by checking the Use palette checkbox and then choosing
a palette from the palette gallery in Chart | Format | Color. You can also
choose a custom color via the bucket fill button.

If you have specific color preferences, such as a corporate standard color
scheme for presentations, you can create your own custom palette in .xml
format and add the file to the location indicated in the Palette tooltip (the
tooltip will appear when you hold your mouse over one of the palette
selections).

You can format the selected text within the chart via the View | Font
group.
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= To add labels to your chart, check the Show checkbox within
Chart | Series | Labels. The labels include the High/Low input values
for each variable and the resulting objective function (i.e., NPV) values.

= Check the EV/CE Values checkbox in Chart | Format | Display. The
tornado is updated as shown in Figure 5-4.

Value Tornado

Unit Sales 4 20/ 36.9 ‘ 60/196.1
Price 4 1.9/93.7 ‘ 2.3/150.6
Marketing Costs|Product Strategy.In-house - 20/93.7 ‘ 5/143
Cost per Unit|Product Strategy.In-house o 1/93.7 ‘ 0.8/105.1
Launch Costs - 25/1024 20 /100.9

License Fee -

1501

T T T T T T T T T T

20 40 60 80 100 120 140 160 180 200
Expected Value

[ Low Policy Change I Policy same as Nominal [l High Policy Change

Figure 5-4. Value Tornado with Values Displayed

DPL displays the low and high settings for each variable as well as the
expected value of the objective function when the variable is at its low and
high setting. The variables' low or high settings appear before the "/"
character and the expected values appear after. In addition, DPL displays
the expected value for the Base Result at the bottom of the vertical line in
the Value Tornado. If a variable has no impact on the objective function as
it is changed from its low to high setting, DPL displays a zero width bar and
no labels for that variable (as is the case for License Fee).

The Value Tornado indicates that four variables result in a change in policy
if they are at either their low or high setting. These variables are called
decision sensitive. In this sample model, there is only one decision with two
alternatives, so you know that a policy change implies that rather than
producing the product In-house the optimal alternative is to License it. For
more information on determining what policy change has occurred, see
Section 5.7.

You have just discovered that several of the variables in your model are
decision sensitive. Assume you do not know the value of these variables for
certain. You may want to know what the optimal policy is when these
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variables are treated as uncertainties. You will now change your model in
order to treat these variables as uncertain quantities.

You're about to make significant changes to the model, so you will create a
copy of the model as it is and edit the copy. This is good practice when you
have results, such as a Value Tornado, which are based on a simpler
version of your model and which you may later need to reproduce.

= Right mouse-click on the item for the model in the Workspace
Manager. The Workspace Manager context menu appears as in fi

WDrkSpace Manager n License vs. In-hi
S I"-lew F'ru:u:luct Strateqgy_ Ser15|tw|t}r da

Tornadol ' Dock

Properties...
Delete
Rename

Duplicate
Add to Workspace >

Portfolic >
Update Report
Session Log Add Chart >

Figure 5-5. Using the Workspace Manager to Duplicate a Model

Select Duplicate. The model is duplicated with the same name plus "-
copy" appended to it.

F2 to edit the name.

=
= Click the item for the new model in the Workspace Manager and Press
= Rename it "License vs. In-house prob".

= Press Enter.

The new model is now active in the Model Window. You may wish to save
the workspace at this point.
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5.3 Discrete Chance Nodes

You will now introduce uncertainty into the model by changing some of the
value nodes to discrete chance nodes. More specifically, you will be

changing the value nodes that are decision sensitive into discrete chance
nodes.

= Select Unit Sales.

= Click the drop-down split of the Influence Diagram | Node| Change To
button on the ribbon (see Table 1-2) and select Discrete Chance from
the list.

= The Node Definition dialog appears as shown in Figure 5-6.

Mode Definition: Unit Sales

Gereral Data  Links

MName and settings

Uit [ Hide
Sales

[[] Separate probability and value data input trees

DPL variable name for expressions:
Unit_Sales

Outcomes

Add
MNominal {Default)
High Insert
Delete
Bename (F2)
Default

Comments

FBrint All Comments...

Copy to Clipboard

Cance Help

Figure 5-6. Node Definition Dialog General Tab for
a Discrete Chance Node

= Leave the settings as they are on the General tab and select the Data
tab. The Data tab for the Unit Sales discrete chance node is shown in
Figure 5-7.
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Node Definition: Unit Sales

General Data

Links

Conditioning... LCopy Full Screen wheel Beorder | Multiple Experts... Cf sy CP Cf‘ Font...

Distribution type: | [discrete) ~

Probabiity:  [El |[v][.f
Value: [20 |[v][F

Nominal
4 40 D

High
3 60 O

Cancel Help

Figure 5-7. Node Definition Dialog Data Tab for
a Discrete Chance Node

DPL assigns default probabilities to the three chance outcomes, which can
be changed in File | Options | General. DPL also assigns the low and high
values that you specified in the Value Tornado to the Low and High
outcomes (as well as the value that was specified for the value node to the
Nominal outcome).

= Click OK to accept the probabilities and the previously specified low
and high values. Press ESC to deselect Unit Sales. Your model should
look something like Figure 5-8.
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Figure 5-8. Model with Sales Changed to a Discrete Chance Node

If you switch to the Decision Tree pane, you'll note that DPL has updated
the Default Tree by adding the Unit Sales discrete chance node to it and

moving the NPV get/pay expression to the branches for Unit Sales. In the
Decision Tree, DPL displays discrete chance nodes as bright green circles.

= Select Cost per Unit and change it to a Discrete Chance Node. Note
that the last node type changed to was Discrete Chance, so it is now
indicated as the default in the Change To icon. Now you can simply
click the Influence Diagram | Node | Change to icon.

The Node Definition dialog appears with the General tab selected.

=

= You will now remove one of the chance outcomes that DPL provides by
default. On the General tab of the Node Definition dialog, select the
Low outcome in the Outcomes list box and click the Delete button.

= DPL will notify you that the reduction in states will result in node data
being deleted. Click OK to continue.

The Node Definition dialog should now look like Figure 5-9.
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MNode Definition: Cost per Unit

General Data  Links

Mame and settings

Cost [Hide

per
Unit "] Separate probability and value data input trees

DPL variable name for expressions:
Cost_per_Unit

Outcomes

Nominal (Default) Add
High

Insert

Rename (F2)

Default

Comments

Print All Comments...

Copy to Clipboard

QK Cancel Help

Figure 5-9. Node Definition Dialog General Tab for Cost per Unit

= Select the Data tab of the Node Definition dialog.

Because Cost per Unit is conditioned by the Product Strategy decision, there
are two sets of probabilities and values, one for In-house and one for
License (See Figure 5-10). No probabilities are given for the Nominal and
High outcomes. The default probabilities are only given for chance nodes
with the same number of outcomes as specified by the defaults in

File | Options | General. However, the Nominal and High value data that you
specified for the In-house alternative when you ran the Value Tornado are
filled in for the In-house condition state.
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Mode Definition: Cost per Unit

General Data  Links
Conditioning... LCopy Full Screen wheel Beorder | Muliipls Experts... || off||(cf)|cb) || Font.
Distribution twpe: | [discrets] i
Frobability: | | V|| f
Walue: |D.8 | V||f
~
Cost
per Nominal
In-house Unit ] 08
Product High @
Strategy Cost 1
per Nominal D
License Unit ( 0
High
0
v
L4 >
Cancel Helo

Figure 5-10. Node Definition Dialog Data Tab for Cost per Unit

= Type "0.6" in the Probability edit box for the Nominal branch of the In-
house alternative.

= Arrow down twice to select High.
= Type "0.4" in the Probability edit box for High.

Because both outcomes for the License alternative have a value of zero,
the probabilities under the License branch don't affect the results, but they
still need to be filled in.

= Arrow down twice to move to the probability for Nominal for the
License branch.

Type "0.5" in the Probability edit box for Nominal.
Arrow down twice to select High.

Type "0.5" in the Probability edit box for High.
Click OK to close the Node Definition dialog.

Change the Node Type of Marketing Costs to a discrete chance node
(Influence Diagram | Node | Change To).

4 1240303

Accept the default outcomes on the General tab and select the Data
tab.
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= Accept the default probabilities and previously specified values.
= Click OK to close the Node Definition dialog.
= Repeat the above steps for Price.

Note: If you don't review the data on the Data tab, DPL will warn you that
default probabilities have been used when you first run the model and will
ask whether you wish to continue the run with those probabilities.

As you saw earlier, you can select multiple nodes in the Influence Diagram.
When changing node types, you can select multiple nodes and change their
types. You could have done this in this example. When you change multiple
nodes at once, DPL does not bring up the Node Definition dialog so you
need to edit each node to make further changes as appropriate once you
have changed the type. In particular if you change multiple nodes and
don't review the node data, you will get the default probabilities warning
mentioned above.

Your model should now look something like Figure 5-11. DPL has updated
the Default Tree further by adding the discrete chance nodes for Cost per
Unit, Marketing Costs, and Price and by moving the NPV get/pay
expression to the end of the tree on the branches for Price. Tab over to the
Decision Tree pane to view it.
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License
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Launch
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Figure 5-11. Model with Four Discrete Chance Nodes

You are now almost ready to run the modified model with uncertainty
incorporated into it. There are now two models in the Workspace. DPL will
always run an analysis on the model you are viewing or on the model
whose output you are viewing. If that model is not the active model in the
Workspace Manager (indicated by bold font), DPL will make it the active
model.

5.4 Base Case Tornado Diagrams

You are now ready to run another sensitivity analysis on your model: the
Base Case Tornado Diagram. The Base Case Tornado diagram is designed
for models which have several discrete chance nodes, each with a plausible
default state (the Nominal or Base Case value) and most of which have
three (or more) outcomes.

To compute a Base Case Tornado Diagram, DPL first sets all discrete
chance nodes to a state that you define to be Nominal for each node to
calculate a Base Case. It then varies each discrete chance node individually
to a state you specify to be Low and to a state you specify to be High while
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keeping all other discrete chance nodes at their Nominal states. The Base
Case Tornado Diagram is useful for understanding the impact of each
discrete chance node on the model's objective function.

= To run a Base Case Tornado Diagram, drop-down the Home |
Sensitivity | Tornado split button and choose Base Case from the list.

The Base Case Tornado Setup dialog appears as shown in Figure 5-12.

Base Case Tornado Setup - License vs. In-house -prob

Bars
Chance Low State Mominal State High 5tate
Price _ Nominal High
Unit_Sales Low Nominal High
Marketing_Costs Low Nominal High
Cost_per_Unit Nominal Maominal High
Cancel

Figure 5-12. States for Base Case Tornado Diagram Dialog

Note: the default tornado type for the Home | Sensitivity | Tornado split
button changes based upon the last tornado type you have run. The
default is now Base Case Tornado.

To run a Base Case Tornado Diagram, you must tell DPL which state (i.e.,
outcome) is Low, Nominal and High for each discrete chance node. For
three-outcome discrete chance nodes, this is usually straightforward. If you
have used the default discrete chance node settings provided by DPL, the
exercise is easy, as is the case for Marketing Costs, Price and Unit Sales.
Figure 5-12 indicates that the states specified to be Low, Nominal and High
for Marketing_Costs, Price and Unit Sales are Low, Nominal and High,
respectively.
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= Click in the cell for the Low State of Marketing Costs. You can see that
there is a combo box that allows you to type or select the setting for
the state of this chance node.

= Use the arrow keys to move around the other cells for each state of
each chance node, leaving the settings as DPL has suggested.

You will also notice that since Cost per Unit is a two-outcome discrete
chance node, one of its outcomes will have to be repeated for the Low,
Nominal or High state specification. DPL has suggested using the Nominal
state for both the Low and Nominal tornado diagram setting. Leave this
setting as is. Note: to start DPL chooses the outcome defined to be Default
in the Node Definition dialog to be Nominal for a Base Case Tornado, the
first outcome for Low and the last outcome for High. For discrete chance
nodes with more than three outcomes, you may need to change the
settings in the Base Case Tornado Setup dialog.

= Click OK to run the Base Case Tornado Diagram.

DPL produces the Base Case Tornado Diagram as shown in Figure 5-13. In
this example the Base Case Tornado is similar to the Value Tornado that
you ran on the deterministic model (i.e., the model with no discrete chance
nodes) in Section -. This will not always be the case for several reasons.
First, the Base Result of a Value Tornado may not be the same as the Base
Case for the Base Case Tornado if the states chosen as Nominal for the
Base Case Tornado do not match what was used as the current values in
the Value Tornado. Second, if you change the high or low values for value
nodes that you have changed to discrete chance nodes, the two tornado
types will differ.

169



Chapter 5 Syncopation Software

Base Case Tornado

Unit Sales -

Price -| I ‘

Marketing Costs | I ‘
Cost per Unit 4 I
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[ Low Policy Change [E Policy same as Nominal [l High Policy Change

Figure 5-13. Base Case Tornado Diagram

Base Case Tornado Diagrams are useful for understanding how the chance
nodes in your model impact the objective function. They are also flexible
because you can add bars to a Base Case Tornado Diagram for values in
your model. This allows you to compare the impact of chance nodes across
their range of states to the impact of changes in values across a range of
settings. Lastly, Base Case Tornado Diagrams are very quick to run which
may be helpful for larger models with many chance nodes.

While Base Case Tornado Diagrams are relatively simple and easy to
understand, they can be limited in terms of showing impacts in a
probabilistic model where there is a lot of conditioning and/or where
probabilities represent skewed distributions. Base Case Tornado Diagrams
don't use probabilities, so if, for example, the probabilities of a chance
node reflect a skewed distribution, the Base Case Tornado will show the
same results as for a symmetric distribution. A Base Case Tornado is also
difficult to use when there is no natural middle case, as in a risk analysis
model which considers a number of very unlikely bad outcomes. In later
chapters we'll discuss more advanced tornado diagrams that can be
insightful for complex models. See Section 14.3, When to Use Which DPL™
Sensitivity Output, for a comparison.
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5.5 Initial Decision Alternatives Tornado
Diagrams

The Initial Decision Alternatives Tornado diagram is an extension of the
Base Case tornado that you ran in Section 5.4. To create an Initial Decision
Alternatives Tornado, DPL sets the initial decision to each of its possible
alternatives and runs a Base Case tornado for each alternative. The
resulting Base Case tornadoes are then shown on one diagram.

You will now run an Initial Decision Alternatives tornado using the model
you built in the previous sections.

= Make sure the "License vs. In-house prob" model is still the active
model.

= Drop down the Home | Sensitivity | Tornado split button and select
Initial Decisions Alternative from the list.

The Initial Decision Alternatives Tornado Setup table appears. It should be
identical to the Base Case Tornado Setup table you examined in Section
5.4.

= Leave the settings as they are.

= Click OK. An Initial Decision Alternatives tornado appears as shown in
Figure 5-14.
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Initial Decision Alternatives Tornado
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Figure 5-14. Initial Decision Alternatives Tornado Diagram

The tornado shown in Figure 5-14 is an example of a very simple Initial
Decision Alternatives tornado. There are two initial decision alternatives
(In-house and License), so the tornado diagram essentially consists of two
Base Case tornadoes on one chart. The diagram shows that the chance
event Unit Sales has the greatest impact on the objective function value,
regardless of which initial alternative is pursued. It also shows that the
impact on the objective function of Unit Sales is less for the License
alternative than it is for the In-house alternative (the bar for License is
narrower). Also, the diagram shows that if the License alternative is
pursued (despite the fact that it is not the optimal policy), the chance
events Marketing Costs and Cost per Unit have no effect on the objective
function. This makes sense based on how the model is set up. If the
product is licensed, marketing costs and per unit costs are zero.

Initial Decision Alternatives tornadoes are helpful for comparing the impact
of each chance event on the objective function across the possible
alternatives of the initial decision in the model. Although the tornado you
ran in this section is simple and illustrative, Initial Decision Alternatives
tornadoes can be quite powerful when used with models that incorporate
several strategic alternatives and several chance events. Note in the simple
example model there is only one decision in the model. Since DPL runs an
Initial Decision Alternatives Tornado by fixing the initial decision at each
alternative and running a Base Case Tornado, no policy changes will be
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seen in this model. However for models with subsequent decisions after the
initial decision (often referred to as downstream decisions), policy changes
may occur in an Initial Decision Alternatives Tornado since the optimal
alternative may change for a downstream decision.

You may want to save the workspace before you proceed to the next
section.

The model you built in Chapter 3 is now ready to produce the full suite of
results that are available within the Home | Run group when you run a
decision analysis.

5.6 Adding and Analyzing a Downstream
Decision

After some consideration management has decided to add more flexibility
to the model by breaking the Unit Sales variable into two time periods:
Sales 1 and Sales 2. They also would like to add an explicit downstream
decision to raise or maintain the current pricing after sales in the first
period have been observed. If sales are strong in the first time period, it
may make sense to raise the price for the product.

= Right mouse-click the item for the model "License vs. In-house prob"
(or whatever you named it earlier) in the Workspace Manager and
select Duplicate from the context menu.

Rename the new model "License vs. In-house downstream".

=

= In order to add the nodes mentioned earlier, re-arrange your Influence
Diagram to give yourself some space between Unit Sales, Revenue per
Unit, Marketing Costs and NPV as shown in Figure 5-15.

= One way to quickly re-arrange the Influence Diagram is to select
multiple nodes at once. While holding down the Ctrl key, click on the
Unit Sales, Marketing Costs, Cost per Unit and Product Strategy nodes.
All these nodes turn magenta because they are selected as a group.

= Use the mouse to drag this group of nodes to the left, freeing up space
in the center of the diagram.

You may have to adapt these steps slightly depending on how your
diagram is drawn.
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Revenue
per Unit

.

Product
Strategy

4 4 0

Figure 5-15. Re-arranged Influence Diagram

Select Influence Diagram | Node | Add | Decision from the ribbon to
add the new decision node.

Click somewhere in the space you created. The Node Definition dialog
appears with the General tab selected.

Name the node "Price Change".

Rename the alternatives to "Raise" and "Keep same". The General tab
should look like Figure 5-16.
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Nede Definition: Price Change

Gereral Data  Links

Mame and settings

Price [ Hide
Change
DPL varable name for expressions:
Price_Change
Altematives
Faise (Defautt) Add
Insert
Delete
Rename (F2)

Default

Comments
Print All Commerts...
Copy to Clipboard

Cancel Help

Figure 5-16. Node Definition Dialog General Tab
for Price Change Decision
= Select the Data tab.

= Enter "1.1" for the Raise alternative and "1.0" for Keep same. These
numbers will be used as multipliers, so 1.1 means raising prices 10%.

= Press Enter. The Data tab should look like Figure 5-17.
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Mode Definition: Price Change

General Data  Links

Congditioning... LCopy Full Screen Wwiheel Beorder Cf o CP Cf‘ Fant...
|[v][f

Ll

Price Raise
Chanae dﬁg
Keep Same [:I

1.0

v
< >

Cancel Help

Figure 5-17. Node Definition Data Tab for Price Change Decision

= Click OK.
= Double-click Unit Sales to edit its definition.

= On the General tab, change the name to "Sales 1". Leave the
Outcomes as they are.

= Change the value for each outcome to half its previous value. The Data
tab should look like Figure 5-18 when you are done.
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Mode Definition: Sales 1

General Data  Links

Conditioning... LCopy Full Screen Wheel Feorder | Multiple Experts..  |of |l (P ol Faont..

Distrbution type: | [discrete] w

Probability: E |[v|[f
Walue: ‘10 | V|| Ff

Nominal
: 20

High
3 30 D

Cancel Helo

Figure 5-18. Node Definition Data Tab for Sales 1

= Switch to the Links tab and under the Calculation links section at the
top select the "None (local)" radio button to break this node's link with
the spreadsheet (more on this later).
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Node Definition: Sales 1
General Dats  Links

Calculation links

These links are recalculated throughout the run. They may be either inputs used in the linked spreadsheet’s calculations (e g., unit sales) or calculated resutts from
the spreadsheet {2.g., NFV).

@ifone flocal} (O DPL Program (O Microsoft Excel
Workbook Browse
Sheet/Cell: Go to Range BRange Names
This is a OPL local node Paste Link
Initialization links
These links are for connecting to a spreadshest, database or program that contains data {values and/or probabilities) which will be used in the Data tab to intialize
nodes. These links are refreshed once at the start of each un.
(®) Mone (local or DPL program) () Microsoft Excel (O Databass

Go to Manage Links

Cancel Help

Figure 5-19. Node Definition Links for Sales 1
= Click OK to close the Node Definition dialog.

You have divided the sales in half because you are about to introduce a
new node called Sales 2. To do this you are going to take advantage of
DPL's node copy and paste capability. By the time you are done modifying
the model, you will have created a two time period model. Sales 1 will
represent sales in the first period and Sales 2 will represent sales in the
second period. You have divided the values in half for Sales 1 to reflect the
fact that previously Unit Sales represented total sales.

= With the Sales 1 node selected (it should be magenta), make a copy of
it by pressing Ctrl+C or clicking Home | Edit | Copy.

= Paste the new node by pressing Ctrl+V or clicking Home | Edit | Paste.

= Select the new node named Sale 1 (copy) and drag it away from Sales
1.

Note: You can also select and copy multiple nodes by holding down Ctrl
and selecting the nodes to be copied, as you did earlier when you moved
multiple nodes.

= Double-click Sales 1 (copy) to edit it.
= On the General tab, change its name to "Sales 2".
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= Check Separate probability and value input trees as shown in Figure
5-20.

Node Definition: Sales 2

General Values Probabiities  Links

Name and settings

[Sales [ Hice

2

| Separate probability and value data input trees

DPL variable name for expressions:
Sales_2

Outcomes

Low Add
Nominal {Defautt)
High

Insert
Delete

Rename (F2)

Defautt

Comments

Print Al Commerts

Copyto Clipboard

Concal | |t

Figure 5-20. Node Definition General Tab for Sales 2

Note that there are now two tabs in place of the Data tab called Values and
Probabilities, respectively. This is convenient if you have a discrete chance
node whose probabilities are conditioned by one or more nodes and whose
values are conditioned by a different set of nodes, or whose probabilities
are conditioned but values aren't or vice versa. As you will see in the
sample model you are building, the probabilities for Sales 2 will be
conditioned by one node while the values will be conditioned by another
node.

= Select the Values tab.
= Click Conditioning. The Conditioning dialog appears.
= Check Price Change as shown in Figure 5-21.
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Conditioning: Sales 2

The values for thiz node depend on:

[ ]Cast per Unit
[ [Marketing Costs
[ ]Price

Frice Change

[ ] Praduct Strategy
[]5ales1

MHurber af value expreszions required: B

Cancel

Figure 5-21. Conditioning dialog for Sales 2 value

Note that the Conditioning dialog tells you how many data expressions are
required given the nodes selected. Since Sales 2 is a three-outcome

discrete chance node and Price Change is a two-alternative decision node,
six data expressions are required.

= Click OK to close the Conditioning dialog. The data input tree updates
on the Values tab to account for the conditioning.

= Change the Low, Nominal and High values for the Raise alternative of
Price Change to be "8", "15", and "28", respectively. You are assuming
that demand (sales) is slightly sensitive to price. Leave the values for

the Keep same alternative as is. The data input tree for Values should
now look like Figure 5-22.
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Node Definition: Sales 2

General VEluss  Probabilties Links

Conditioning. . Copy Full Screen Wfheel Beorder Cf oy (P Cf‘ Faont...
El |[v]lF
~
Low
Sales
Raise 2 Nominal
50
Price High
Change 28 D
Low
Sales 10 D
Keep Same 2 Nominal
T
High
w0
W
L4 >

Corea ] [

Figure 5-22. Node Definition Value Tab After Conditioning

= Select the Probabilities tab.
= Click Conditioning. The Conditioning dialog appears.
= Select Sales 1 and click OK.

As the Conditioning dialog indicated, nine data expressions are required.
The probability input tree for this is rather small.

= Click the Full Screen button to make entering the data easier. See
Figure 5-23.

= Enter probabilities for Sales 2 according to Table 5-2.
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Sales 1 Outcome Sales 2 Outcome Probability
Low Low .6
Nominal 3
High d
Nominal Low 3
Nominal 4
High 3
High Low 1
Nominal 2
High 7

Table 5-2. Probability Data for Sales 2

Corgtoring. Copy | Ful§creen | \wheel | fe oot Font

Low
Sales

Low 2 ot Nominal
‘ @

[
[ \
[ \_High
[ 1
|
| Low
Sales | sales /3
1 & Nominal 2 2 Nominal
§ ®
\ \Hgh
\ 3
Low
\ Sales / 1
\_High 2 gb, Nominal
Q-

\
\_High
7

Figure 5-23. Full Screen Probability Input Tree for Sales 2

Note that the probabilities for Sales 2 given that Sales 1 is Nominal are
unchanged. The probability data in Table 5-2 reflects the belief that if sales
in the first period are low (i.e., if the outcome of the Sales 1 chance node is
Low) then sales in period two are more likely to be low (i.e., the outcome
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of the Sales 2 chance node is more likely to be Low). Similarly if sales in
the first period are high they are more likely to be high in the second
period.

= Click Full Screen again. The Node Definition dialog returns to normal
dialog mode.

= Click OK. Your model should now look something like Figure 5-24.

License
Fee

Price
Change

Product
Strategy

= Marketing
Costs

Figure 5-24. Model After Editing Sales 2

DPL has indicated the changes that you have just made with colored arcs.
A green arc indicates that the influencing node (i.e., Sales 1 — called the
predecessor) conditions the probabilities of the influenced node (i.e., Sales
2 — called the successor). As you have seen previously a blue arc indicates
that the influencing node (i.e., Price Change) conditions the values of the
influenced node (i.e., Sales 2). If the predecessor conditions both the
probabilities and the values of the successor, DPL indicates this with a light
orange arc. Arc colors are covered in more detail in Section 7.3.

Note that DPL continues to update the Default Tree as you make changes
in the Influence Diagram. The Default Tree is not yet correct, but you can
ignore that for now. There are several more changes to make to the
Influence Diagram.

You need to create a value node to connect to the "Unit_Sales" driver cell
in the spreadsheet. This node will represent total sales in both time
periods.

183



Chapter 5 Syncopation Software

=

440

Click the Influence Diagram | Node | Linked Node icon. Note that the
default add link node type indicated by the icon is currently Excel-
Calculation Linked. If it is not, drop down the split button and select
Excel Calculation-Linked... from the list.

In the Range Names dialog, select Unit_Sales and click OK.
Double-click the new Unit Sales node to edit it.
On the General tab, change the name to "Total Unit Sales".

On the Data tab, enter the formula "Sales_1 + Sales_2". Use the
variable button to avoid typing mistakes. See Figure 5-25.

Mode Definition: Total Unit Sales

General Data  Links
Conditianing LCopy Full Screen Wwiheel FRearder Cf o CP Cf‘ Faont
2 M [f
A
Total Unit
Sales
Sales 1+Sales 2
v
£ >
oK Cancel Help

4 4 44037

Figure 5-25. Node Definition Data for Total Unit Sales

Click OK to close the Node Definition dialog.
Move Total Unit Sales to the bottom of the Influence Diagram.

Draw an arc from Sales 1 to Total Unit Sales and Sales 2 to Total Unit
Sales.

Delete the arc that goes from Sales 1 to NPV (hint: click near the
arrowhead to select it and then press the Delete key).

Draw an arc from Total Unit Sales to NPV. Your model should look
similar to Figure 5-26.
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Figure 5-26. Model with Total Unit Sales

Now you will update Revenue_per_Unit to reflect the price change. The
formula for Revenue_per_Unit in the In-house case becomes an average
selling price.

= Double-click Revenue per Unit to edit it.

= The In-house formula is "(Price*Sales_1 +
Price*Price_Change*Sales_2)/Total_Unit_Sales". The License formula
doesn't change. Again, use the Variable button for accuracy. See Figure
5-27.

= If the data is cut off in the input tree, you can right mouse-click on the
tree to get the context menu and select Lengthen Branch.
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Mode Definition: Revenue per Unit

General Data  Links
Conditioning.... Copy Full Screen wheel Feorder Cf oy CP Cf‘ Font...
|[v][f
A
Revenue
Product In-house per Unit D
Strategy (Price™Sales_1 + Price’Price_Change™Sales_2)/Total_Unit_Sales
License
W
< >
Cancel Help

Figure 5-27. Node Definition Dialog for Revenue per Unit

= Click OK close the dialog.

= Click Influence Diagram | Arc | From Formulas to add arcs from Sales
1, Sales 2, Price Change and Total Unit Sales to Revenue per Unit.

You have now incorporated Sales 2 and Price Change into the expressions
for Revenue per Unit. In particular, if In-house is chosen then revenues
reflect the price change in the second period.

Your model is nearly complete. However if you were to view the Default
Tree DPL is building you'd find that it is not yet correct. The model you are
developing is a two time period model. You have an upfront decision to
produce the product In-house or License it. You then have a downstream
decision to change the price or not. The downstream decision occurs after
you have observed sales in the first period. To reflect this, you need to
have the Sales 1 discrete chance node appear before (to the left of) Price
Change in the Decision Tree.

= Drag the splitter bar up from the bottom of the Influence Diagram
pane, so that the Influence Diagram and Decision Tree panes are of
equal size. Zoom Full within both panes so you can see all of the model
in each as shown in Figure 5-28.

Price Change is currently before Sales in the Default Tree. You will now add
a timing arc to the Influence Diagram so that DPL will correct this.
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Specifically, you will add an influence arc from Sales 1 to Price Change. As
mentioned in Chapter 2, an influence arc can represent dependency,
conditioning and/or timing. In this case, the influence arc from Sales to
Price Change is a timing arc (Price Change does not depend on and is not
conditioned by Sales 1). The arc tells DPL that Sales 1 occurs before Price
Change.

= Click Influence Diagram | Influence/Arc | Add.
= Create an arc from Sales 1 to Price Change.

Note that DPL has moved Sales 1 ahead of Price Change in the Decision
Tree.

You may want to move some nodes around again and/or bend some
influence arcs to make the Influence Diagram neater. Your model should
look something like Figure 5-28. You will now run your updated model.

) He-8+ DPL - New Prod Test_5_25.da - [New Product Strateq; eam] P
HOME  INFLUENCEDIAGRAM  DECISIONTREE  VIEW  DATA  HELP -8

@ m ?Lmkzd?dcdz ng @ X f-) o

Edit  Add

Workspace Manager

o
2 New Product Strategy downstream

Price
Change

Product
Strategy

Session

2375
US: +1 878233 2508

n (Internal Buid)
mber 31, 1569 Product Sales p Cost

Strateqy 1 [
Unit

M?:rzzlhsng Price Sﬂ\ss

In-house

Raise Nurmna\
Nominal
Nominal Nominal Nominal
High High High High

Figure 5-28. Completed Model with Downstream Decision

= In the Home | Run group, make sure Policy Tree and Policy Summary
are checked.
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= Click Home | Run | Decision Analysis or press F10. DPL produces the
requested outputs.

= Review the Policy Tree.

In the revised model, there is a downstream decision. With downstream
decisions there is not necessarily a single alternative that is always optimal.
Note that in the Policy Tree a different alternative is optimal for the Raise
Price decision depending upon the outcome of Sales 1. It is easy to review
the relatively small Policy Tree in this example. The Policy Summary
provides a useful view of the information in the Policy Tree, particularly for
models with larger and/or more complex Policy Trees. Note that the
expected value of the model has increased to 111.1.

= Double-click on the Policy Summary item in the Workspace Manager to
activate the window. The Policy Summary as shown in Figure 5-29 is
displayed.

Product Strategy Frice Change Sales 1

In-house Raise

License

(does not occur) (does not oceur)

0% 0% (does not oceur)

0%
Cost per Unit Marketing Costs Price

Low Low

Mominal 0%
Mominal

Mominal

40%

(does not occur) 30%
0% (does not occur)

(does not occur)
0% 0%

Sales 2

Low

Mominal

(does not occur)

0%

Figure 5-29. Policy Summary™

As stated previously, for downstream decisions the Policy Summary
displays the probability weighted fraction of scenarios for which each
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downstream decision alternative is optimal. In your updated model, Price
Change is a downstream decision because it occurs after the Sales 1
discrete chance node. As indicated in Figure 5-29, Raise has a policy
dependent probability of 30% while Keep same has a policy dependent
probability of 70%. By looking at the Policy Tree again you can determine
in which scenarios the Raise vs. Keep same alternative is optimal.

The Policy Summary also displays the policy dependent probabilities of the
outcomes for discrete chance nodes. For discrete chance nodes that are
not conditioned by others and that do not depend on the optimal policy,
the policy dependent probabilities are equal to the input probabilities. This
is true of Sales 1, Cost per Unit, Marketing Costs and Price. However, Sales
2 is conditioned by another node (namely Sales 1). You can see that the
policy dependent probabilities for Sales 2 are not the same as the input
probabilities.

5.7 Rainbow Diagram on a Value

The rest of this chapter addresses Rainbow Diagrams, which are another
form of sensitivity analysis. A Rainbow Diagram provides more detailed
information on how the objective function of the model and the optimal
policy change as a single variable is varied across a range of settings. You
will now create a Rainbow Diagram for a value node in the model.

= Click Home | Sensitivity | Rainbow Diagram (One-Way Rainbow
diagram in is the current default indicated by the icon). The Rainbow
Diagram Setup dialog appears similar to Figure 5-31 but blank.

= Press the Select button to select a variable for the dialog.
= Select License_Fee in the Value for sensitivity drop-down list as shown
in Figure 5-30.
Select Value for Rainbow Diagram X
Walue for sensitivity: Lizenze_Fee o
Current walue: 0.75

Carcel

Figure 5-30. Select Value for Rainbow Diagram dialog
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= Click OK.

= In the Run Rainbow Diagram dialog, specify the From: and To: values
to be "0.7" and "0.9", respectively.

= Set the Step size to be "0.025". The number of steps will update. The
Rainbow Diagram Setup dialog should now look like Figure 5-31.

Rainbow Diagram - License vs. In-house downstreamn

Y ariable

Yariable name: |License Fee |

Select

Curent value: 075

Eram: |.? | T |.E|
() Mumnber of steps |E| |
(®) Step size |.|:|25 |

E valuation methad

Fazt sequence evaluation Change

Cancel Help

Figure 5-31. On-way Rainbow Diagram Setup for License Fee

= Click OK to run the Rainbow Diagram.

A Rainbow Diagram displays the value of the model's objective function on
the y-axis and the values of the selected variable on the x-axis. The
diagram shows how the objective function value changes as the variable
setting changes across the specified range. The Rainbow Diagram for
License Fee is in Figure 5-32. The diagram indicates that as License Fee
increases from 0.7 to 0.85 there is no change in the objective function
value, but as License Fee increases from 0.85 to 0.9 there is an increase in
the objective function value.
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Figure 5-32. Rainbow Diagram for License Fee

Rainbow Diagrams also indicate policy changes by changes in color. Since
the Rainbow Diagram in Figure 5-32 changes color between 0.85 and
0.875, you know that a policy change occurs in that region. As with
Tornado diagrams, the vertical line where the color changes does not
indicate the precise point at which the policy changes. The vertical line is
drawn at the halfway point of the two tested values of the variable
between which a policy change has occurred. In this instance, License Fee
is tested at 0.85, which results in one policy, and again at 0.875, which
results in a second policy.

Therefore the vertical line is drawn halfway between 0.85 and 0.875. If you
want more precise information on where the policy change occurs you can
run another Rainbow Diagram with finer increments within this range.

In a Rainbow Diagram, DPL starts with a color and changes to a new color
every time there is a policy change. The color of the region does not relate
to the value of the variable, i.e., blue does not mean that the high setting
of the variable resulted in a policy change. It only indicates that a policy
change has occurred. You can use your mouse cursor to find out which
policy applies in each colored region if you have Show Tips turned on, i.e.
the Show Tips button is shaded blue within the View | Tips group.
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= Place your mouse cursor over the blue square marker for 0.875 on the
curve. A policy tip will appear as indicated in Figure 5-33.

117 4
116.5
1164
115.5
@ 1154
=
o
= 11451 BV 114
E EV policy.
o 1144 Price Change: Keep Same=100%
& Product Strategy: License=100%
W 1357
1134
112.5
112 4
111.5 4
- * » » »
0.7 0.725 0.75 0.775 0.8 0.825
License Fee

Figure 5-33. Rainbow Diagram with Policy Tip Showing

The policy tip tells you the expected value of the model given the value of
the variable that the marker represents. For example, the policy tip in
Figure 5-33 indicates that the expected value of the model is 114 when
License Fee is 0.875. The policy tip also tells you the policy dependent
probabilities for each decision in the model given the value of the variable
that the marker represents. The decision alternatives are displayed in the
policy tip by using the decision node name followed by a colon followed by
the decision alternative. E.g., "Product Strategy: License". The policy
dependent probability for the alternative follows the equal sign. As Figure
5-33 indicates, the policy when License Fee is 0.875 is to License out
production of the product and to keep price the same in time period 2. To
keep the policy tip compact, decision alternatives with a policy dependent
probability of zero are not displayed.

= If you wish, place your mouse cursor over one of the green circular
markers on the curve to see what the policy is for these points.

You have completed a Rainbow Diagram on one value in your model. You
will now learn how to run a Rainbow Diagram on a probability.
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5.8 Rainbow Diagram on a Probability

When you ran the Rainbow Diagram in Section 5.7 you may have noticed
that the only variables you could select in the Select Value for Rainbow
dialog were values. What if you would like to run a sensitivity analysis on a
probability? You will need to modify your model slightly to do so.

=

=

=
=
=
=

Double-click on the item for the "License vs. In house downstream"
model in the Workspace Manager. The Model Window becomes active.

Add a value node to the model by clicking Influence Diagram | Node |
Add. If the default add node type isn't value (as indicated by the icon),
use the drop-down list to select Value.

Click anywhere in the Influence Diagram. The Node Definition dialog
comes up with the General tab selected.

Name the value "p".
Click the Data tab.
Type "0.6" as shown in Figure 5-34.

Mode Definition: p

General Data  Links

|[v][f

Conditioning... LCopy Full Screen Wwiheel Beorder Cf a; CP Cf‘ Fant...

0

Cancel Help

Figure 5-34. Node Definition Dialog Data Tab for p
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Click OK.

Double-click the Cost per Unit node to edit it. The Node Definition
dialog appears with the Data tab selected.

In place of "0.6" for the probability of Nominal (given In-house), type
"p".

Press the down arrow twice to select the probability for High.

Delete the "0.4" that is there for the Probability of High.

Press Enter. Your node data for Cost per Unit should now look like
Figure 5-35.

44 4 10

MNode Definition: Cost per Unit

General Data  Links
Conditioning... LCopy Full Screen wheel Beodsr | Multipls Experts... || of||cf CP o Fort...
Distribution type: | [discrete] ~
Probabilty: [ |[v][F
Yalue: | v||f
A
Cost
per Nominal D
In-house Unit p 08
Product High
Strategy Cost
per Nominal D
License Unit 5 0
5] 0
v
< >
Conca | [

Figure 5-35. Node Definition Data Tab for Cost per Unit

Note: in the changes you just made you left the probability of the last
outcome of the discrete chance node blank. You can always do this. DPL
will assign one minus the sum of the rest of the outcome probabilities to
the last outcome. In this instance, you must do this. Rather than entering a
number for the probability of Nominal, you have now entered a value. The
use of a value such as "p" in the probability expression of an outcome is
called a non-constant probability expression. When you use a non-constant
probability expression for any of the chance outcomes in a node, you must
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leave the last probability expression blank. This helps to ensure that the
probabilities of all the outcomes sum to one.

g ¢4 44034 00

DP

Click OK to close the Node Definition dialog.

Click Home | Sensitivity | Rainbow Diagram. The Run Rainbow Diagram
dialog appears.

Click the Select button.
Select p in the Select Value for Rainbow dialog.
Click OK.

In the Run Rainbow Diagram dialog, specify the From: and To: values
to be "0.3" and "0.9", respectively.

Set the Step size to be "0.05". The Run Rainbow Diagram dialog should
now look like Figure 5-36.

Click OK to run the Rainbow Diagram.

Rainbow Diagram - License vs. In-house downstream

" ariable
Yariahle name: |p | I

Select |

Current walue: |05

Erom: |.3 | To |.E| |
() Mumber of steps |13 |
(®) Step size |.|:|5 |

E valuation method

Fazt sequence evaluation Change

Carca Ho

Figure 5-36. Rainbow Diagram Setup Dialog for p

L produces the Rainbow Diagram for p as shown in Figure 5-37. The

Rainbow Diagram indicates that while the objective function increases from
approximately 102 to 120, no policy changes occur as p varies from 0.3 to
0.9. In this instance, you can be comfortable with your estimation of the
probability of Nominal for Cost per Unit. Over a fairly wide range, it does
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not change the optimal strategy. Note, however, that the Rainbow Diagram
in Figure 5-37 still assumes that the value for Cost per Unit is no lower
than 0.8 and no higher than 1.0 (the Nominal and High values of the
outcomes). The Rainbow Diagram tests the sensitivity of the optimal policy
to the probability that Cost per Unit is Nominal or High given the specified
values of the outcomes.

120 4
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= - =
= -y [
= & e

Expected Value

-
=
@

106 4

104

0.3 0.35 0.4 0.45 0.5 0.55 0.6 0.65 0.7 0.75 0.8 0.83
p

Figure 5-37. Rainbow Diagram for p

The next section discusses Probabilistic Base Case Tornadoes, an additional
sensitivity type.

5.9 Probabilistic Base Case Tornado Diagram

0.9

A Probabilistic Base Case Tornado Diagram is similar to a Base Case
Tornado Diagram. However, the Probabilistic Base Case Tornado does not
remove the uncertainty from the model when calculating results. To
calculate the base run for the output, DPL evaluates the full model with all
uncertainty as if it were running a Decision Analysis on the model.
Consequently, the base run, or the vertical line in the tornado, will equal
the expected value of the model as in a Risk Profile or a Policy Tree. See
Sections 3.1 and 3.2 for descriptions of these outputs. To produce the
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results for each chance node in the model, DPL runs the model with the
chance node it is evaluating fixed to a low state while allowing all the
remaining chance nodes to vary across their outcomes. DPL then repeats
this with the chance node fixed at a high state and repeats the whole
process for each chance node. Because the base run in the Probabilistic
Base Case Tornado matches the expected value of the model in a Decision
Analysis run, it can be more easily compared to other outputs from a
Decision Analysis run and sometimes easier to explain.

The process for setting up the Probabilistic Base Case Tornado is identical
to that of the Base Case.

= Drop-down the Home | Sensitivity | Tornado split button and choose
Probabilistic Base Case from the list.

The Probabilistic Base Case Tornado Setup dialog appears. The set-up is
identical to that of the Base Case Setup Dialog in Figure 5-12.

= Click OK to run the Probabilistic Base Case Tornado Diagram.

DPL produces the Probabilistic Base Case Tornado Diagram as shown in
Figure 5-38.

Probabilistic Base Case Tornado

Price 4 . ‘
Marketing Costs - . ‘
Cost per Unit - . ‘

T T T T T T T T T
40 60 80 100 120 140 160 180 200

[ Low Policy Change [ Policy same as Mominal [l High Policy Change

Figure 5-38. Probabilistic Base Case Tornado Diagram
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The tornado indicates that all variables are decision sensitive (there is at
least one policy change for each bar) and that Sales 1 and Sales 2 have the
biggest impact on the objective function. Notice that the vertical line is at
111.1, which is the expected value of the objective function of the model
as currently built.

You have now reached the end of the tutorials on building and analyzing
DPL decision analysis models. Though the model you developed in this
tutorial is fairly simple, you now have the essential skills needed to develop
models of decisions of varying complexity.
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6. Building and Analyzing Monte Carlo
Simulation Models

This tutorial focuses on building an Excel-linked DPL model for a financial
risk analysis application. It assumes familiarity with cash flow spreadsheets
and with the analysis of uncertainty by Monte Carlo simulation. This
chapter discusses how to do Monte Carlo simulation in DPL.

= If needed, start DPL.

The left-hand pane is the Workspace Window, and contains the Workspace
Manager and Session Log. For more on the Workspace Window, see
Section 1.4.2. DPL will load with an empty Decision Tree pane maximized
within the Model Window on the right-hand side of the screen as shown in
Figure 6-1. This indicates that you are in Decision Tree-focused modeling
mode. For on the Model Window and modeling modes, see Section 1.4.3.

The Model Window always contains two panes: 1) the Influence Diagram
pane and 2) the Decision Tree pane — though both are not necessarily
visible at once. When one pane is maximized, the other is present but
minimized and, consequently, hidden from view.

At the moment, Modell is the only document in your Workspace.
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Figure 6-1. A Blank DPL Workspace in Decision Tree-focused Mode

The DPL Model you are about to build will be used to characterize the
uncertainties of the decision-problem and a linked Excel spreadsheet model
will calculate cash flows. The risk analysis model built in this tutorial lends
itself to Influence Diagram-focused modeling mode.

6.1 The Excel Cash Flow Model

Before creating the DPL model, take a brief tour of the Excel model
provided for this tutorial.

= Start Excel as you normally do.

= Open the file "Enlightify1.xIsx". This file is found in the "Examples”
folder where DPL was installed, usually C:\Program
Files\Syncopation\DPLS\Examples.

The directory may vary slightly depending on your license type and
operating system.
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Figure 6-2. Excel Cash Flow Model for Enlightify: Assumptions Sheet

This simple cash flow model calculates the value of Enlightify Consulting
LLC, a troubled business unit whose financial performance is of concern.
The Excel model is built on two sheets, one for key assumptions and value
drivers, and another for the cash flow calculations.

In Figure 6-2, you can see that eight of the value drivers have already been
identified as sources of uncertainty; the cells are shaded in light green.
Each of these cells has been assigned a range name. When using an Excel
model with DPL, you must name the cells you intend to link to DPL. If you
select a named cell in Excel, the name will appear in the name combo box
to the left of the formula bar. In Figure 6-3 you can see that cell C17 has a
current value of $895, and has been given the name "Total_Value". Please
consult your Excel documentation if you are not familiar with named
ranges, as they are essential for using DPL with Excel.
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Figure 6-3. Cell C17 is Named Total_Value

The calculations sheet (DCF) is shown in Figure 6-4. In this sheet, the
model calculates the total value of the Enlightify Consulting business unit
by the discounted cash flow method. These calculations are connected to
the input cells on the Assumptions sheet. For example, if the Trendline
Revenue Growth Rate (cell C22) is changed from 8% to 5%, the total 